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Matrox Limited Warranty

Limited Warranty Statement

1 Matrox” ("Matrox") having its head office at 1055 St-Regis Blvd., Dorval, Quebec Canada tel: (514) 822-6000
warrants that the Matrox hardware products (the "Matrox Product") will be free from defects in materials and
workmanship under normal use for a period of one (1) year from the date of purchase by the original customer
("Customer" or "You") who provides adequate proof of purchase and payment (for example, a copy of your sales
receipt or purchase invoice). The warranties provided by Matrox in this Matrox limited warranty statement apply
only to Matrox Products that the Customer purchases for use, and not for resale. This warranty applies only to the
original Customer and is non-transferable. MATROX DOES NOT WARRANT THAT THE OPERATION OF THE
MATROX PRODUCT WILL BE UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS IN THE MATROX
PRODUCT WILL BE CORRECTED, OR THAT THE MATROX PRODUCT WILL MEET THE CUSTOMER'S
REQUIREMENTS OR PERFORM WITH ANY HARDWARE OR SOFTWARE PROVIDED BY THIRD
PARTIES. Conditions and limitations of Matrox's warranty are stated below.

N

Matrox's limited warranty applies only to the Matrox Product entirely manufactured by or for Matrox. The limited
warranty does not apply to any non-Matrox hardware products or any software, even if packaged or sold with the
Matrox Product. Manufacturers, suppliers or publishers other than Matrox may provide their own warranties to the
Customer, but Matrox, insofar as permitted by law, provides their products "as is." Software provided by Matrox is
not covered under this limited warranty (please refer to the licensing agreement accompanying the software for
details of the terms applicable to such).

3 Matrox's limited warranty covers only those defects which arise as a result of normal use of the Matrox Product
and does not apply to any damage which arises from:

a improper or inadequate maintenance;

b incompatibilities due to the Customer's hardware or software applications, including non-Matrox products,
with or in which the Matrox Product interfaces;

Matrox Product of a special or custom-made nature;

Q o

unauthorized modification or misuse, including physical damage to the Matrox Product caused by the
Customer or due to transportation of the product;

e improper installation, abuse, misapplication or negligence;
f failure to follow instructions relating to Matrox Product's use;
g operation outside the Matrox Product's environmental specifications;

h improper site preparation or maintenance;

software;

service performed by anyone who is not a representative of Matrox;

=~

other causes that do not relate to a Matrox Product defect;

defects or damage suffered as a result of force majeure (including theft);
m defects or damage suffered as a result of normal wear and tear or otherwise due to the normal aging of the
Matrox Product, and/or
n stolen goods.
The warranty is voided by removal or alteration of identification labels on the Matrox Product or its parts.
4 In the event of a defect in a Matrox Product during the applicable warranty period, Matrox shall at its sole option,
either i) repair the defect using new or refurbished parts and return the repaired Matrox Product within a
reasonable delay; or ii) replace the Matrox Product with a Matrox Product that is new or which has been
manufactured from new or serviceable used parts and is at least functionally equivalent to the original Matrox
Product and send such replacement Matrox Product within a reasonable delay.

* Matrox is Matrox Electronic Systems Ltd, Matrox Graphics Inc. or Matrox Europe Limited. Head office at
1055 St-Regis Blvd. Dorval, Quebec, Canada HOP 2T4 Telephone (514) 822-6000.
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5 A replacement Matrox Product or part assumes the remaining warranty of the original Matrox Product.
‘When a Matrox Product or part is replaced, any replacement item becomes the Customer's property and the
replaced item becomes Matrox's property.

6 This warranty is valid in any country where Matrox Products are distributed by Matrox and/or its authorized
resellers, dealers or distributors.

7 This limited warranty gives the Customer specific legal rights. The Customer may also have other
rights which vary from state to state in the United States, from province to province in Canada, and
from country to country elsewhere in the world.

8 For Australian Consumers: The rights described in this warranty are in addition to the statutory rights to
which You may be entitled under the Competition and Consumer Act 2010 and other applicable Australian
consumer protection laws and regulations. Our Matrox Products come with guarantees that cannot be
excluded under the Australian Consumer Law. You are entitled to a replacement or refund for a major failure
and compensation for any other reasonably foreseeable loss or damage. You are entitled to have the goods
repaired or replaced if the goods fail to be of acceptable quality and the failure does not amount to a major
failure. Goods presented for repair may be replaced by refurbished goods of the same type rather than being
repaired. Refurbished parts may be used to repair the goods.

Limitations of Warranty

1 TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND THE REMEDIES SET FORTH
ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, REMEDIES AND
CONDITIONS. NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY
OTHER WARRANTY OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO
MATROX PRODUCTS. MATROX SPECIFICALLY DISCLAIMS (AND THE CUSTOMER, BY
ACCEPTING THE MATROX PRODUCT, SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND
WAIVES) ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN,
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR OR INTENDED PURPOSE OR USE AND THE WARRANTY AGAINST
LATENT DEFECTS, WITH RESPECT TO THE HARDWARE AND/OR SOFTWARE. MATROX
FURTHER DISCLAIMS ANY WARRANTY THAT MATROX PRODUCTS, IN WHOLE OR IN PART,
WILL BE FREE FROM INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY,
INCLUDING, WITHOUT LIMITATION, ANY PATENTS, OR PROPRIETARY RIGHTS.

N

To the extent that this limited warranty is inconsistent with the law of the locality where the Customer
purchases the Matrox Product, this limited warranty shall be deemed modified to be consistent with such
local law. Under such local law, certain limitations of this limited warranty may not apply to the consumer. If
Matrox cannot lawfully disclaim statutory or implied warranties, then to the extent permitted by law, all such
warranties shall be limited in duration to the duration of this express warranty and to repair or replacement
service as determined by Matrox at its sole discretion.

3 Matrox disclaims any representation that it will be able to repair any Matrox Product under this warranty or
make a Matrox Product exchange without risk to or loss of the programs or data.

4 To the extent allowed by local law, the remedies provided in this limited warranty are the Customer's sole
and exclusive remedies.

Limitations of Liability
1 EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE LIMITED WARRANTY, IN
NO EVENT SHALL MATROX BE LIABLE FOR:

a any direct, indirect, special, incidental, consequential, foreseeable or unforeseeable, or punitive
damages, whether based on contract, tort, delict or any other legal theory and whether advised of the
possibility of such damages; and/or
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b damages arising from the loss of use, data, Matrox Production revenue, use of money, anticipated savings,
procurement of substitute goods, business, opportunity, goodwill, reputation and/or profit in connection with
the Matrox Product or any business interruption.
¢ Matrox disclaims and shall have no obligation to indemnify or defend You or any third party in respect of any

actual or alleged infringement of any actual or pending patents, copyright or other intellectual property rights.
Matrox shall have no liability arising out of any such actual or alleged intellectual property infringement.

N

Without prejudice to the foregoing, any liability of Matrox for any breach of warranty shall be limited to the actual
amount paid by the Customer for the defective hardware in question.

3 To the extent allowed by local law, Matrox's entire liability and the Customer's exclusive remedy shall be the
repair or replacement of any defective Matrox Product during the warranty period. Matrox does not offer any other
warranty with respect to Matrox hardware or software or any other hardware or software.

4 Customer shall be responsible for all applicable taxes, duties and customs fees on any replacement unit, as well as
all transport, insurance, storage and other charges incurred on all returned Matrox Products.

5 Matrox reserves the right to change its warranties at any time and without notice, at its sole discretion, with
respect to future sales and deliveries.

6 UNAUTHORIZED USE. THE MATROX PRODUCT AND ANY DOCUMENTATION RELATED THERETO
ARE NOT DESIGNED, INTENDED, AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR
RESALE IN ANY TYPE OF SYSTEM OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR
POTENTIALLY HAZARDOUS ENVIRONMENTS OR APPLICATIONS REQUIRING
HIGH-AVAILABILITY OR FAIL-SAFE PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY
OCCUR, SUCH AS MEDICAL SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF
NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC
CONTROL, PUBLIC WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE
FAILURE OF A MATROX PRODUCT COULD LEAD TO PROPERTY DAMAGE, ENVIRONMENTAL
DAMAGE, OR PERSONAL INJURY. CUSTOMER WILL NOT USE, OR PERMIT TO BE USED, THE
MATROX PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS
AND FURTHER AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS
MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, AND
ASSIGNS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, DAMAGES,
AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) ARISING
OUT OF, OR RELATED TO, THE BREACH OF CUSTOMER'S OBLIGATIONS RELATED HERETO, EVEN
IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR
MANUFACTURE OF THE MATROX PRODUCT.

Obtaining Service (whether in or out of warranty)
1 Verify that your Matrox Product was installed and configured according to the information in its accompanying
documentation or at the web site referenced therein.

N

Read the "Troubleshooting" information included with the Matrox Product or at the web site referenced therein, to
verify if the problem can be easily solved.

3 If You are still experiencing difficulties, please contact your dealer or distributor where You purchased your
Matrox Product. Please go to http://www.matrox.com/hr/en/company/legal/en/warranty, to find the list of Matrox
authorized dealers and/or distributors in your area.

4 Alternatively, if this first option is unavailable to You and you are still experiencing problems or if you believe that
your product is defective, please contact the Matrox Support team. We will help you troubleshoot your issue and
process a replacement if it is found to be defective. Matrox support team can be reached at
http://www.matrox.com/hr/en/company/legal/en/warranty.

5 Before returning the Matrox Product, please back up any and all information or data thereon, including, without
limitation, confidential, proprietary, personal or other information. All data and information on the Matrox
Product will be lost given that the persistent storage device(s) will be reformatted to factory default during testing;
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and Matrox cannot, and does not, accept any responsibility for any information that may be lost, corrupted,
damaged or otherwise rendered inaccessible.

6 When returning a Matrox Product, leave the configuration as it was when You were using it, and leave all
identification stickers on the Matrox Product. Pack the Matrox Product in its original box and return it to
your Matrox dealer or distributor where the Matrox Product was purchased, together with your proof of
purchase. Your Matrox dealer or distributor will return the Matrox Product for You. Alternatively, You may
proceed by returning your Matrox Product by following the guidelines referred to at the following address
http://www.matrox.com/hr/en/company/legal/en/warranty, and follow the link to Customer Support, where a
Return Merchandise Authorization (RMA) number will be issued, upon receipt of adequate proof of
purchase, and shipping instructions will be given to you. Customer will be responsible in paying the freight
to send the Matrox Product for service. Please ensure that the product is in Electrostatic discharge (ESD)
packaging before shipping it back to Matrox or else the warranty shall be void.

DO NOT RETURN THE MATROX PRODUCT TO MATROX WITHOUT MATROX'S RMA NUMBER
AND EXPRESS AUTHORIZATION.

Once an RMA number is issued, the Matrox Product must be returned to Matrox within thirty (30) days.

NON-WARRANTY product will be shipped back to You collect or on your courier account number, if one is
provided.

General

1 This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws
of Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear
and decide any dispute instituted by the Customer in connection with this limited warranty; the Customer
waives, by accepting the Matrox Product, its rights to institute proceedings in connection with this warranty
against Matrox in any jurisdiction other than Quebec. Customer hereby agrees to all terms of this warranty in
the English language. The United Nations Convention on Contracts for the International Sale of Goods does
not apply to this warranty and is strictly excluded.

N

Except as may be expressly agreed to the contrary in a signed written agreement between Customer and
Matrox, i) any written or oral information or advice given by Matrox's distributors, agents or employees will
in no way increase the scope of the limited warranty contained in this limited warranty; and ii) this limited
warranty states the only warranty made to You by Matrox with respect to the units of Matrox Product that
You have purchased, and the terms of this limited warranty shall override the terms of any purchase orders
and any other terms and understandings You may seek to apply in respect thereof.

3 This limited warranty is personal to You and cannot be assigned or transferred without Matrox's prior written
agreement.

4 The failure by Matrox to enforce any of the provisions of this limited warranty shall not constitute a waiver
of Matrox's rights to enforce such provision or any other provision of this limited warranty in the future.

5 If any clause in this limited warranty is held by a court of law to be illegal or unenforceable the remaining
provisions of this limited warranty shall not be affected thereby.
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Matrox Software License Agreement

THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD.
("MATROX") CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY DOWNLOADING,
INSTALLING, COPYING, ACCESSING, CLICKING ON AN "ACCEPT" BUTTON, OR OTHERWISE USING
THE SOFTWARE, THE LICENSEE AGREES TO THE TERMS OF THIS AGREEMENT. IF YOU ARE
ACCEPTING THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL
INSTITUTION, OR AGENCY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL GOVERNMENT
AS ITS AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE
FULL AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF
THIS AGREEMENT, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS
DOWNLOADED, DESTROY ALL COPIES OF THE SOFTWARE.

In this agreement "Software" refers to: any firmware, software, associated software components, media, printed
materials, and "online" or electronic documentation related to Matrox products.

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This license
does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software. This license
sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or its suppliers. The present License does
not give Licensee any intellectual property rights to the Software or its derivatives. The downloading and/or the use of
any Software are subject to the following restrictions and limitations:

LICENSES:

If you are an end user, the '"End User License' shall apply to you.

If you are an original equipment manufacturer (OEM), the "OEM License' shall apply to you.

END USER LICENSE

Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any
location. However, Licensee must use the Software on a single computer owned or leased by Licensee at a time, in
conjunction with and for the purpose of, operating the Matrox hardware. Licensee shall also have the right to make
one copy of the Software in any computer-readable or printed form for back-up or archival purposes;

=y

N

No right to recopy, sell, distribute, license, sub-license, alter, modify, disassemble, de-compile or reverse engineer
any Software in any manner whatsoever is hereby given, except as provided in this Agreement. Violation may
result in severe civil and/or criminal penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such;

4 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the
purpose of installation, service integration and/or support of said Software within Licensee's product. In such
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this
Agreement;

o

Licensee may not grant any sublicense, lease or other right in the Software to others;

o]

Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or
recommendations to Matrox regarding the Licensed Software and/or Licensee's product ("Feedback"), Matrox is
free to use and incorporate such Feedback in Matrox's products, without payment of royalties or other
consideration to Licensee.
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OEM LICENSE

Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's
product or as a standalone Software maintenance update for existing end users of Licensee's products, excluding
any other standalone products, subject to these conditions:

1 This Software is licensed for use only in conjunction with Matrox products. Use of the Software in
conjunction with non-Matrox products is not licensed hereunder;

N

No right to recopy, sell, distribute, license, sub-license, alter, modify, disassemble, de-compile or reverse
engineer any Software in any manner whatsoever is hereby given, except as provided in this Agreement.
Violation may result in severe civil and/or criminal penalties, as violators will be prosecuted to the maximum
extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using
the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such;

4 You may only distribute the Software to your customers pursuant to a written license agreement. At a
minimum such license shall safeguard Matrox's ownership rights to the Software;

5 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for
the purpose of installation, service integration and/or support of said Software within Licensee's product. In
such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third
party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions
of this Agreement;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or
recommendations to Matrox regarding the Licensed Software and/or Licensee's product ("Feedback"),
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or
other consideration to Licensee.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)

There are inherent dangers in the use of any software available for downloading on the Internet and Matrox
cautions Licensee to ensure that Licensee completely understands the potential risks before downloading any of
the Software. Licensee is solely responsible for adequate protection and backup of the data and equipment used
in connection with any of the Software, and Matrox will not be liable for any damages that may be suffered in
connection with use of the Software.

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically
applies, without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities.

COPYRIGHT

All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by
Matrox or its suppliers. All title and intellectual property rights in and to the content which may be accessed
through use of the Software is the property of the respective content owner and may be protected by applicable
copyright or other intellectual property laws and treaties. This Software License Agreement grants you no rights
to use such content. All rights not expressly granted are reserved by Matrox

DISCLAIMER OF WARRANTIES

Licensee expressly acknowledges and agrees that use of the Software is at Licensee's sole risk. The Software and
Documentation is provided "AS IS" AND WITHOUT WARRANTY OF ANY KIND AND MATROX
EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NON-INFRINGEMENT. MATROX DOES NOT WARRANT THAT THE CONTENTS OF
THE SOFTWARE OR DOCUMENTATION WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE
OPERATION OF THE SOFTWARE OR DOCUMENTATION WILL BE UNINTERRUPTED OR
ERROR-FREE. THE ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE AND
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DOCUMENTATION IS ASSUMED BY LICENSEE. FURTHERMORE, MATROX DOES NOT WARRANT OR
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE
SOFTWARE OR DOCUMENTATION IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY,
CURRENTNESS, OR OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE OR DOCUMENTATION
PROVE DEFECTIVE, LICENSEE ASSUMES THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO LICENSEE.

LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE.
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED
HEREIN.

LIMITATION OF LIABILITY

UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES AND ITS SUBSIDIARIES BE
LIABLE FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL
DAMAGES THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS
LIMITATION APPLIES WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT,
NEGLIGENCE, STRICT LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY
IN SUCH JURISDICTIONS SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW.

UNAUTHORIZED USE. THIS SOFTWARE AND ANY DOCUMENTATION RELATED THERETO ARE NOT
DESIGNED, INTENDED, AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY
TYPE OF SYSTEM OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY
HAZARDOUS ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL SYSTEMS,
LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, AIRCRAFT
NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC WORKS, WEAPONS
SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A PRODUCT COULD LEAD TO
PROPERTY DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL INJURY. LICENSEE WILL NOT USE,
OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL
APPLICATIONS AND FURTHER, LICENSEE AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS
MATROX AND ITS MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES,
SUCCESSORS, AND ASSIGNS FROM AND AGAINST ANY ACTION, SUIT , PROCEEDING, COST,
EXPENSE, DAMAGES, AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE
ATTORNEYS' FEES) ARISING OUT OF , OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS
RELATED HERETO, EVEN IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING
THE DESIGN OR MANUFACTURE OF THE SOFTWARE.

TERMINATION

This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In
such event, Licensee must destroy all copies of the Software and all of its component parts. Matrox reserves the right
to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee
violates any of this Licenses' terms and conditions.

Matrox will not, by reason of the termination of this Agreement, be liable for compensation, reimbursement or
damages on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments,
leases, or commitments in connection with the Licensee's business or goodwill or otherwise.
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If Licensee commences or participates in any legal proceeding against Matrox then Matrox may, in its sole
discretion, suspend or terminate all license grants and any other rights provided under this License during the
pendency of such legal proceedings.

MISCELLANEOUS

If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision
will be construed as limited to the extent necessary to be consistent with and fully enforceable under the law.
This License is the final, complete and exclusive agreement between the parties relating to the subject matter
hereof, and supersedes all prior or contemporaneous understandings and agreements relating to such subject
matter, whether oral or written. This License may only be modified in writing signed by an authorized officer of
Matrox. Licensee agrees that it will not ship, transfer or export the Software into any country, or use the Software
in any manner, prohibited by the United States Bureau of Industry and Security or any export laws, restrictions or
regulations.

Controlling Law. The validity, performance and construction hereof shall be governed by and interpreted in
accordance with the laws of the Province of Quebec. Both parties hereby irrevocably submit to the exclusive
jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute
arising out of or in connection with this Agreement.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary
notices and copyright information, the terms of which must also be observed and followed.

The failure of Matrox to enforce at any time any of the provisions of this Agreement, or the failure to require at
any time performance by the Licensee of any of the provisions of this Agreement, shall in no way be construed to
be a present or future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and
every such provision thereafter.

All rights reserved by Matrox.

Matrox reserves the right to change Software specification without notice. All intellectual property, including
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Introducing Matrox MXO0O2

This chapter lists the MXO2
system requirements, details
the battery requirements and
guidelines, and describes the
MXO2 documentation.



Welcome to Matrox MX02

Matrox MXO2 connects to your Mac system to provide broadcast-quality
input/output, monitoring, and up/down/cross conversion to streamline your
workflow with supported video editing applications. MXO2 provides built-in
surround sound monitoring, as well as the flexibility to map any audio track from
a video editing application to any audio output. MXO2 also features the Matrox
HDMI Calibration Utility, which is a unique tool designed to calibrate your RGB
HDMI monitor or television so that it performs like a traditional broadcast video
monitor. For Matrox MXO2 products with Matrox MAX technology, the
dedicated hardware processor accelerates the creation of H.264 .mov files for
Blu-ray Disc, the web, and mobile devices.

Matrox MX0O2 system requirements

Matrox MXO2 requires a Mac system with the following configuration:

Note For the most up-to-date system requirements, see the Matrox MXO2
Support section of our website at www.matrox.com/video/support.

* Mac OS X Mavericks, Mountain Lion, or Lion. For the supported OS
versions for this release, see the “Supported OS and Applications” document
provided in the “Downloads” section of the Matrox MXO2 Support website.

Note MXO2 Dock is supported with Mac OS X Mavericks and Mountain
Lion only.

* One free PCle slot to install the Matrox PCle host adapter (for desktops), or
one free ExpressCard/34 slot to install the Matrox PClIe host ExpressCard/34
adapter (for laptops), or one free Thunderbolt port to connect the Matrox
MXO2 Thunderbolt adapter or MXO2 Dock.

Note A third-party Thunderbolt cable is required to connect the Matrox
MXO2 Thunderbolt adapter or Matrox MXO2 Dock to your computer.

* We recommend an HDMI monitor that supports the following:
— An HDMI input resolution of 1920x 1080 for previewing all HD formats.

— 1:1 pixel mapping for displaying your MXO2 output at its exact
resolution, and for use with the Matrox HDMI Calibration Utility.

Supported programs

For a complete list of the third-party applications supported with this release, see
the “Supported OS and Applications” document provided in the “Downloads”
section of the Matrox MXO2 Support website.
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Check our website for equipment information
For up-to-date information about recommended computer systems, batteries, and
other MXO2-compatible devices, check the Matrox MXO2 Support section of
our website at www.matrox.com/video/support.

Battery requirements and guidelines for MX0O2

Note This section does not apply to Matrox MXO2 Rack and Matrox MX02
Mini as they cannot be powered by a battery.

As an alternative to using an AC outlet, you can use a battery to power Matrox
MXO2 or MXO2 LE. To avoid damage to your MXO2 system and peripheral
devices when using a battery, please observe the following requirements and
guidelines. For instructions on how to connect a battery, see “Powering MX02”
on page 12 or “Powering MXO2 LE” on page 32.

» Use a standard self-protected (fused) battery with a nominal voltage of 12V,
13.2V, or 14.4V. A higher-voltage battery will damage your MXO2 system.

* Disconnect MXO?2 from the battery when not in use. Do not leave MXO2
connected to the battery when not in use as this may damage your MXO2
system and/or battery.

* Do not power your MXO?2 using your vehicle’s battery via the power socket.
A Caution To avoid damage to your MXO2 system and peripheral devices, use a
Matrox-recommended battery. For a list of batteries recommended for use with

your MXO2, visit the Matrox MXO2 Support section of our website at
www.matrox.com/video/support.

About this guide

This guide provides you with information about installing and using your Matrox
MXO2 hardware and software, including how to configure your Matrox MX02
for use with supported programs.

Style conventions
The following style conventions are used in this guide:

* The names of files, folders, and documents appear in italics. For example:
— The data is stored in the Sample Movie file.
— The file is located in the Clips folder.
— Please refer to your Matrox MXO?2 Installation and User Guide.

* Menus and commands that you need to choose are displayed in the form
Menu > Command. For example, File > Save means click File in the
menu bar, and then click Save in the menu that appears.

Battery requirements and guidelines for MX02
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How video formats are expressed
With the exception of NTSC and PAL, all SD and HD video formats are
expressed in the Matrox MXO2 documentation as follows:

VRp ori or PsF at n fps

Where:

¢ VR s the vertical resolution. For 1440x 1080 video, however, both the
horizontal and vertical resolutions are specified.

» porior PsF represents either progressive, interlaced, or progressive
segmented frame video.

* n fps is the frame rate in frames per second.

Here are some examples:
* 486p at 23.98 fps Represents 720x486 progressive video at 23.98 frames
per second.
* 720p at 59.94 fps Represents 1280x720 progressive video at 59.94 frames
per second.

* 1440x1080i at 29.97 fps Represents 1440x 1080 interlaced video at 29.97
frames per second. This format is used for HDV 1080i material.

» 1080i at 29.97 fps Represents full-size 1920x 1080 interlaced video at
29.97 frames per second.

Last-minute information
Any important information that wasn’t available for inclusion in this manual by
publication time is provided to you in the Matrox MXO2 Release Notes.
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Installing Your Matrox MXO2
Hardware and Software

This chapter describes how to
install Matrox MXO2 hardware
(PCle adapters only) and
software.



Important installation information

This chapter explains how to install Matrox software and hardware on your Mac
system. However, hardware installation is required only if you’ll be using MXO2
with the Matrox MXO2 PCle host adapter or Matrox MXO2 PCle
ExpressCard/34 adapter. If you want to use MXO2 with the Matrox MXO2
Thunderbolt adapter or MXO2 Dock, hardware installation is not required.

Before installing your Matrox hardware

Read the following information carefully before attempting to install the Matrox
MXO2 PClIe host adapter on your Mac system.

Start with a functioning system

Before attempting any Matrox MXO?2 installation, you should have a Mac
computer system with Mac OS X fully installed and functioning smoothly. This
will avoid potential problems later on.

Avoid costly damage

Static electricity from your body can damage your Matrox PCle host adapter or
your computer. Although you may not notice it, static electricity is generated
every time you move. It’s often too small to cause a spark, but it can still cause
damage to sensitive electronic components or at least reduce their lifespan.

To avoid damage, please observe the following precautions:

* Do not remove your Matrox PCle host adapter from its antistatic bag until
you’re ready to install it. Before removing the card, place the package within
easy reach of the area where you intend to perform the installation.

* You should avoid touching the chips and other components on the circuit
board. Try to handle the card by its edges.

* Try to work in an area where the relative humidity is at least 50%.

* Do not wear wool or synthetic clothing. These fabrics tend to generate more
static electricity than cotton, which is best for this kind of work.

* Turn off the power switches on your computer and its connected
components.

Once you’ve opened your computer, drain static electricity from your body by
touching a bare metal surface on your computer chassis before you install or
remove any parts of your system. If you have a grounding wrist strap, use it while
handling and installing any components in your computer.

Installing your Matrox PCle adapter

This section details how to install the Matrox MXO2 host adapter and Matrox
MXO?2 host ExpressCard/34 adapter on your Mac computer.
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Note If you want to use MXO2 with the Matrox MXO2 Thunderbolt adapter
or MXO2 Dock, hardware installation is not required.

Installing your PCle host adapter (for desktops)
The Matrox PCle host adapter is a standard low-profile PCle x1 card designed to
operate in an Intel-based Mac system. For detailed instructions on how to
perform the following steps, refer to your Mac desktop computer’s
documentation.

1 Shut down the computer, unplug the power cord and all the cables from the
unit, and open the computer’s chassis.

2 Insert the Matrox PCle host adapter in an available PCIe slot in the
computer, and secure the adapter into place.

3 Close the computer chassis, and reconnect the power cord and all the cables
to the unit.

Installing your PCle host ExpressCard/34
adapter (for laptops)

The Matrox PCle host ExpressCard/34 adapter is designed to operate in your
Mac laptop’s ExpressCard/34 slot. You can install the Matrox PCle host
ExpressCard/34 adapter when your laptop is on or off. Connect the Matrox PCle
cable to the host ExpressCard/34 adapter, and then insert the host adapter in your
laptop’s ExpressCard/34 slot until the adapter clicks into place. For details on
how to safely remove your Matrox PCle host ExpressCard/34 adapter from your
laptop, see “Removing your PCle host ExpressCard/34 adapter” on page 8.

Matrox PCle
ExpressCard/34

ExpressCard/34 slot
Caution To ensure functionality and avoid damaging the PCle cable or

host connector, the side labeled “B” on the PCle cable connector must face
the top of the Matrox PCle ExpressCard/34 adapter.

Installing your Matrox PCle adapter



Removing your PCle host ExpressCard/34

adapter
You can remove the Matrox PCle host ExpressCard/34 adapter when the laptop is
either on or off. However, you must power off the card before removing it.

@ Important Do not disconnect the PCle cable from the Matrox PCle host
ExpressCard/34 adapter when your laptop is running. Instead, remove the adapter
from your laptop with the Matrox PCle cable attached.

1 Close all video/audio applications that are running on your system.
2 From the menu bar, click the ExpressCard icon ([ZJ0).
3 Click Power off Card.

4 Remove the Matrox PCle host ExpressCard/34 adapter from your laptop’s
ExpressCard/34 slot.

Installing your Matrox MXO2 software

You can install the MXO2 software on a computer with or without the MXO2
hardware connected. To download and install the latest version of the MXO2
software, visit the MXO2 Support section of our website at
www.matrox.com/video/support. You can also contact your MXO2 dealer for the
latest software.

@ Important

* If your MXO?2 system also includes a Matrox CompressHD card, you must
install the Matrox MAX Ultilities software, even if your MXO2 hardware
does not include Matrox MAX technology. Installing the Matrox MAX
Utilities software installs the software for your CompressHD card as well. If
the CompressHD software is already installed on your computer, you must
uninstall it before installing the Matrox MAX Utilities software.

 If you plan on working with a supported video editing application, such as
Adobe Premiere Pro, you must install that application before installing the
MXO?2 software.

Updating your MXO2 firmware

When you install the MXO2 software while your MXO2 hardware is powered
and connected to your Mac system, the software installation automatically
verifies the firmware on your MXO2 hardware and updates it if required.
However, if you install the MXO2 software on your Mac system without a
powered MXO2 connected, your MXO2 hardware may have a firmware version
that is not supported by the installed MXO2 software. If your MXO2 hardware
has an incompatible firmware version when you later connect the MX02
hardware to your Mac system, the Matrox Utilities preferences window options
will be unavailable and a message regarding the incompatibility between the
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MXO02 software and MXO2 firmware will appear on the Info pane (see “Viewing
MXO?2 information” on page 72), along with a Launch firmware updater
button.

To update the MXO2 firmware from the Matrox Utilities preferences window,
make sure your MXO2 hardware is powered and connected to your computer,
and then click Launch firmware updater on the Info pane to run the Matrox
Firmware Updater. You’ll be required to shut down your system, with your
MXO2 powered and connected to your computer, to complete the firmware
update. If updating the firmware for Matrox MXO2 Mini, you must unplug your
MXO2 Mini from the AC outlet, and then re-plug it before restarting your
system.

A Caution Do notdisconnect or power off MXO2, or interrupt the firmware update
during the update process. Doing so may damage your MXO2 hardware.

Alternately, you can update your MXO2 firmware by running the Matrox
firmware updater from the Finder window as follows:

1 With your Mac system shut down, supply power to your MXO2, and connect
it to your Mac system.

2 Start your computer.
3 In the Finder menu, choose File > New Finder Window.

4 In the Applications folder, click the Matrox utilities folder, and then
double-click the firmware updater file to run the Matrox Firmware Updater.
You’ll be required to shut down your system, with your MXO2 powered and
connected to your computer, to complete the firmware update. If updating
the firmware for Matrox MXO2 Mini, you must unplug your MXO2 Mini
from the AC outlet, and then re-plug it before restarting your system.

Disable App Nap for editing applications on
Mac OS X Mavericks

To avoid issues with using your editing applications on a Mac OS X Mavericks
system, you should turn off the App Nap feature for those applications. To do
this, open the application’s folder (such as for Final Cut Pro), right-click the
application, choose Get Info, and in the displayed pane, select Prevent App
Nap in the General section. When App Nap is disabled, the application will
always run at full power.

Removing your Matrox MXO2 software

Perform the following steps to remove the MXO2 software from your Mac
system.

Disable App Nap for editing applications on Mac OS X Mavericks
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1 In the Finder menu, choose File > New Finder Window.

2 In the Applications folder, click the Matrox utilities folder, and then
double-click the software uninstaller file.

3 In the uninstaller dialog box, select or clear the Delete the Matrox
software user preferences option. When selected, all current user settings
in the Matrox Utilities preferences window will be removed from your
computer. Clear this option if you wish to keep your current MXO2 user
settings for a future MXO2 software installation.

4 Click Continue.

5 Enter your administrator password, and click OK to remove the MXO02
software from your computer.

Chapter 2, Installing Your Matrox MX0O2 Hardware and Software
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Note This chapter details how to connect external devices to Matrox MXO2
only. For another MXO?2 product, see Chapter 4, “Connecting External Devices
to Matrox MXO2 Rack”, Chapter 5, “Connecting External Devices to Matrox
MXO2 LE”, or Chapter 6, “Connecting External Devices to Matrox MX02
Mini.”

Available MXO2 connections

Matrox MXO?2 features a full compliment of professional inputs and outputs, and
allows you to connect multiple devices for up to five user-selectable simultaneous
video outputs.

MXOZ2 video connections
* One HD HDMI input and one HD/SD HDMI output, both with up to eight
channels of embedded audio support. The HDMI input/output supports YUV
and RGB devices.

* One HD/SD SDI input and two HD/SDI outputs with up to 16 channels of
embedded audio. Both SDI outputs simultaneously output the same video
and embedded audio.

* One HD/SD analog component input/output, one S-Video input/output, and
one composite input/output.

* Analog black burst reference input.

MXO2 audio connections
* Two balanced analog XLR inputs (stereo pair).

» Four balanced analog XLR outputs (two stereo pairs).
* One AES/EBU stereo input/output.
* Two unbalanced analog RCA inputs (stereo pair).

* Six unbalanced analog RCA outputs (for surround sound monitoring).

Powering MXO2

Supply power to MXO2 using an AC outlet via the Matrox external power supply
and a power cord, or using a battery via the Matrox battery power cable. Matrox
MXO2 connects to the battery via a 4-pin XLR connector. For information on
how to connect your battery to portable video equipment, such as Matrox MXO?2,
contact the battery manufacturer. Before connecting MXO?2 to a battery, please
read the “Battery requirements and guidelines for MXO2” on page 3.

MXO2 power functionality

MXO?2 features a power button that you can use to manually turn the MXO2 on
and off. However, when power is supplied to MXO2 and it is connected to your
Mac system, the MXO2 will turn on or off automatically when you start up or

Chapter 3, Connecting External Devices to Matrox MX02
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shut down your Mac system. That is, when you shut down your Mac system, your
MXO?2 turns off. Starting up your Mac system turns your MXO2 on. To manually
turn your MXO2 on, press the power button. To turn off your MXO2, press and
hold the power button for at least two seconds.

@ Important When MXO2 is connected to a Mac system that is running, do not
disconnect MXO2 from its power source, or power off MXO2. Shut down your
Mac system before removing power from MXO?2. If using a battery to power
MXO02, ensure that the battery is sufficiently charged.

: : MX02
i e (side view)
; o@D
External Power button
power supply OR
A Caution When
disconnecting the power
supply from MXQO?2,

make sure that you slide
back the casing on the
connector to release the
locking mechanism.

Matrox battery
power cable

ma—"

Battery on a
universal battery
adapter

Female 4-pin/
XLR cable

Power cord

To AC
outlet

Powering MX0O2
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Connecting MXO2 to your Mac system

Connect MXO?2 to your Mac system using the Matrox PCle cable and the
appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCle cable connection

To ensure functionality and avoid damaging the PCle cable or host connector
when connecting MXO2 to your computer, the PCle cable must be connected to
your MXO2 and host connector as shown below:

To Matrox MX02

“B” side of PCle cable must face the side
labeled “HOST” on MXO2.

To Matrox PCle ExpressCard/34 adapter
“B” side of PCle cable must face the
top of the Matrox PCle
ExpressCard/34 adapter.

To Matrox MX02 Thunderbolt adapter
“B” side of PCle cable must face the
side labeled “HOST” on the Matrox
MXO2 Thunderbolt adapter.

To Matrox MX02 Dock

“B” side of PCle cable must face the top
of MXO2 Dock.

To Matrox PCle host adapter

“B” side of PCle cable must face the side
labeled “XI LINK” on the Matrox PCle
host adapter.

Chapter 3, Connecting External Devices to Matrox MX02



15
Using Matrox MXO2 Dock

For instructions on how to connect and use Matrox MXO2 Dock, see Appendix
E, “Connecting and Using Matrox MXO2 Dock,” on page 185.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO2 Thunderbolt adapter to connect MXO?2 to your
computer’s Thunderbolt port. When doing this, it may take up to ten seconds for
your MXO2 to be detected by your system and its applications.

Important Make sure that the Matrox PCle cable is connected to the adapter
and MXO?2 before connecting the adapter to your computer via the Thunderbolt
cable. If you want to disconnect or connect MXO2 when your system is running,
you must do it by disconnecting/connecting the Thunderbolt cable. Do not
disconnect the Matrox PCle cable from the adapter, or MXO2, when your Mac
system is running.

MX02
(side view)

A Caution To ensure functionality and avoid
damaging the PCle cable or host connector, you
must connect the PCle cable as shown in
“Ensuring proper PCle cable connection” on

page 14.
«
] I — Thunderbolt cable
‘ (Not included. A
Matrox MX0O2 Thunderbolt cable is
Thunderbolt adapter required to connect the

Matrox MXO2 Thunderbolt
adapter to your computer.)

“\ @ motrox MXO2

To your computer’s
Thunderbolt port.

Connecting MXO2 to your Mac system
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Using the Matrox PCle host adapters

For MXO2 to be detected on a Mac desktop system, power must be supplied to
MXO2 (see “Powering MXO2” on page 12), and it must be connected to your
computer before starting up your system.

@ Important Do not disconnect the Matrox PCle cable from the adapter, or
MXO2, when your Mac system is running. To safely remove the Matrox PCle
host Expresscard/34 adapter, see “Removing your PCle host ExpressCard/34
adapter” on page 8.

Jel|  mxo2
(side view)

A Caution To ensure functionality and
avoid damaging the PCle cable or host
connector, you must connect the PCle
cable as shown in “Ensuring proper PCle
cable connection” on page 14.

PCle cable

Matrox PCle host
ExpressCard/34

i dapter
A

Matrox PCle
host adapter

To your laptop’s ExpressCard/34
slot (see “Installing your PCle host
ExpressCard/34 adapter (for
laptops)” on page 7).

Chapter 3, Connecting External Devices to Matrox MX02
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MXO2 RS-422 serial connection

MXO02’s RS-422 serial connector allows a video editing application, such as
Adobe Premiere Pro, to control a device that uses the RS-422 SMPTE time code
protocol, such as a VTR or digital disk recorder, to ensure frame-accurate capture
and export to tape.

MXO02
(side view)

RS-422 serial cable

|
RS122

RS-422 device

MXO2 RS-422 serial connection
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Typical Matrox MXO2 connections

In the following typical connection examples, we’ve connected a monitor to view
the signal that will be recorded, and separate source and record decks. You may,
however, use the same deck as both your source and record device by making the
input and output connections to a single deck. For details on the Matrox MXO2
connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections
In this illustration, we’re using analog component connectors for video, XLR

connectors for audio, and an HDMI connector for video monitoring. The video is
genlocked using MXO2’s internal genlock.
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Digital video connections

In this illustration, we’re using SDI connectors for video and audio, an SDI
connector for video monitoring, and we’re monitoring the audio on a surround
sound speaker system through RCA connectors. The video is genlocked using a
tri-level sync generator.

Tri-level N Source
sync (Deck 1)
generator
MXO02 Inputs
L(1) INPUT
matrox MXO 2 ‘ ‘ Rm
1

Q MXO2 Outputs é é

OUTPUT L) cp) LS

8000' &

R@) LFE@) RSE)

AESEBU

J_LE

sol

INPUT

Video monitor

Rsm @ Lse) | < Jm———mr-—
er) @ c@ | < ihm—
R — (| I Ra) @ v | < m—

INPUT

Recorder (Deck 2) Surround sound
speaker system

Typical Matrox MXO2 connections
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Your notes

Chapter 3, Connecting External Devices to Matrox MX02
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Note This chapter details how to connect external devices to Matrox MXO2
Rack only. For another MXO?2 product, see Chapter 3, “Connecting External
Devices to Matrox MX02”, Chapter 5, “Connecting External Devices to Matrox
MXO02 LE”, or Chapter 6, “Connecting External Devices to Matrox MX02
Mini.”

Available MX0O2 Rack connections

Matrox MXO2 Rack features a full compliment of professional inputs and
outputs, and allows you to connect multiple devices for up to five user-selectable
simultaneous video outputs.

MXO2 Rack video connections
* One HD HDMI input and one HD/SD HDMI output, both with up to eight

channels of embedded audio support. The HDMI input/output supports YUV
and RGB devices.

* One HD/SD SDI input and two HD/SDI outputs with up to 16 channels of
embedded audio. Both SDI outputs simultaneously output the same video
and embedded audio.

* One HD/SD analog component input/output, one S-Video input/output, and
one composite input/output.

* One analog black burst reference input and loop-through output.

MXO2 Rack audio connections
* Four balanced analog XLR inputs (two stereo pairs).
» FEight balanced analog XLR outputs (four stereo pairs).
* Two AES/EBU stereo inputs/outputs.

Rack mounting your MXO2 Rack

Use the supplied rackmount brackets to mount your Matrox MXO2 Rack to a
standard 19-inch rack. The rackmount brackets can be used to either front or rear
mount your MXO2 Rack. You can also mount MXO2 Rack so that it’s recessed
to allow more space for cables. MXO2 Rack takes up two vertical rack unit
spaces.

1 Unpack the two rackmount brackets and their eight mounting screws.

Caution Use only the screws supplied with your MXO2 Rack to attach the
rackmount brackets to your MXO2 Rack. If you use screws that are larger or
longer than the ones supplied, you can damage your equipment.

2 Depending if you want to front or rear mount your MXO2 Rack, position the
rackmount brackets so that the bracket face is either towards the front
(connector side) or the back of your MXO2 Rack.

Chapter 4, Connecting External Devices to Matrox MX0O2 Rack
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3 MXO02 Rack can be recess mounted to allow extra space for connectors and
cables. Depending on your mounting needs, align the screw holes on each
rackmount bracket with the desired screw holes on either side of the MXO02
Rack.

Front rackmounting

=Ty

Rackmount \add b
bracket MXO2 Rack o0

V o

®oee
AT

A Caution For stability and safety, whichever mounting method you choose,
make sure to fasten each rackmount bracket to MXO2 Rack using all four

supplied screws.

4 Using a hand screwdriver only (no power screwdrivers), carefully tighten
each screw until snug. Do not overtighten!

5 Fasten your MXO2 Rack to the standard 19-inch rack as per your rack’s
instructions.

Rack mounting your MX0O2 Rack
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Powering MXO2 Rack
You can power MXO2 Rack using an AC outlet and an IEC-C13 power cord.

MXO2 power functionality

When power is supplied to MXO2 Rack and it is connected to your Mac system,
the MXO2 Rack will turn on or off automatically when you start up or shut down
your Mac system. That is, when you shut down your Mac system, your MXO02
Rack turns off. Starting up your Mac system turns your MXO2 Rack on.

@ Important When MXO2 Rack is connected to a Mac system that is running,
do not disconnect MXO2 Rack from its power source. Shut down your Mac
system before removing power from MXO2 Rack.

MXO02 Rack

ANALOG AUDIO AESEBU

—_— ——  —  —  ——  ———  ——

. . 7 .
© © @ @ @ @ @ ) !
. . . . . . .
& @ ® & @ & & ©)

AUALOG AUDIO
W0-20V_SUBIHz L0000,
s <

020000 Rsa22
= o (@le |<em cem tem cen
B e
PR
8 o000 HosT
i renroree g
Sndeiivhe  oEDe ® ® ® ®

(== MXO2 Rack

AESEBU

IEC-C13
power cord
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Connecting MX0O2 Rack to your Mac system

Connect MXO2 Rack to your Mac system using the Matrox PCle cable and the
appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCle cable connection

To ensure functionality and avoid damaging the PCle cable or host connector
when connecting MXO2 Rack to your computer, the PCle cable must be
connected to your MXO2 Rack and host connector as shown below:

To Matrox MX02 Rack

“B” side of PCle cable must face the side
labeled “HOST” on MXO2 Rack.

To Matrox PCle ExpressCard/34 adapter
“B” side of PCle cable must face the
top of the Matrox PCle
ExpressCard/34 adapter.

To Matrox MXO2 Thunderbolt adapter
“B” side of PCle cable must face the
side labeled “HOST” on the Matrox
MXO2 Thunderbolt adapter.

To Matrox MIX0O2 Dock

“B” side of PClIe cable must face the top
of MXO2 Dock.

To Matrox PCle host adapter

“B” side of PCle cable must face the side
labeled “XI LINK” on the Matrox PCle
host adapter.

Connecting MXO2 Rack to your Mac system
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Using Matrox MXO2 Dock

For instructions on how to connect and use Matrox MXO2 Dock, see Appendix
E, “Connecting and Using Matrox MXO2 Dock,” on page 185.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO02 Thunderbolt adapter to connect MXO2 Rack to your
computer’s Thunderbolt port. When doing this, it may take up to ten seconds for
your MXO2 Rack to be detected by your system and its applications.

@ Important Make sure that the Matrox PCle cable is connected to the adapter
and MXO2 Rack before connecting the adapter to your computer via the
Thunderbolt cable. If you want to disconnect or connect MXO2 Rack when your
system is running, you must do it by disconnecting/connecting the Thunderbolt
cable. Do not disconnect the Matrox PCle cable from the adapter, or MXO2
Rack, when your Mac system is running.

ANALOG AUDIO AES/EBU

e MXS 2 Rack { "" ""

OUTPUT

ve
Nan

)
ANALOG AUDIO
100-28 =000 e LEUT
0-0 o
0 ® ve
0 “05' o .

MXO02 Rack _

A Caution To ensure functionality and avoid
damaging the PCle cable or host connector,
you must connect the PCle cable as shown in
“Ensuring proper PCle cable connection” on

PCle cable

page 25.
- /
P I > Thunderbolt cable
Mat MXO2 (Not included. A
atrox .
Thunderbolt adapter Thunderbolt cable is

required to connect the
Matrox MXO2 Thunderbolt
adapter to your computer.)

To your computer’s
Thunderbolt port.
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Using the Matrox PCle host adapters

For MXO2 Rack to be detected on a Mac desktop system, power must be
supplied to MXO2 Rack (see “Powering MXO2 Rack” on page 24), and it must
be connected to your computer before starting up your system.

@ Important Do not disconnect the Matrox PCle cable from the adapter, or
MXO2 Rack, when your Mac system is running. To safely remove the Matrox
PCle host Expresscard/34 adapter, see “Removing your PCle host
ExpressCard/34 adapter” on page 8.

ANALOG AUDIO [ SOIA

P —— § ——— T ——

@ ‘ G‘ G‘
@ @ @ @ () @ @ (@)

ANALOG AUDIO
Rs42

OO
® ® © © ® ®

A

nEt s MXSE Rack

100- 240 V=500 Hz
30A MAX.

¥ —— Pb— b i

MX02 Rack A Caution To ensure functionality and avoid
B | damaging the PCle cable or host connector,
you must connect the PCle cable as shown in
“Ensuring proper PCle cable connection” on
PCle cable

page 25.

Matrox PCle host
Matrox PCle ExpressCard/34

host adapter i adapter

To your laptop’s ExpressCard/34
slot (see “Installing your PCle host
ExpressCard/34 adapter (for
laptops)” on page 7).
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MXO2 Rack RS-422 serial connection

The Matrox MXO2 Rack RS-422 serial connector allows a video editing
application, such as Adobe Premiere Pro, to control a device that uses the RS-422
SMPTE time code protocol, such as a VTR or digital disk recorder, to ensure
frame-accurate capture and export to tape.

RS-422 device N
|

RS-422 serial cable

J\ e —————
=S 0&0 [ % y ‘
g HOST R\
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MXO02 Rack
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Chapter 4, Connecting External Devices to Matrox MX0O2 Rack
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Typical Matrox MX0O2 Rack connections

In the following typical connection examples, we’ve connected a monitor to view
the signal that will be recorded, and separate source and record decks. You may,

however, use the same deck as both your source and record device by making the
input and output connections to a single deck. For details on the Matrox MXO2

Rack connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections

In this illustration, we’re using analog component connectors for video, XLR
connectors for audio, and an HDMI connector for video monitoring. The video is
genlocked using MXO2’s internal genlock.
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Digital video connections

In this illustration, we’re using SDI connectors for video and audio, an SDI
connector for video monitoring, and we’re monitoring the audio on a surround
sound speaker system through XLR connectors. The video is genlocked using a
tri-level sync generator.
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Note This chapter details how to connect external devices to Matrox

MXO2 LE only. For another MXO2 product, see Chapter 3, “Connecting
External Devices to Matrox MX02”, Chapter 4, “Connecting External Devices to
Matrox MXO2 Rack”, or Chapter 6, “Connecting External Devices to Matrox
MXO2 Mini.”

Available MXO2 LE connections

Matrox MXO2 LE features a full compliment of professional inputs and output,
and allows you to connect multiple devices for up to five user-selectable
simultaneous video outputs.

MXO2 LE video connections
* One HD HDMI input and one HD/SD HDMI output, both with up to eight
channels of embedded audio support. The HDMI input/output supports YUV
and RGB devices.

* One HD/SD SDI input and two HD/SDI outputs with up to 16 channels of
embedded audio. Both SDI outputs simultaneously output the same video
and embedded audio.

* One HD/SD analog component input/output, one S-Video input/output, and
one composite input/output.

* Analog black burst reference input.

MXO2 LE audio connections
* Two balanced analog XLR inputs/outputs (stereo pair).

» Two unbalanced analog RCA inputs/outputs (stereo pair).

Powering MXO2 LE

Supply power to MXO2 LE using an AC outlet via the Matrox external power
supply and a power cord, or using a battery. Matrox MXO2 LE connects to the
battery via a 4-pin XLR connector. For information on how to connect your
battery to portable video equipment, such as Matrox MXO2 LE, contact the
battery manufacturer. Before connecting MXO2 LE to a battery, please read the
“Battery requirements and guidelines for MXO2” on page 3.

MXO2 LE power functionality

MXO?2 LE features a power button that you can use to manually turn the

MXO?2 LE on and off. However, when power is supplied to MXO2 LE and it is
connected to your Mac system, the MXO2 LE will turn on or off automatically
when you start up or shut down your Mac system. That is, when you shut down
your Mac system, your MXO2 LE turns off. Starting up your Mac system turns
your MXO2 LE on. To manually turn your MXO2 LE on, press the power button.

Chapter 5, Connecting External Devices to Matrox MX0O2 LE
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To turn off your MXO?2 LE, press and hold the power button for at least two
seconds.

@ Important When MXO2 LE is connected to a Mac system that is running, do
not disconnect MXO2 LE from its power source, or power off MXO2 LE. Shut
down your Mac system before removing power from MXO2 LE. If using a
battery to power MXO?2 LE, ensure that the battery is sufficiently charged.

o f : 95| MxozLE

[:ﬁ é e i ofilde Q@ ﬂj (side view)
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power supply OR

Female 4-pin
XLR cable

Power cord

Battery on a
universal battery
adapter

To AC
outlet

Powering MX0O2 LE
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Connecting MXO2 LE to your Mac system

Connect MXO?2 LE to your Mac system using the Matrox PCle cable and the
appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCle cable connection

To ensure functionality and avoid damaging the PCle cable or host connector
when connecting MXO2 LE to your computer, the PCle cable must be connected
to your MXO?2 LE and host connector as shown below:

To Matrox MXO02 LE

“B” side of PCle cable must face the side
labeled “HOST” on MXO2 LE.

To Matrox PCle ExpressCard/34 adapter
“B” side of PCle cable must face the
top of the Matrox PCle
ExpressCard/34 adapter.

To Matrox MX02 Thunderbolt adapter
“B” side of PCle cable must face the
side labeled “HOST” on the Matrox
MXO2 Thunderbolt adapter.

To Matrox MX02 Dock

“B” side of PClIe cable must face the top
of MXO2 Dock.

To Matrox PCle host adapter

“B” side of PCle cable must face the side
labeled “XI LINK” on the Matrox PCle
host adapter.

Chapter 5, Connecting External Devices to Matrox MX0O2 LE
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Using Matrox MXO2 Dock

For instructions on how to connect and use Matrox MXO2 Dock, see Appendix
E, “Connecting and Using Matrox MXO2 Dock,” on page 185.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO2 Thunderbolt adapter to connect MXO?2 LE to your
computer’s Thunderbolt port. When doing this, it may take up to ten seconds for
your MXO2 LE to be detected by your system and its applications.

@ Important Make sure that the Matrox PCle cable is connected to the adapter
and MXO2 LE before connecting the adapter to your computer via the
Thunderbolt cable. If you want to disconnect or connect MXO2 LE when your
system is running, you must do it by disconnecting/connecting the Thunderbolt
cable. Do not disconnect the Matrox PCle cable from the adapter, or MXO2 LE,
when your Mac system is running.
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Matrox MXO2 Thunderbolt
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Using the Matrox PCle host adapters

For MXO2 LE to be detected on a Mac desktop system, power must be supplied
to MXO2 LE (see “Powering MXO2 LE” on page 32), and it must be connected
to your computer before starting up your system.

@ Important Do not disconnect the Matrox PCle cable from the adapter, or
MXO?2 LE, when your Mac system is running. To safely remove the Matrox PCle
host Expresscard/34 adapter, see “Removing your PCle host ExpressCard/34
adapter” on page 8.

: MXO02 LE
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& Caution To ensure functionality
and avoid damaging the PCle cable
or host connector, you must connect
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MXO2 LE RS-422 serial connection

MXO2 LE’s RS-422 serial connector allows a video editing application, such as
Adobe Premiere Pro, to control a device that uses the RS-422 SMPTE time code
protocol, such as a VTR or digital disk recorder, to ensure frame-accurate capture
and export to tape.

MXO2 LE
(side view)

RS-422 serial cable

|
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RS-422 device

MXO2 LE RS-422 serial connection
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Typical Matrox MXO2 LE connections

In the following typical connection examples, we’ve connected a monitor to view
the signal that will be recorded, and separate source and record decks. You may,
however, use the same deck as both your source and record device by making the
input and output connections to a single deck. For details on the Matrox

MXO?2 LE connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections
In this illustration, we’re using analog component connectors for video, XLR

connectors for audio, and an HDMI connector for video monitoring. The video is
genlocked using MXO2 LE’s internal genlock.
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Digital video connections
In this illustration, we’re using SDI connectors for video and audio, an SDI
connector for video monitoring, and we’re monitoring the audio on a surround
sound speaker system through an HDMI connector. The video is genlocked using
a tri-level sync generator.

Tri-level
sync
generator
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Your notes
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Connecting External Devices to
Matrox MX02 Mini

This chapter shows how to
supply power and connect
external devices to Matrox
MXO2 Mini.
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Note This chapter details how to connect external devices to Matrox MXO2
Mini only. For another MXO2 product, see Chapter 3, “Connecting External
Devices to Matrox MX02”, Chapter 4, “Connecting External Devices to Matrox
MXO02 Rack”, or Chapter 5, “Connecting External Devices to Matrox MX02
LE.”

Available MX0O2 Mini connections

Matrox MXO2 Mini provides inputs and outputs for connecting external devices,
including HDMI, analog component, S-Video, and composite video devices.

MXO2 video and audio connections
* One HD HDMI input and one HD/SD HDMI output, both with up to eight
channels of embedded audio support. The HDMI input/output supports YUV
and RGB devices.
* One HD/SD analog component input/output, or one S-Video input/output
and one composite input/output.

Note S-Video input/output is available by using the provided S-Video

adapters (see “Connecting S-Video devices to MXO2 Mini” on page 47).

* Two unbalanced analog RCA audio inputs/outputs (stereo pair).

Powering MXO2 Mini

®

You can supply power to MXO2 Mini using an AC outlet via the Matrox external
power supply cable. To turn MXO2 Mini off, unplug the Matrox external power
supply cable from the AC outlet while your computer is shut down.

Important When MXO2 Mini is connected to a computer that is running, do
not disconnect MXO2 Mini from its power source. Shut down your computer
before removing power from MXO2 Mini.

MXO2 Mini power supply and adapter plugs
MXO2 Mini provides an external power supply cable with international adapter
plugs for use in different regions:

* To remove an adapter plug from the power adapter, hold down the button
labeled PUSH on the power adapter, and then slide the adapter plug up until
it releases from the power adapter.

» To insert an adapter plug into the power adapter, ensure that the adapter plug
is properly aligned with the corresponding slot on the power adapter, and
then slide the adapter plug down into the power adapter until it locks into
place.

Chapter 6, Connecting External Devices to Matrox MX02 Mini
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Connecting MXO2 Mini to your computer

Connect MXO2 Mini to your Mac system using the Matrox PCle cable and the
appropriate Matrox host adapter or MXO2 Dock.

Ensuring proper PCle cable connection

To ensure functionality and avoid damaging the PCle cable or host connector
when connecting MXO?2 Mini to your computer, the PCle cable must be
connected to your MXO2 Mini and host connector as shown below:

To Matrox MX02 Mini

“B” side of PCle cable must face the side
labeled “HOST” on MXO2 Mini.

To Matrox PCle ExpressCard/34 adapter
“B” side of PCle cable must face the
top of the Matrox PCle
ExpressCard/34 adapter.

To Matrox MX02 Thunderbolt adapter
“B” side of PCle cable must face the
side labeled “HOST” on the Matrox
MXO2 Thunderbolt adapter.

To Matrox MX02 Dock

“B” side of PClIe cable must face the top
of MXO2 Dock.

To Matrox PCle host adapter

“B” side of PCle cable must face the side
labeled “XI LINK” on the Matrox PCle
host adapter.

Chapter 6, Connecting External Devices to Matrox MX02 Mini
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Using Matrox MXO2 Dock

For instructions on how to connect and use Matrox MXO2 Dock, see Appendix
E, “Connecting and Using Matrox MXO2 Dock,” on page 185.

Using the Matrox MXO2 Thunderbolt adapter
Use the Matrox MXO2 Thunderbolt adapter to connect MXO2 Mini to your
computer’s Thunderbolt port. When doing this, it may take up to ten seconds for
your MXO2 Mini to be detected by your system and its applications.

Important Make sure that the Matrox PCle cable is connected to the adapter
and MXO2 Mini before connecting the adapter to your computer via the
Thunderbolt cable. If you want to disconnect or connect MXO2 Mini when your
system is running, you must do it by disconnecting/connecting the Thunderbolt
cable. Do not disconnect the Matrox PCle cable from the adapter, or MXO?2
Mini, when your Mac system is running.
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To your computer’s
Thunderbolt port.
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Using the Matrox PCle host adapters

For MXO2 Mini to be detected on a Mac desktop system, power must be
supplied to MXO2 Mini (see “Powering MXO2 Mini” on page 42), and it must
be connected to your computer before starting up your system.

@ Important Do not disconnect the Matrox PCle cable from the adapter, or
MXO2 Mini, when your Mac system is running. To safely remove the Matrox
PCle host Expresscard/34 adapter, see “Removing your PCle host
ExpressCard/34 adapter” on page 8.

E matrax MXO 2 Mini

HDMI IN E b r HDMI OUT ©

A Caution To ensure functionality and
avoid damaging the PCle cable or host
connector, you must connect the PCle cable
as shown in “Ensuring proper PCle cable
connection” on page 44.

MXO02 Mini

POWER

PCle cable

Matrox PCle
host adapter

Matrox PCle host
ExpressCard/34
adapter

[
Ll

To your laptop’s ExpressCard/34
slot (see “Installing your PCle host
ExpressCard/34 adapter (for
laptops)” on page 7).
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Connecting S-Video devices to MXO2 Mini

To support S-Video connections on MXO2 Mini, your MXO2 Mini kit includes
two S-Video adapter cables (one for S-Video input and one for S-Video output).

Note When you connect an S-Video device to MXO2 Mini, you won’t be able
to connect an analog component device at the same time.

To S-Video OUT connector
on source device

S-Video adapter
cable

Y C

-w@illi © @ Hbw-
=@l ® @ Hhw-

D)

MXO02 Mini

¢

HDMIIN

0](0]

R
@ matrox MXO2 Mini

Y (&3
To S-Video IN connector on
output device

Connecting S-Video devices to MX02 Mini
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Typical Matrox MX0O2 Mini connections

In the following typical connection examples, we’ve connected a monitor to view
the signal that will be recorded, and separate source and record decks. You may,

however, use the same deck as both your source and record device by making the
input and output connections to a single deck. For details on the Matrox MXO2

Mini connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections

In this illustration, we’re using component connectors for video, RCA connectors
for audio, and an HDMI connector for video monitoring. The video is genlocked
to the input source using MXO2 Mini’s built-in genlock.
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HDMI video connections

In this illustration, we’re using HDMI for video, RCA connectors for audio, and
S-Video for video monitoring. The video is genlocked to the input source using
MXO2 Mini’s built-in genlock.

Note When using HDMI connections, the embedded uncompressed HDMI
audio is also available.
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Your notes
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Configuring Your MX0O2 System

This chapter explains how to
configure your MXO2 settings.
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Introduction

This chapter describes the settings in the Matrox Ultilities preferences window for
all MXO2 products. The Matrox Utilities preferences window allows you to
specify various settings for working with MXO2. You can also save and load
custom presets, and view information about your MXO2, such as the serial
number and software version.

Depending on your MXO2 hardware, some of the options described in this
chapter may not be available, and your Matrox Utilities preferences window may
not appear exactly as shown.

Remarks
» Before defining your settings, make sure that you’ve installed your MX02
hardware, powered your MX02, and connected your MXO?2 to your Mac
system.

* If you have an MXO2 product with Matrox MAX technology, the MX02
inputs and outputs will not be available when creating H.264 files using the
Matrox MAX H.264 codec. This limitation, however, does not apply if your
system includes a Matrox CompressHD card. In this case, the Matrox MAX
H.264 codec on your CompressHD card will always be used for the
encoding, and your Matrox inputs and outputs will be available when
creating H.264 files. For details on using the Matrox MAX H.264 codec, see
Chapter 10, “Using the Matrox MAX H.264 Codec.”

Custom presets

You can save and load custom presets of your Matrox MXO2 preference settings.

Saving custom presets

Saving a custom MXO?2 preference settings preset creates a .plist file that you can
load at any time. All settings, except the FCP X setting, are saved in your custom
preset.

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.
2 Specify your MXO?2 settings.

3 Click Save Preset, specify a filename and location, and then click Save.

@ Important Do not save your preset, or overwrite any Matrox files, in

Users/~/Library/Preferences.

Loading custom presets
You can load a custom MXO?2 preference settings preset at any time. Your
MXO?2 settings are automatically updated when you load a preset.

Chapter 7, Configuring Your MX0O2 System
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#| Note Since the FCP X setting is not saved in a custom preset, this setting is not
updated in your Matrox Utilities preferences window when loading a preset.

1 From the Apple menu, click System Preferences, and then click the

Matrox Utilities icon.

2 Click Load Preset, select the custom preset file (.plist) that you want to

load, and then click Open.

Specifying your general settings
You can specify general settings for working with Matrox MXO?2. These settings
are applied to the MXO2 video inputs and outputs.
1 From the Apple menu, click System Preferences, and then click the

Matrox Utilities icon.
2 Click General.

® 0 Matrox Utilities

| « | » || ShowAll |

Q|

Save Preset

| Coneral M

Load Preset

{_Info A/V Input
Luminance Levels

Allow super white
Allow super black

Setup Level

Analog NTSC pedestal:

Video Output | Aud

o Output | CC/AFD | WYSIWYG | FCPX |

7.5IRE *

3 Under Luminance Levels, select Allow super white to allow the highest
luminance level of your video to exceed the standard maximum white level.
Select Allow super black to allow the lowest luminance level of your video

to fall below the standard black level.

Note Super white and super black should not be allowed when producing

your final video production for broadcast.

Specifying your general settings
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4 Under Setup Level, select the pedestal setting that you want for your NTSC
analog video from the Analog NTSC pedestal menu:

— 7.51IRE Applies the standard NTSC pedestal of 7.5 IRE.

— O0IRE Applies a pedestal of O IRE. You should select this option when
working with a commercial DV device that uses the Japanese analog
NTSC pedestal of 0 IRE. For example, if the video appears too bright
when you play back DV clips on your NTSC monitor, you can change the
pedestal to O IRE to output your DV clips at the correct brightness.
Note Ifyourdevice has a different NTSC pedestal for input and output, you
can switch the pedestal setting as needed before capturing or recording to tape.

Specifying your genlock settings
Note This section does not apply to Matrox MXO2 Mini.

You can select the source to which you want to genlock all devices connected to
your MXO2 system, as well as adjust the timing offset for all MXO2 video
outputs.

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

2 Click Genlock.

e 0 Matrox Utilities
| « | » || ShowAll | Q

Load Preset | | Save Preset

{Cinfo | General [NITSNSTMI A/Vinput | Video Output AudioOutput | CC/AFD | WYSIWYG FCPX |

Use external genlock source (REF) M
Genlock format: | 720p 59.94 + | (Not locked)

Video Output Timing Offset

Horizontal (pixels): |0 3 Reset

Vertical (lines): o & Reset
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5

Select Use external genlock source (REF) if you connected an external

analog genlock source to MXO2’s REF/REF IN connector, such as a

bi-level analog black burst for SD or a tri-level sync for HD. If you don’t

have an external genlock source connected to MXO2, clear this option to

genlock to MXO2’s internal reference signal during playback, and genlock

to your capture source during capture (see “Specifying your A/V input

settings” on page 55).

Remarks

— When capturing RGB material from a DVI source using MX02’s HDMI
input, you must use an external genlock source.

— When capturing video with digital closed captioning (see “Matrox
4VANC capture and playback” on page 66), you must genlock to your
capture source and not an external genlock source. Clear this option to
genlock to your capture source.

To indicate whether or not MXO?2 is presently locked to your external
genlock source, the status will be displayed next to the Genlock format
menu as Locked or Not locked.

From the Genlock format menu, select the video format of your external
genlock source.

Important To ensure good output results, make sure that your genlock
source’s video format is compatible with the MXO2 video output format.

Use the horizontal and vertical settings under Video Output Timing Offset
to adjust the timing of the video output relative to your external genlock
source. This lets you compensate for cable delays within your system.

Specifying your A/V input settings

You can select the MXO?2 video and audio inputs to be used as your capture
source. Only one video and audio input source can be used at a time. You can
also capture your video to a different format than your source video by enabling
scaling on the input.

Note When capturing, MXO2 outputs your source video at the capture format.
The Matrox video output settings are ignored during capture.

For descriptions of the MXO2 inputs, see “Inputs” on page 158. For a list of the
input and capture formats that are supported on MXO2, and to view the MXO2
input scaling options, see Appendix C, “Matrox MXO2 Supported Input and
Capture Formats.”

Note The HDMI video input does not support SD video for capture. When
capturing RGB material from a DVI source using MX02’s HDMI input, you
must use an external genlock source (see “Specifying your genlock settings” on
page 54).
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1 From the Apple menu, click System Preferences, and then click the

Matrox Utilities icon.
2 Click A/V Input.

e 6 Matrox Utilities
[ «|» || ShowAl | Q|

Load Preset | | Save Preset

{_Info General Genlock l Video Output Audio Output CC/AFD WYSIWYG FCPX |
Input Source

Video: | Component (Y, Pb, Pr)

Capture unstable video signals \]
Audio: | Analog unbalanced RCA *

Scaling

“

Source format: | 720p

Scale input for capture

Aspect ratio formatting: | Letterbox/Pillarbox

3 Under Input Source, select the Video and Audio inputs that you want to
capture.

Remarks

— The SDI embedded audio option can be used with the SDI video input
option only.

— When capturing from an HDMI source, only uncompressed embedded
audio is supported.

4 To capture an unstable or low-quality video signal, such as from a
low-quality composite or S-Video VCR, select Capture unstable video
signals to ensure that the capture application does not stop the capture due
to a poor video signal/signal loss. The captured video, however, may include
dropped or black frames. If this option is disabled, a low-quality video signal
or signal loss may cause the capture application to stop the capture.

5 If the format to which you want to capture does not match the format of your
source video, select Scale input for capture. MXO2 will either upscale,
downscale, or cross-convert to the desired capture format. For example,
select Scale input for capture if your source video is 720p at 59.94 fps and

Chapter 7, Configuring Your MX0O2 System



you want to capture to 1080i at 29.97 fps. For a list of the input and capture
formats that are supported on MXO2, and to view the MXO2 input scaling
options, see Appendix C, “Matrox MXO?2 Supported Input and Capture
Formats.”

Note If Scale input for capture is not selected, your capture format must
match your source video’s format.

If you selected Scale input for capture in step 5, select the format of your
source video (MXO?2 input) from the Source format list:

Note Depending on the input type selected in step 3, some options may not
be available.

— SD 4:3 Select this option for standard 4:3 NTSC or PAL video. When
upscaling to HD, the video is captured in pillarbox format.

SD 16:9 Select this option for widescreen 16:9 NTSC or PAL video.
When upscaling to HD, the video is captured in anamorphic format.

720p Select this option for 720p video.

1080i Select this option for 1080i video.
1080PsF  Select this option for 1080PsF video.
1080p  Select this option for 1080p video.

If you selected Scale input for capture in step 5, select the Aspect ratio
formatting option to be used when your source video’s aspect ratio does not
match the capture aspect ratio:

— Letterbox/Pillarbox When capturing 16:9 video from a 4:3 source,
your video is captured in pillarbox mode (black bars to the left and right
of the picture). When capturing 4:3 video from a 16:9 source, your video
is captured in letterbox mode (black bars at the top and bottom of the
picture). When capturing SD 16:9 from an SD 4:3 source, this option is
not supported and will result in anamorphic video.

— Center cut/Center zoom When capturing 16:9 video from a 4:3
source, your video is captured in center zoom mode (picture is zoomed
with even cropping of the top and bottom edges of the picture). When
capturing 4:3 video from a 16:9 source, your video is captured in center
cut mode (even cropping of the left and right edges of the picture).

— Anamorphic Captures the source video so that the entire picture fills
the capture aspect ratio, without cropping. The source video’s aspect ratio
is not maintained.
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Specifying your video output settings

MXO?2 features simultaneous video outputs that allow you to send your video to
a variety of devices at the same time. MXO2 provides two separate video output
channels to choose from: main channel and SD channel. The video output
settings allow you to set the main channel’s video format, assign a video channel
to an MXO?2 output, and define the channel’s behavior. You can also select other
settings such as the scrub and pause method, and calibrate your HDMI monitor
for video.

Note When capturing, MXO2 outputs your source video at the capture format.
The Matrox video output settings are ignored during capture.

For a list of the supported video output formats for the MXO2 main and SD
channels, and the supported video formats for the MXO2 outputs, see Appendix
D, “Matrox MXO2 Supported Output Formats.”

Note When working with Apple Final Cut Pro X, changes made to certain
video output settings won’t take effect until you play back the clip in Final Cut
Pro X.

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

2 Click Video Output.
MXO02, MX02 Rack, and MXO2 LE

e 0 Matrox Utilities

| | » || ShowAll | Q

Load Preset | | Save Preset
{(info | General = Genlock | A/Vinput JRETNeNTMl Audio Output

Set main channel format to:

CC/AFD | WYSIWYG | FCPX |

Follow application

Pulldown

Channel Selection

Analog output:
SDI output:

HDMI output:

Channel Behavior

Aspect ratio formatting:

HDMI 3D Viewing Mode
Signal type:

Miscellaneous

SD channel

Main channel 3

Main channel +

Letterbox/Pillarbox

Side by Side

Scrub and pause:
Set HDMI output to:
Set component output to:

HDMI monitor calibration:
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MXO02 Mini

‘@00 Matrox Utilities
| «|» || Showal | (Q

Load Preset Save Preset

[_infa

M Audio Output | WYSIWYG | FCPX |

Active analog output: | Component s
Set main channel format to: | Follow application B

Pulldown

Channel Selection

Analog output: | SD channel s

HDMI output: | Main channel % |

Channel Behavior

Aspect ratio conversion: | Letterbox/Pillarbox

HDMI 3D Viewing Mode

Signal type: | Side by Side %

Miscellaneous

Scrub and pause: | Both fields 2|
Set HDMI output to: | YUV al

HDMI monitor calibration: | Calibrate |

3 For MXO2 Mini only, from the Active analog output menu, select the type

of connection that you want to use for MXO2 Mini’s Y, Pb, and Pr output
connectors (see “Outputs” on page 165).

Note When you connect an analog component device to MXO2 Mini, you
won’t be able to connect an S-Video or composite device at the same time. If
you’re outputting HD analog component video, the composite and S-Video
outputs will be invalid.

From the Set main channel format to menu, you can select the video
output format that you want for the MXO2 main channel. For a list of the
supported video output formats for the MXO2 main and SD channels, see
“Supported main and SD video output formats” on page 180.

— Follow application Sets the main channel’s video output to match your
project’s video format, or to a compatible format for your project. For
example, if your project’s video format is NTSC, the MXO2 main channel
will be set to NTSC as well. If your project’s video format is 720p at
23.98 fps, the MXO2 main channel will be set to the compatible 720p at
59.94 fps output format.

— 486p/576p Sets the main channel’s video output to either 486p or
576p, depending on your project’s video frame rate. For example, a 720p

Specifying your video output settings
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at 23.98 fps project will be output as 486p, and a 720p at 25 fps project
will be output as 576p.

— 720p Sets the main channel’s video output to 720p at a frame rate
compatible with your project’s video frame rate.

— 1080i/PsF  Sets the main channel’s video output to a 1080i or 1080PsF
format, depending on your project’s video format. For 23.98 fps video,
selecting this option outputs 1080PsF at 23.98 fps video by default.
However, you can use the Pulldown feature (see step 5) to convert
1080PsF at 23.98 fps video to 1080i at 29.97 fps video at the output.

— 1080p Sets the main channel’s video output to 1080p at a frame rate
compatible with your project’s video frame rate.

5 If 1080i/PsF was selected in step 4, select Pulldown to output 23.98 fps
video as 10801 at 29.97 fps video instead of 1080PsF at 23.98 fps. Matrox
uses standard pulldown to convert 1080PsF at 23.98 fps video to 1080i at
29.97 fps video. For a description of standard pulldown, see Appendix A,
“Understanding Pulldown.”

6 Under Channel Selection, select the video channel (main or SD) that you
want for your MXO2 analog (composite, S-Video, and component), SDI (not
available on MXO2 Mini), and HDMI outputs:

— Main channel Outputs your project’s video as defined for the main
channel (see step 4).

— SD channel Outputs your project’s video as NTSC or PAL, depending
on your project’s video output frame rate.

7 Under Channel Behavior, select the Aspect ratio formatting option to be
used for your video output when the source video’s aspect ratio does not
match the main channel/SD channel output’s aspect ratio:

— Letterbox/Pillarbox When outputting 16:9 video from a 4:3 source,
the video is output in pillarbox mode (black bars to the left and right of
the picture). When outputting 4:3 video from a 16:9 source, the video is
output in letterbox mode (black bars at the top and bottom of the picture).
When outputting SD 16:9 from an SD 4:3 source, this option is not
supported and will result in anamorphic video.

— Center cut/Center zoom When outputting 16:9 video from a 4:3
source, the video is output in center zoom mode (picture is zoomed with
even cropping of the top and bottom edges of the picture). When
outputting 4:3 video from a 16:9 source, the video is output in center cut
mode (even cropping of the left and right edges of the picture).

— Anamorphic Outputs the source video so that the entire picture fills the
capture aspect ratio, without cropping. The source video’s aspect ratio is
not maintained. When outputting 4:3 video from a 16:9 source, select the
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10

16:9 display setting on your NTSC/PAL monitor to display the video with
the correct proportions.

Under HDMI 3D Viewing Mode, select the 3D Signal type that will be
sent to your 3D monitor via MX02’s HDMI output. This option signals your
3D monitor to automatically switch to the selected 3D viewing mode. You
must select the signal type that matches the 3D video that you want to
output, or disable this option (this feature may not be supported on some 3D
monitors).

— Disabled Select this if you’re not outputting 3D video, or to disable this
option. You can still monitor 3D video, but you must select the correct
viewing mode on your 3D monitor manually.

— Side by Side Select this for horizontally-compressed side-by-side 3D
video (also referred to as side-by-side horizontal).

— Over/Under Select this for over/under 3D video (also referred to as top
bottom).

Note If your Avid Media Composer or Avid Symphony project’s
Stereoscopic setting is anything other than Side by side, Over/Under, or
Full, make sure that you set the HDMI 3D Viewing Mode to Disabled. For
example, if your project’s Stereoscopic setting is Off or Leading Eye, you
must disable the HDMI 3D Viewing Mode option in order to properly view
the HDMI output.

Under Miscellaneous, select First field, Second field, or Both fields
from the Scrub and pause menu to indicate whether you want to display
both fields or only one field when pausing video playback or scrubbing the
timeline in your project. For example, you may want to scrub the first or
second field to eliminate the flickering that can be seen in your picture when
you pause while scrubbing interlaced video.

From the Set HDMI output to menu, select the type of video signal that
you want to be sent from the HDMI output:

— YUV Outputs YUV HDMI video. Select this only if you connected the
HDMI output to a device that accepts a YUV signal.

— RGB - calibrated Outputs adjusted RGB HDMI video using the
currently loaded Matrox HDMI calibration settings for your HDMI
monitor or television. For details on calibrating your HDMI monitor and
loading HDMI calibration settings using the Matrox HDMI Calibration
Utility, see Chapter 8, “Calibrating Your HDMI Monitor for Video.”

— RGB - native Outputs native RGB HDMI video that does not apply any
calibration compensation. This is useful when you want to output RGB
HDMI video to a device other than an HDMI monitor or television, such
as an HDMI recorder to perform an export to tape.
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11 From the Set component output to menu, select YUV or RGB to set the
type of video that is sent from MX02’s component (Y, Pb, Pr) output. For
example, select RGB if your MXO2’s component output is connected to a
device that accepts an RGB signal.

Note Component outputs are not available on MXO2 Mini.

12 Click the Calibrate button to calibrate your HDMI monitor or load HDMI
calibration settings using the Matrox HDMI Calibration Utility (see Chapter
8, “Calibrating Your HDMI Monitor for Video”).

Note Inorder to runthe Matrox HDMI Calibration Utility, the HDMI output
type must be set to RGB - calibrated (see step 10).

Specifying your audio output settings
MXO2’s simultaneous audio outputs allow you to send your audio to a variety of
devices at the same time. You can also map any audio track in your video

application to any MXO2 audio output. For descriptions of the MXO2 outputs,
see “Outputs” on page 165.

@ Important Audio mapping must be disabled for surround sound HDMI audio
output.

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.
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2 Click Audio Output.

e 6 Matrox Utilities
| «|» || ShowAll | Q

Load Preset | | Save Preset
{_Info | General Genlock | A/Vinput | Video Outpu: [NLNCTHCNUATEN CC/AFD | WYSWYG | FCPX |
Audio Mapping
Enable audio mapping \]
Matrox Outputs Application Outputs

RCA 1/2 and XLR 1/2: Pair1/2 3
RCA 3/4 and XLR 3/4: Pair5/6 <
RCA5/6: Pair 7/8
AES/EBU 1/2: Pair1/2 %
SDI 1/2 and HDMI 1/2: Pair1/2 7
SDI 3/4 and HDMI 3/4: Pair3/4 <
SDI 5/6 and HDMI 5/6: Pair5/6 +
SDI 7/8 and HDMI 7/8: Pair7/8 3
SDI 9/10: Pair 9/10 %
SDI 11/12: Pair 11/12 5
SDI 13/14: | Pair 13/14 :
SDI 15/16: Pair 15/16 +

Miscellaneous

Number of HDMI channels: | 8 3

Attenuate analog audio by 4dB: 4

Note The available MXO2 audio outputs depend on your MXO2 hardware.

3 Under Audio Mapping, select or clear the Enable audio mapping option.

If this option is cleared, your application’s audio track outputs will be routed
to the corresponding MXO2 audio outputs by default. For example, when
you output audio tracks as Pair 1/2 from your application, the audio will be
routed to the corresponding 1/2 MXO2 audio outputs.

If you selected the Enable audio mapping option, for each of the MXO2
outputs, select the desired audio pair from your application.

Note If you enable playback of Matrox 4VANC AFD or Matrox 4VANC
closed captioning, audio track 15 or 16 will be muted and won’t be available
for audio playback (see “Matrox 4VANC capture and playback” on page 66).

Under Miscellaneous, select the Number of HDMI channels that you
want to output from MX0O2’s HDMI output. This option is especially useful
for HDMI monitors that don’t accept more than two audio channels. If you
choose to output two audio channels, MXO2 will output the audio pair
mapped to HDMI 1/2.

Select Attenuate analog audio by 4dB to decrease the level of the audio
that is output from the MXO2 analog outputs by 4dB.

Specifying your audio output settings
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Note The Attenuate analog audio by 4dB option is not available on
MXO2 Mini.

Closed captioning and AFD

Chapter 7,

Note Closed captioning and AFD are suppported on Matrox MX02, MXO02
Rack, and MXO2 LE only.

The Matrox 4VANC tool lets you capture and play back digital closed caption
and AFD (active format description) data along with your video using a
supported video application.

Matrox MXO2 also supports Adobe Premiere Pro’s closed captioning feature for
playback and export to tape. If you’re working with Adobe Premiere Pro, you can
choose to use Premiere Pro’s closed captioning feature instead of the Matrox
4VANC tool to play back closed captioning using MXO2.

This section details how to specify the settings in MXO2 when using the Matrox
4VANC tool or Premiere Pro’s closed captioning feature.

Adobe closed caption playback

Matrox MXO2 supports Premiere Pro’s closed captioning feature for playback
and export to tape. When using Premiere Pro, you can choose to use the closed
captioning feature in Premiere Pro instead of the Matrox 4VANC tool to play
back closed captioning using MXO?2.

The closed captions on your sequence can be embedded in your video’s VANC
on output for display on an SDI or analog video monitor that supports closed
captioning, or you can choose to overlay the closed captions on all the MXO02
video outputs for display on video monitors that do not support closed
captioning.

For detailed instructions on how to use Adobe Premiere Pro’s closed captioning
feature with MXO?2, see “Closed captioning and AFD” on page 91.

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

Configuring Your MX0O2 System
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2 Click CC/AFD.

e 0 Matrox Utilities
| « | » || ShowAll | Q

Load Preset | ( Save Preset

{(info | General | Genlock | A/Vinput | Video Output _Audio Output [ISHLITTN| WYSWYG | FCPX |

(%) Use Adobe CC Playback

Embed in SDI VANC (HD/SD) ¥
Embed in SDI Line 21 (SD)
Embed in analog Line 21 (SD) @

Use Matrox 4VANC CC/AFD

Capture

Playback

3 Select Use Adobe CC Playback.

4 Specify where you want the closed caption data to be embedded in the video
signal during playback. Since MXO2 features simultaneous outputs, you can
select more than one of the following options.

— Embed in SDI VANC (HD/SD) Use this option if you want to play
back HD or SD video from MXO2’s SDI output, and embed the closed
captioning data in your video’s VANC.

— Embed in SDI Line 21 (SD) Use this option if you want to play back
SD video from MXO02’s SDI output, and embed the closed captioning
data on Line 21 of the VBI (vertical blanking interval) portion of your
video signal.

— Embed in analog Line 21 (SD) Use this option if you want to play
back SD video from any of MXO2’s analog outputs (component, S-Video,
and composite), and embed the closed captioning data on Line 21 of the
VBI (vertical blanking interval) portion of your video signal.

Note To preview HD video with closed captioning on an SD monitor, you
must set the output that is connected to your monitor to SD (see “Specifying
your video output settings” on page 58), and select either Embed in SDI Line
21 (SD) or Embed in analog Line 21 (SD).

Closed captioning and AFD
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5 Specify the appropriate settings in your video application.

Matrox 4VANC capture and playback

The Matrox 4VANC tool lets you capture and play back AFD (active format
description) and digital closed caption data, along with your video, using audio
tracks 15 and 16, respectively. This section describes Matrox 4VANC, as it
applies to AFD and closed captioning, and details how to enable these features on
MXO2.

AFD capture and playback

If you have an SDI video source that contains AFD (active format description)
data in the VANC (vertical ancillary data space), Matrox 4VANC lets you
preserve the data during capture, maintain the data during playback and export to
disk, and restore the data during output. When using a supported video
application, Matrox 4VANC captures the AFD data as an audio track using
MXO2’s SDI input, along with the video. The Matrox 4VANC audio track that
contains the AFD data can then be used in a supported video application to play
back the AFD data through MX02’s SDI output.

Matrox 4VANC preserves the SDI VANC AFD data during capture by encoding
the data into the audio stream using audio track 15. The resulting file is an
uncompressed 24-bit 48 kHz audio file that contains the AFD data. When using
MXO2’s SDI input for capture, you can choose to use audio track 15 to preserve
the AFD data that is in your source video’s VANC. Because audio track 15 is
used for capturing AFD data, that channel will not be available for capturing
audio.

When using MXO2’s SDI output for playback, you can choose to retrieve and
output the Matrox 4VANC AFD data from your video application. The AFD data
is retrieved from audio track 15 and output using MXO2’s SDI output. The AFD
data is restored to your HD/SD video’s VANC on output. When Matrox 4VANC
is being used, track 15 is muted during playback, therefore it will not be available
for playing back audio.

The follwing steps describe how to enable Matrox 4VANC AFD for capture and
playback on MXO?2:

Chapter 7, Configuring Your MX0O2 System
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1 From the Apple menu, click System Preferences, and then click the

Matrox Utilities icon.
2 Click CC/AFD.

(- N3] Matrox Utilities

| «|» || ShowAll | Q

Load Preset | | Save Preset
{_Info_ General Genlock = A/Vinput | Video Output | Audio Output [ISHLIZMl WYSWYG | FCPX |

_)Use Adobe CC Playback

() Use Matrox 4VANC CC/AFD

Capture

Preserve SDI VANC AFD using audio track 15 \]
Preserve SDI VANC closed captioning using audio track 16

Playback

Retrieve AFD from audio track 15
Retrieve closed captioning from audio track 16
mbed in SDI VANC (HD/SD)
1(SD
21 (SD)

3 Select Use Matrox 4VANC CC/AFD.

4 Under Capture, select Preserve SDI VANC AFD using audio track 15 to
capture the AFD data from your source video’s VANC using SDI audio track
15.

Note To capture AFD data, you must select SDI as your video input source
(see “Specifying your A/V input settings” on page 55). You must also genlock
to your capture source and not an external genlock source (see “Specifying
your genlock settings” on page 54).

5 Under Playback, select Retrieve AFD from audio track 15 to retrieve the
Matrox 4VANC AFD data from audio track 15 in your video application,
and play back the video with the AFD data restored to the VANC using
MXO02’s SDI output.

6 Specify the appropriate settings in your video application. For information
on how to set your video application settings to capture, play back, and
export Matrox 4VANC AFD, see Chapter 9, “Using Matrox MXO2 with
Supported Programs.”

Closed captioning and AFD
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Closed caption capture and playback

If you have an SDI video source that contains digital closed caption data in the
VANC (vertical ancillary data space), Matrox 4VANC lets you capture the closed
caption data as an audio track using MX02’s SDI input, along with the video.
The Matrox 4VANC audio track that contains the closed caption data can then be
used in a supported video application to play back closed captioning through
MXO02’s SDI or analog output.

Matrox 4VANC preserves the SDI VANC closed caption data during capture by
encoding the data into the audio stream using audio track 16. The resulting file is
an uncompressed 24-bit 48 kHz audio file that contains the closed caption data.
You can also create a Matrox 4VANC closed caption audio file using supported
captioning software, such as CPC MacCaption. You can add a Matrox 4VANC
closed caption audio file to any project timeline in your video application, or
transport and store the audio file on any video/audio device as an audio track.

When using MX02’s SDI input for capture, you can choose to use audio track 16
to preserve the closed caption data that is in your source video’s VANC. Because
audio track 16 is used for capturing closed captioning, that channel will not be
available for capturing audio.

Note Closed caption data that is present in line 21 of a video’s VBI (vertical
blanking interval) is not transferred to an audio track because it is captured by
MXO?2 as part of the video signal.

When using MXO2’s SDI or analog output for playback, you can choose to
retrieve and output the Matrox 4VANC closed caption data from your video
application. The closed caption data is retrieved from audio track 16 and output
using MX0O2’s SDI or analog output. When Matrox 4VANC is being used, track
16 is muted during playback, therefore it will not be available for playing back
audio. For playback, MXO?2 lets you choose whether to embed the closed caption
data in your HD/SD video’s VANC, or in Line 21 of the VBI portion of SD video.

The following steps describe how to enable Matrox 4VANC closed captioning for
capture and playback on MXO2:
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1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.
2 Click CC/AFD.

e 6 Matrox Utilities
| « | » || ShowAll | Q

Load Preset | | Save Preset

{_Info | General Genlock = A/Vinput | Video Output | _Audio Output [ISSIIZNl WYSWYG | FCPX |

_)Use Adobe CC Playback

() Use Matrox 4VANC CC/AFD

Capture

Preserve SDI VANC AFD using audio track 15
Preserve SDI VANC closed captioning using audio track 16 \]

Playback

Retrieve AFD from audio track 15 [
Retrieve closed captioning from audio track 16 \]
Embed in SDI VANC (HD/SD) ¥
Embed in SDI Line 21 (SD)
Embed in analog Line 21 (SD) @

3 Select Use Matrox 4VANC CC/AFD.

4 Under Capture, select Preserve SDI VANC closed Captioning using
audio track 16 to capture the digital closed caption data from your source
video’s VANC using SDI audio track 16.

Note To capture digital closed captioning, you must select SDI as your
video input source (see “Specifying your A/V input settings” on page 55). You
must also genlock to your capture source and not an external genlock source
(see “Specifying your genlock settings” on page 54).

5 Under Playback, sclect Retrieve closed captioning from audio track 16
to retrieve the Matrox 4VANC closed caption data from track 16 in your
video application, and play back the video with closed captioning using
MXO02’s SDI or analog output.

6 If you selected Retrieve closed captioning from audio track 16 in step 5,
specify where you want the closed captioning data to be embedded in the
video signal during playback. Since MXO?2 features simultaneous outputs,
you can select more than one of the following options.

Closed captioning and AFD
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— Embed in SDI VANC (HD/SD) Use this option if you want to play
back HD or SD video from MXO2’s SDI output, and embed the closed
captioning data in your video’s VANC.

— Embed in SDI Line 21 (SD) Use this option if you want to play back
SD video from MXO02’s SDI output, and embed the closed captioning
data on Line 21 of the VBI (vertical blanking interval) portion of your
video signal.

— Embed in analog Line 21 (SD) Use this option if you want to play
back SD video from any of MXO2’s analog outputs (component, S-Video,
and composite), and embed the closed captioning data on Line 21 of the
VBI (vertical blanking interval) portion of your video signal.

Note To preview HD video with closed captioning on an SD monitor, you
must set the output that is connected to your monitor to SD (see “Specifying
your video output settings” on page 58), and select either Embed in SDI Line
21 (SD) or Embed in analog Line 21 (SD).

Specify the appropriate settings in your video application. For information
on how to set your video application settings to capture, play back, and
export Matrox 4VANC closed captioning, see Chapter 9, “Using Matrox
MXO2 with Supported Programs.”

Specifying your Matrox WYSIWYG settings

The Matrox WYSIWYG settings configure the MXO2 video output when
working with Adobe After Effects (v12.x or earlier) and Photoshop only (see
Chapter 9, “Using Matrox MXO2 with Supported Programs”).

Note If you're using Adobe After Effects v13.x, you don’t need to specify
WYSIWYG settings. Instead, you use the MXO2 playback device to output
your After Effects project using the MXO2 outputs as explained in “Using
Adobe After Effects v13.x” on page 110.

1 From the Apple menu, click System Preferences, and then click the

Matrox Utilities icon.
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2 Click WYSIWYG.

e 0 Matrox Utilities
| « | » || ShowAll | Q

Load Preset | | Save Preset

{Cinfo | General | Genlock | A/Vinput | Video Output _Audio Output | CC/AFD [ENEINCM FCPX |

Video format: | 1080i 29.97 8-bit
Scale to fit (¥
Alpha channel only

3 From the Video format menu, select the format that matches your
composition/image, or the format that is closest in resolution and aspect
ratio. The video format at which your composition/image is output from
MXO?2 is set in the Video Output pane (see step 6).

Note To view a 1:1 representation of your composition/image on an HDMI
monitor that does not support 1:1 pixel mapping, select your monitor’s native
resolution as the video format, and disable Scale to fit.

4 If the selected video format does not match your composition/image, select
Scale to fit to upscale/downscale your project to fit the selected video
format. Clear this option to display your composition/image at its exact
resolution (1:1) within the selected video format.

5 Select Alpha channel only to output only the alpha channel from your
composition/image.

6 Specify the Video Output settings in the Matrox preferences window as
described in “Specifying your video output settings” on page 58.

Note To output your composition/image at the video format selected in step
3, select Follow Application from the Set main channel format to list, and
make sure that the MXO2 output that you will use for monitoring is set to
output the Main channel under Channel Selection.

Specifying your Matrox WYSIWYG settings



72

7 To output your project using MXO?2, specify the settings in Adobe After
Effects/Photoshop as explained in Chapter 9, “Using Matrox MXO2 with
Supported Programs.”

Specifying the Apple Final Cut Pro X setting

The FCP X pane in the Matrox Utilities preferences window is used when
working with Apple Final Cut Pro X only. For details on setting the FCP X
setting when using Matrox MXO?2 with Final Cut Pro X, see “Working with
Apple Final Cut Pro X" on page 123.

Note The FCP X setting in the Matrox Utilities preferences window is not
saved when saving a custom preset (see “Saving custom presets” on page 52).

Viewing MXO2 information
To view your MXO2’s serial number, firmware version, and software version:

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

2 Click Info.

e 0 Matrox Utilities
[ «|» || ShowAl | Q|

Load Preset | | Save Preset

@M General | Genlock | A/Vinput | Video Output _Audio Output | CC/AFD | WYSIWYG | FCPX |

matrox MXO 2 MAX

Product Name (S/N): Matrox MXO2 (A441851)
Firmware Version:  36.10
Software Version:  3.5.1.0016

Matrox MAX compression device is present

Note If a message appears indicating an unsupported firmware version on your
MXO?2 hardware, you must update the MXO?2 firmware as explained in
“Updating your MXO2 firmware” on page 8.

Chapter 7, Configuring Your MX0O2 System
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MXO2 core audio support

You can use MXO?2 as the input and output audio device for your Mac OS, and
any audio application on your system. The Matrox MXO2 input and output audio
device options allow you to set MXO?2 as the input and output audio device in
your Mac OS Sound settings for your entire system, for use with such
applications as Apple iTunes. You can also set MXO2 as the input and output
audio device within specific audio applications on your system.

Capture

If you want to perform a capture in an application that has MXO?2 as the audio
device, you must close any other application that has MXO2 selected as the audio
device before capturing.

Playback
When playing back in an application that uses MXO2 as the output audio device,
you must close any other application that uses MXO?2 as the output audio device.

MXO2 core audio support
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Your notes
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for Video

This chapter explains how to
use the Matrox HDMI
Calibration Utility to calibrate
your RGB HDMI monitor for
video.
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Overview

The Matrox HDMI Calibration Utility is a unique tool designed to calibrate your
RGB HDMI monitor or television so that it performs like a traditional broadcast
video monitor. This utility provides a wizard that walks you through the
calibration process using specially designed patterns to effectively identify and
compensate for the processing errors that may be present in your HDMI monitor.
The Matrox HDMI Calibration Utility calibrates your monitor’s black and white
levels, white point, gamma response, and hue and chroma.

This utility is optimized for calibrating HDMI LCD/LED monitors or televisions
that support 1:1 pixel mapping, which allows you to view the output on your
HDMI monitor at its exact resolution without any scaling. Although instructions
are provided for calibrating plasma HDMI monitors, and HDMI monitors that
scale the output, a blue-only filter will be required for the color calibration (hue
and chroma). Some HDMI monitors feature a built-in blue-only mode that you
can use for color calibration. If your HDMI monitor does not have a built-in
blue-only mode, you can use a proper third-party blue-only filter (for example, a
blue gel filter, or blue-only calibration glasses) that completely blocks out all
colors except for blue. Because some blue-only filters do not block out colors
effectively, the Matrox HDMI Calibration Utility includes a blue-only filter test
that you can use to determine if your blue-only filter is adequate for color
calibration.

Note This utility is best viewed at a display resolution of 1280x800 or higher.

Calibrating your HDMI monitor

The Matrox HDMI Calibration Utility provides on-screen instructions to
calibrate your HDMI monitor. At the end of the calibration process, you must
save your calibration settings to a file. Once saved, the calibration settings are
automatically loaded as your system’s current calibration settings. If you’re
calibrating more than one HDMI monitor, you can calibrate and save settings for
each monitor and load the corresponding settings at any time (see “Loading
Matrox HDMI calibration settings” on page 77). You can later choose to enable
or disable the loaded calibration settings (see “Enabling and disabling the Matrox
HDMI calibration settings” on page 78).

Note An administrator username and password is required to calibrate your
HDMI monitor.

1 Ensure that your HDMI monitor is connected to MX02’s HDMI output, turn
the HDMI monitor on, and allow it to warm up for about 20 or 30 minutes.

2 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

3 Click Video Output.
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4 Under Miscellaneous, from the Set HDMI output to list, select RGB -

calibrated.

Click Calibrate, and follow the on-screen instructions to calibrate your
HDMI monitor.

Note When the Matrox HDMI Calibration Utility is running, you will not
have access to the MXO2 options in the Matrox preferences window, and the
MXO?2 inputs and outputs will not be available to any other application.

At the end of the calibration process, save your calibration settings to a file
anywhere on your system. You’ll be required to enter an administrator
username and password to save the settings. Once saved, your settings are
automatically loaded as your system’s current calibration settings. You can
later choose to enable or disable the loaded calibration settings (see

“Enabling and disabling the Matrox HDMI calibration settings” on page 78).

Note The calibration settings file is saved as a .plist file. If you cancel the
HDMII calibration, or close the utility at any time before saving the calibration
settings, the current calibration settings will be lost.

Loading Matrox HDMI calibration settings

After calibrating your HDMI monitor and saving your calibration settings to a
file (see “Calibrating your HDMI monitor” on page 76), the calibration settings
are automatically loaded as the current HDMI calibration settings for your
system. You can, however, load another HDMI calibration settings file at any
time, but only one calibration settings file can be loaded for your system at any
given time. Once loaded, you can enable or disable the calibration settings (see
“Enabling and disabling the Matrox HDMI calibration settings” on page 78). If
your system has multiple users, the loaded calibration settings apply to all users.

Note An administrator username and password is required to load HDMI
calibration settings.

From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

2 Click Video Output.
3 Under Miscellaneous, from the Set HDMI output to list, select RGB -

calibrated.

Click Calibrate, enter an administrator username and password, and then
click Load Settings from the Welcome page.

Select the desired .plist calibration file, and then click Open.

77
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Enabling and disabling the Matrox HDMI

calibration settings

The HDMI calibration settings that are loaded for your system (see “Loading
Matrox HDMI calibration settings” on page 77) can be enabled or disabled.
When enabled, the video that is output from the MXO2 HDMI output will have
the color settings that are saved in the currently loaded calibration file. This is
used when you want to monitor video on your RGB HDMI monitor. Disable the
calibration settings if you want the HDMI video to be output from MXO2 with its
native color settings, such as when performing an edit-to-tape.

1 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

2 Click Video Output.

3 Under Miscellaneous, from the Set HDMI output to list, select RGB -
calibrated to enable the loaded HDMI calibration settings. Depending on
your HDMI output device, select RGB - native or YUV to disable the loaded
calibration settings. For more information on setting the MX0O2 HDMI
output type, see “Specifying your video output settings” on page 58.
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with Supported Programs

This chapter explains how to
define various settings for
using MXO2 with supported
programs.
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Introduction
This chapter provides information on how to configure the following applications
for use with MXO2:
* Adobe Premiere Pro (page 80)
* Adobe Encore (page 108)
* Adobe Prelude (page 109)
» Adobe After Effects (page 110)
* Adobe Photoshop (page 111)
* Adobe SpeedGrade (page 112)
* Avid Media Composer and Symphony (page 114)
» Apple Final Cut Pro X (page 123)
@ Important Matrox MXO2 features scaling options that you can use to scale
your video for capture and output. To ensure desired results, always scale your

video using the MXO?2 scaling options (see Chapter 7, “Configuring Your MXO2
System”) instead of the scaling options found in your video editing application.

Working with Adobe Premiere Pro

You can use Adobe Premiere Pro to play back, capture, export, and output video
and audio using Matrox MXO?2. For a list of the supported video output formats
for the MXO2 main and SD channels, and the supported video formats for the
MXO?2 outputs, see Appendix D, “Matrox MXO2 Supported Output Formats.”
For a list of the input and capture formats that are supported on MXO2, and to
view the MXO2 input scaling options, see Appendix C, “Matrox MXO02
Supported Input and Capture Formats.”

Note To ensure that changes made in the Matrox Ultilities preferences
window are applied to Premiere Pro when switching between Premiere Pro and
the Matrox Utilities preferences window, select Disable video output when
in the background in Premiere Pro’s Playback settings (Premiere Pro >
Preferences > Playback).

This section provides information on how to:

* Create a new Adobe Premiere Pro project. (page 81)

» Define your playback settings. (page 82)

* Define your capture settings. (page 84)

* Add a voice-over to your sequence. (page 86)

» Work with closed captioning and AFD. (pages 91-94)
* Set up Matrox device control. (page 99)

» Export your sequence to tape. (page 101)

Chapter 9, Using Matrox MX0O2 with Supported Programs
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* Use the Matrox MPEG-2 I-frame codec. (page 105)

Support for Adobe Premiere Pro CC and CS6
The following instructions are for using Adobe Premiere Pro CC and Adobe
Premiere Pro CS6. When an operation is different between the CC and CS6
versions, the version is displayed after the operation as (CC) or (CS6). Screen
shots of the Adobe Premiere Pro dialog boxes are for the CC version only. Dialog
boxes in the CS6 version may be slightly different.

Creating a new Adobe Premiere Pro project
Creating a new Adobe Premiere Pro project involves specifying the location of
your scratch disks and selecting a sequence preset.

1 Start Adobe Premiere Pro and click the New Project icon. The New
Project dialog appears. You can leave all the settings on the General pane at
the default settings. For details on changing these settings, see your Adobe
Premiere Pro documentation.

2 On the Scratch Disks pane, use the Browse button to select an appropriate
A/V drive for each scratch disk type. When specifying the location of your
scratch disks, make sure you follow the recommendations in your Adobe
Premiere Pro documentation. For example, store your video and audio files
on a separate hard drive dedicated to your media assets.

& Tip Specifying the same scratch disk settings for all your projects will help
shorten the amount of time it takes to open new or existing projects.

From the Location list, select where you want to save your project.
Specify a Name for your project.
Click OK to save your settings.

o O A~ W

Choose File > New > Sequence (CC only). The New Sequence dialog
opens on the Sequence Presets pane.

7 Under Available Presets, select the preset that matches the type of
sequence that you want to create. Matrox MXO2 supports all the available
presets, including custom presets that you create.

Note When you select any of the MPEG-2 I-frame presets, the Matrox
MPEG-2 I-frame codec will be set for rendering your video previews.

8 Specify a Sequence Name.

9 If you plan on playing back or exporting Matrox 4VANC AFD or Matrox
4VANC closed caption data:

a In the Tracks pane, select Multichannel from the Master list.

b From the Number of channels list, select 16, and then set the Track
Type for each track in your sequence to Mono.
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¢ In the Settings pane, under Audio, select 48000 Hz from the Sample
Rate list.

10 Click OK to apply the settings.

Note To avoid playback issues when using Matrox Player as the playback
device, make sure that a Matrox audio device is not selected in the Audio
Hardware preferences (and Audio Output Mapping preferences in Premiere
Pro CS6).

Defining your playback settings

This section details how to define your settings in order to use your Matrox
MXO2 hardware to output video and audio that is played back in Adobe
Premiere Pro. For a list of the supported video output formats for the MXO2
main and SD channels, and the supported video formats for the MXO?2 outputs,
see Appendix D, “Matrox MXO?2 Supported Output Formats.”

1 In Premiere Pro, choose Premiere Pro > Preferences > Audio
Hardware, and make sure that a Matrox audio device is not selected for
Adobe Desktop Audio (CC) or Default Device (CS6). This includes a
Matrox aggregate audio device that you created for your Mac OS X
Mavericks or Mountain Lion system for the purposes of adding a voice-over
(see “Adding a voice-over to your sequence” on page 86).

2 Choose Premiere Pro > Preferences > Playback.

Preferences

G
A
Al
A
Al
C:
=
D
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In the Preferences dialog, select Matrox Player from the Audio Device
list.

Under Video Device, select Matrox Player, and then click Setup beside
Matrox Player.

Matrox Player Setup

Video Output
O 8-bit
@ 10-bit
£ Enable CC overlay on output (Adobe C56)

In the Matrox Player Setup dialog, select the bit depth for your video
output (8-bit or 10-bit).

If you’re using Premiere Pro CS6 and your sequence includes closed
captioning that was not created using the Matrox 4VANC tool (see “Closed
captioning and AFD” on page 91), you can select Enable CC overlay on
output (Adobe CS6) if you want to overlay the closed captions on all the
MXO?2 video outputs for display on video monitors that do not support
closed captioning as explained in “Overlay closed captions (CS6)” on
page 98.

Note If you’re using Premiere Pro CC, you can use the closed captioning
overlay feature in Premiere Pro as explained in “Overlay closed captions
(CC)” on page 98.

Click OK to close the Matrox Player Setup dialog.

Click OK to save your settings in the Preferences dialog.

If you selected an MPEG-2 I-frame sequence preset, or a custom sequence
preset that uses the Matrox MPEG-2 I-frame codec to render your video
preview, choose Sequence > Sequence Settings, and then in the
Settings pane, click Configure beside Preview File Format to configure
the codec. See “Using the Matrox MPEG-2 I-frame codec” on page 105 for
information on specifying your Matrox MPEG-2 I-frame codec settings.

Set the appropriate video and audio output settings in the Matrox Utilities
preferences window (see Chapter 7, “Configuring Your MXO2 System”).

Note To ensure that changes made in the Matrox Ultilities preferences
window are applied to Premiere Pro when switching between Premiere Pro
and the Matrox Utilities preferences window, select Disable video output
when in the background in Premiere Pro’s Playback settings (Premiere
Pro > Preferences > Playback).

In Premiere Pro, play back your sequence.
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Defining your capture settings

To capture video and audio in Premiere Pro using your Matrox MXO2 hardware,
you must define your capture settings as detailed in this section. For a list of the
input and capture formats that are supported on MXO02, and to view the MXO2
input scaling options, see Appendix C, “Matrox MXO2 Supported Input and
Capture Formats.”

1 In Premiere Pro, choose File > Capture.

2 In the Capture panel, in the Settings pane, under Capture Settings, click
Edit.

Capture Settings

3 In the Capture Settings pane, select Matrox Recorder from the Capture
Format list, and then click Configure.

Matrox Recorder Configuration

Video Capture Settings

“

Video format: | 720p 59.94 8-bit
| Configure Codec |

2

Audio channels: | 16 s

| A/V Input Preferences Cancel OK

4 In the Matrox Recorder Configuration dialog, select the Video format to
which you want to capture your source video.

5 Click Configure Codec to select and configure the capture codec. If you
want to use the Matrox MPEG-2 I-frame codec, see “Using the Matrox
MPEG-2 I-frame codec” on page 105 for details on configuring the codec.

6 Select the number of Audio channels to capture. If capturing Matrox
4VANC AFD or closed caption data (see “Closed captioning and AFD” on
page 91), you must capture 16 audio channels.
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7 Click A/V Input Preferences to set the appropriate video and audio input

settings in the Matrox Ultilities preferences window (see “Specifying your
A/V input settings” on page 55).

Note To ensure that changes made in the Matrox Utilities preferences
window are applied to Premiere Pro when switching between Premiere Pro
and the Matrox Utilities preferences window, select Disable video output
when in the background in Premiere Pro’s Playback settings (Premiere
Pro > Preferences > Playback).

Click OK to save your settings in the Matrox Recorder Configuration
dialog.

If you want to use Matrox device control for frame-accurate capture from a
device, see “Setting up Matrox device control” on page 99.

Note When using Matrox device control, the capture does not stop at the
end of the tape when using the Tape option in the Capture panel. To avoid
capturing beyond the end of the tape, use the In/Out capture option instead
and set an In and Out point for your capture.

10 Capture as you would normally.
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Adding a voice-over to your sequence
Matrox MXO2 supports voice-over in Adobe Premiere Pro, which allows you to
record audio tracks as .wav files to add commentary to video clips, such as

newsreels and documentaries.

Note Matrox voice-over supports recording to standard, mono, and adaptive

audio tracks only.

Connection and setup

1 Connect the microphone to the audio input on a source device, such as a
preamplifier, and then connect the audio output from the source device to the
corresponding audio input on your MXO2 hardware.

Note The Matrox hardware audio inputs are line level. Therefore, make sure
your audio equipment output matches.

2 If you’re using a Mac OS X Lion system, proceed to step 3. For Mac OS X
Mavericks or Mountain Lion users, a Matrox aggregate audio device is
required for your system. If you previously created a Matrox aggregate audio
device on your system for the purposes of voice-over, proceed to step 3. To
create a Matrox aggregate audio device, perform the following steps:

a In the Mac OS X Finder window, choose Applications > Utilities, and
then double-click Audio MIDI Setup.

68 0 O

Audio Devices

B i s
o) 2in/0out

% Built-in Digital Input
¥ 2in/00ut

Built-in Output
\ 0in/ 2 out o

Built-in Line Output
| 0in/ 2 out

Built-in Digital Output
\ 0in/ 2 out

Matrox MXO2 A441851 Audi
pci )

16 out

Matrox MXO2 A441851 Audi
Pci 16 in/ 0 out

Premiere Pro 6.0
4 o 0in/ 0 out

+ | = [~

Built-in Line Input

Clock source: Default ?)

@ outout |

Source: Line In

Format: |48000.0 Hz | ¥ | | 2ch-16bit Integer 3
Ch Volume Value dB  Mute Thru
Master
1 O [ 0] <16
2 O [ 0|[ 16

b In the Audio Devices window, click + at the bottom left of the dialog,
and then Create Aggregate Device.

¢ Double-click the newly created aggregate device that appears in the left
pane, and type a descriptive name for the device, such as Matrox Audio.
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d Highlight the Matrox Audio aggregate device, and then select to use the
Matrox audio input and output.

8 0 0 Audio Devices
Built-in Line Input
2in/ 0 out ¢ Matrox Audio
% Built-in Digital Input Clock Source: | Matrox MXO2 A441851 A. @
2in/ 0 B
e Sample Rate: |48000.0 Hz -
Built-in Output
S 0in/ 2 out Ko Use | Audio Device In | Out | Drift...
Built-in Line Output ) Built-in Line Input 2 0
0in/ 2 out Built-in Digital Input 2 0
Built-i 2
Built-in Digital Output uf N fn 9“‘”"‘ 0
0in 2 0t Built-in Line Output 0 2
| Built-in Digital Output 0 2
PCl g”“f‘]’: MX02 A441851 Audi ©  Matrox MXO2 A441851 Audio Output 0 16 o
v/ 16 out
e &  Matrox MXO2 A441851 Audio Input 16 0
Matrox MXO2 A441851 Audi
PCl g0 o0

Premiere Pro 6.0
s o 0in/ 0 out

Q WRIOXIAUGIO)

| Configure Speakers... |
+ | - [Rev
e Quit Audio MIDI Setup.
3 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.
4 Click A/V Input.

800 Matrox Utilities

</ > Show All (Q J

Load Preset Save Preset
{(info_| General | Genlock Video Output | Audio Output | _CC/AFD | WYSMWYG | FCPX |

Input Source

Video: | Component (Y, Pb, Pr) &
Capture unstable video signals [ |

Audio: | Analog balanced XLR v

Scaling

Scale input for capture | |
Source format: = SD 4:3

Aspect ratio formatting: = Letterbox/Pillarbox
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5 Under Input Source, select the Audio input on your Matrox hardware to
which your audio source device is connected, and then select Component
from the Video list.

6 Close the Matrox Utilities preferences window.

7 In Premiere Pro, choose Premiere Pro > Preferences > Playback, and
then select Adobe Desktop Audio as the Audio Device.

Preferences

deo output when in the background

8 Click OK to apply the change.

9 Choose Premiere Pro > Preferences > Audio Hardware, and then select
the option based on your operating system:

— Mac OS X Lion Select the Matrox input/output option from the Adobe
Desktop Audio list (CC) or the Default Device list (CS6). For example,
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Matrox MXO2 (serial number) Input/Matrox MXO02 (serial number)
Output. Do not select the Matrox option for output only.

Preferences

o 16 12 16 5 1= [ fo | [

— Mac OS X Mavericks or Mountain Lion Select the Matrox aggregate
audio device created in step 2 from the Adobe Desktop Audio list (CC)
or the Default Device list (CS6).

Preferences

Output Mapp

> Input: Out 1

-
-
-
-
~
-
-
14
’
F
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10 Click OK to apply the change.

Recording your voice-over
You use Adobe Premiere Pro’s Audio Track Mixer (CC) or Audio Mixer (CS6) to
record your voice-over. For further information on using this mixer, see your
Adobe Premiere Pro documentation.
1 In Premiere Pro, choose Window > Audio Track Mixer (CC) or Audio
Mixer (CS6), and then select the sequence in which you want to record your

voice-over, such as Sequence 01.

8 0 0

Audio Track Mixer: Sequence 01 v X

>

Master Master

I

Master Master

00:01:00:00

00:00:10:24 i« =t > {p} 2
2 Position the current-time indicator in the Timeline panel where you want the
voice-over to begin.You can also set In and Out points to specify the section
of the timeline to which you want to add your voice-over.
3 In the mixer’s panel, click the Enable track for recording button (| ) for
the tracks on which you want to record audio. You can record your
voice-over on multiple tracks at the same time.
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Note If atrack that you’ll be recording your voice-over on already contains
audio at the current-time indicator, the audio will be overwritten by your
voice-over.

For each track selected in step 3, select the Matrox audio input channel that
you want to record from the Track Input Channel list at the top of the panel.

Select Meter Input(s) Only in the mixer’s menu to display the MXO2 audio
input levels in the meters.

Tip You can click the Solo Track button ( ) for a track on which you’ll
be recording audio to mute the audio playback of other audio tracks in your
sequence.

Test the audio input levels by speaking into the microphone, and watch the
levels in the meters. If needed, adjust the audio level on your source device
so that the input levels are sufficiently high but not clipping.

7 Click the Record button (@) ) to prepare the sequence for recording.
8 Click the Play button (J§§), or the Play In to Out button ([{§Y) if you set

10

In and Out points, to start recording your voice-over.

Note During recording, there’s a slight delay in the audio preview of your
voice-over. To mute the preview, click the Mute Track button (] ) or you
can choose to lower the track volume by dragging the Volume slider.

Click the Stop button ([ ) to stop recording. Your voice-over will be added
to the selected audio tracks as .wav files.

To ensure proper A/V synchronization during playback when not recording a
voice-over, make sure that a Matrox audio option is not selected for the
Adobe Desktop Audio option (CC) or Default Device option (CS6) in the
Audio Hardware preferences (Premiere Pro > Preferences > Audio
Hardware), and then select Matrox Player as the Audio Device and
Video Device in the Playback settings (Premiere Pro > Preferences >
Playback).

Closed captioning and AFD
Matrox MXO2 provides two ways of working with closed caption and AFD data
in Adobe Premiere Pro:

Matrox 4VANC tool (pages 92 and 94) The Matrox 4VANC tool lets you
capture and play back digital closed caption and AFD (active format
description) data along with your video. The Matrox 4VANC closed caption
and AFD data can be embedded in your video’s VANC on output for display
on an SDI or analog video monitor that supports closed captioning.

Premiere Pro’s closed captioning (page 97) Matrox MXO2 supports

Adobe Premiere Pro’s closed captioning feature for playback. The closed
captions on your sequence can be embedded in your video’s VANC on

o
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output for display on an SDI or analog video monitor that supports closed
captioning, or you can choose to overlay the closed captions on all the
MXO2 video outputs for display on video monitors that do not support
closed captioning.

Working with Matrox 4VANC AFD

MXO?2 lets you capture the AFD (active format description) data stored in your
video’s VANC, along with your video, and restore the AFD data during playback,
using the Matrox 4VANC tool. This section details how to capture and play back
Matrox 4VANC AFD using Adobe Premiere Pro. You can also use Premiere Pro
to export a sequence with Matrox 4VANC AFD to a file for playback using
Premiere Pro. For more information about any of the features mentioned in this
section, see your Premiere Pro documentation.

Note Matrox MXO2 Mini does not support AFD data.

Capturing Matrox 4VANC AFD

When using MXO2’s SDI input for capture, Matrox 4VANC lets you
preserve the AFD (active format description) data from your video’s VANC
(vertical ancillary data space) by capturing the data as an audio track.

If Matrox 4VANC capture is enabled in the Matrox Utilities preferences
window, Matrox MXO2 uses audio track 15 to preserve the AFD data during
capture in Premiere Pro. The resulting file is an uncompressed 24-bit 48 kHz
audio file that contains the AFD data. The Matrox 4VANC audio track that
contains the AFD data can then be played back in Premiere Pro. During
playback the AFD data is restored to your HD/SD video’s VANC through
MXO2’s SDI or analog output (see “Playing back Matrox 4VANC AFD” on
page 92). Because audio track 15 is used for capturing AFD data, that
channel will not be available for capturing audio. To capture Matrox 4VANC
AFD:

a Enable capture of Matrox 4VANC AFD in the Matrox Utilities
preferences window (see “AFD capture and playback” on page 66).

b Specify your capture settings in Premiere Pro as detailed in “Defining
your capture settings” on page 84.

¢ Capture as you would normally.

Playing back Matrox 4VANC AFD

During playback, MXO?2 retrieves the AFD data from the Matrox 4VANC

audio track that is assigned to audio output 15 in Premiere Pro, and restores

the AFD data to your HD/SD video’s VANC through MX02’s SDI or analog
output. Set your playback settings as follows:

a In Premiere Pro, choose File > New > Sequence. In the New
Sequence dialog:

+ In the Tracks pane, select Multichannel from the Master list.

Chapter 9, Using Matrox MX0O2 with Supported Programs



« From the Number of channels list, select 16, and then set the Track
Type for each track in your sequence to Mono.

+ In the Settings pane, under Audio, select 48000 Hz from the Sample
Rate list.

b Set the remaining settings in the New Sequence dialog, and then click
OK.

¢ With your project files on the timeline, in the Audio Track Mixer, assign
the audio track that contains the Matrox 4VANC closed caption data on
your timeline to audio output 15 + 16, and then use the Pan/balance
control to set the balance completely to the left (channel 15). If there is
another audio track assigned to 15 + 16, you must set the balance for that
audio track completely to the right (channel 16). Audio track 16 can be
used for Matrox 4VANC closed caption data (see “Working with Matrox
4VANC closed captioning” on page 94).

Note To preserve the integrity of the AFD data for playback, do not

manipulate the audio track that contains the AFD data in any way. For example,

do not adjust the audio gain or add audio effects to the track.

d Specify your playback settings as detailed in “Defining your playback
settings” on page 82.

e Enable playback of Matrox 4VANC AFD in the Matrox Utilities
preferences window (see “AFD capture and playback™ on page 66).

f Play back your sequence.

Exporting Matrox 4VANC AFD to a file
This section details how to maintain the Matrox 4VANC AFD data when
exporting your sequence to a file. The exported file can then be used in
Premiere Pro for playback (see “Playing back Matrox 4VANC AFD” on
page 92).
a In Premiere Pro, choose File > New > Sequence. In the New
Sequence dialog:
+ In the Tracks pane, select Multichannel from the Master list.
« From the Number of channels list, select 16, and then set the Track
Type for each track in your sequence to Mono.
+ In the Settings pane, under Audio, select 48000 Hz from the Sample
Rate list.
b Set the remaining settings in the New Sequence dialog, and then click
OK.

¢ With your project files on the timeline, in the Audio Track Mixer, assign
the audio track that contains the Matrox 4VANC AFD data to an audio
output pair (for example, 3 + 4), and then use the Pan/balance control
to set the balance of the Matrox 4VANC track completely to the left or
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right. If the selected audio output pair is assigned to another audio track,
set the balance for the other audio track to the other side. For example, if
the Matrox 4VANC AFD audio track balance is set to the left, set the
balance for the other audio track that is assigned to the same audio outputs
to the right.

d Choose File > Export > Media.

e In the Audio pane, select a lossless or uncompressed Audio Codec.
Compressed audio codecs are not supported for use with Matrox 4VANC.

f Under Basic Audio Settings, select 48000 Hz from the Sample Rate
list.

g From the Channels list, select the number of audio channels to export.

Note Mono, 5.1, and Stereo are not supported when exporting
Matrox 4VANC AFD data.

h From the Sample Size list, select 24 bit.

i Export your sequence to file. If you have an MXO2 product with MAX
technology, see Chapter 10, “Using the Matrox MAX H.264 Codec” for
information on exporting your sequence using the Matrox MAX H.264
codec.

Working with Matrox 4VANC closed captioning

MXO2 lets you capture and play back video with digital closed captioning using
the Matrox 4VANC tool. This section details how to capture and play back
Matrox 4VANC closed captioning using Adobe Premiere Pro. You can also use
Premiere Pro to export a sequence with Matrox 4VANC closed captioning to a
file for playback using Premiere Pro. For more information about any of the
features mentioned in this section, see your Premiere Pro documentation.

Note Matrox MXO2 Mini does not support closed captioning.

Capturing Matrox 4VANC closed captioning

When using MX02’s SDI input for capture, Matrox 4VANC lets you
preserve the closed caption data from your video’s VANC (vertical ancillary
data space) by capturing the data as an audio track.

If Matrox 4VANC capture is enabled in the Matrox Utilities preferences
window, Matrox MXO?2 uses audio track 16 to preserve the closed caption
data during capture in Premiere Pro. The resulting file is an uncompressed
24-bit 48 kHz audio file that contains the closed caption data. The Matrox
4VANC audio track that contains the closed caption data can then be used in
Premiere Pro to play back closed captioning through MX0O2’s SDI or analog
output (see “Playing back Matrox 4VANC closed captioning” on page 95).
Because audio track 16 is used for capturing closed captioning, that channel
will not be available for capturing audio. To capture Matrox 4VANC closed
captioning:
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a Enable capture of Matrox 4VANC closed captioning in the Matrox
Utilities preferences window (see “Closed caption capture and playback”
on page 68).

b Specify your capture settings in Premiere Pro as detailed in “Defining
your capture settings” on page 84.

¢ Capture as you would normally.

Playing back Matrox 4VANC closed captioning

During playback, MXO?2 retrieves the closed caption data from the Matrox

4VANC audio track that is assigned to audio output 16, and outputs it using

MXO2’s SDI or analog output. To play back Matrox 4VANC closed

captioning:

a In Premiere Pro, choose File > New > Sequence. In the New
Sequence dialog:

+ In the Tracks pane, select Multichannel from the Master list.

« From the Number of channels list, select 16, and then set the Track
Type for each track in your sequence to Mono.

+ In the Settings pane, under Audio, select 48000 Hz from the Sample
Rate list.

b Set the remaining settings in the New Sequence dialog, and then click
OK.

¢ With your project files on the timeline, in the Audio Track Mixer, assign
the audio track that contains the Matrox 4VANC closed caption data on
your timeline to audio output 15 + 16, and then use the Pan/balance
control to set the balance completely to the right (channel 16). If there is
another audio track assigned to 15 + 16, you must set the balance for that
audio track completely to the left (channel 15). Audio track 15 can be
used for Matrox 4VANC AFD data (see “Working with Matrox 4VANC
AFD” on page 92).

Note To preserve the integrity of the closed caption data for playback, do

not manipulate the audio track that contains the closed caption data in any

way. For example, do not adjust the audio gain or add audio effects to the track.

d Specify your playback settings as detailed in “Defining your playback
settings” on page 82.

e Enable playback of Matrox 4VANC closed captioning in the Matrox
Utilities preferences window (see “Closed caption capture and playback”
on page 68).

f Play back your sequence.
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Exporting Matrox 4VANC closed captioning to a file

This section details how to maintain the Matrox 4VANC closed caption data
when exporting your sequence to a file. The exported file can then be used in
Premiere Pro for playback (see “Playing back Matrox 4VANC closed
captioning” on page 95).

-~

9

In Premiere Pro, choose File > New > Sequence. In the New
Sequence dialog:

+ In the Tracks pane, select Multichannel from the Master list.

« From the Number of channels list, select 16, and then set the Track
Type for each track in your sequence to Mono.

+ In the Settings pane, under Audio, select 48000 Hz from the Sample
Rate list.

Set the remaining settings in the New Sequence dialog, and then click
OK.

With your project files on the timeline, in the Audio Track Mixer, assign
the audio track that contains the Matrox 4VANC closed caption data to an
audio output pair (for example, 3 + 4), and then use the Pan/balance
control to set the balance of the Matrox 4VANC track completely to the
left or right. If the selected audio output pair is assigned to another audio
track, set the balance for the other audio track to the other side. For
example, if the Matrox 4VANC closed caption audio track balance is set
to the left, set the balance for the other audio track that is assigned to the
same audio outputs to the right.

Choose File > Export > Media.

In the Audio pane, select a lossless or uncompressed Audio Codec.
Compressed audio codecs are not supported for use with Matrox 4VANC.

Under Basic Audio Settings, sclect 48000 Hz from the Sample Rate
list.

From the Channels list, select the number of audio channels to export.

Note Mono, 5.1, and Stereo are not supported when exporting
Matrox 4VANC closed caption data.

h

From the Sample Size list, select 24 bit.

Export your sequence to file. If you have an MXO2 product with MAX

technology, see Chapter 10, “Using the Matrox MAX H.264 Codec” for
information on exporting your sequence using the Matrox MAX H.264

codec.
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Working with Premiere Pro’s closed captioning

Matrox MXO?2 supports Premiere Pro’s closed captioning feature for playback
and export to tape. The closed captions on your sequence can be embedded in
your video’s VANC on output for display on an SDI or analog video monitor that
supports closed captioning, or you can choose to overlay the closed captions on

all the MXO2 video outputs for display on video monitors that do not support
closed captioning.

For details on how to import a closed caption file to your sequence, see your
Adobe Premiere Pro documentation. To determine your video monitor’s

capabilities for displaying closed captioning, check your video monitor’s
documentation.

Embed closed captions in VANC
This section details how to embed the closed captions that are on your

sequence in your video’s VANC for play back and export to tape using
MXO2.

a From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

b Click CC/AFD.

e 0 Matrox Utilities
| « | » || ShowAll | Q

Load Preset | ( Save Preset

{_Info_ General Genlock = A/Vinput | Video Output | _Audio Output [ISHLIZONl WYSWYG | FCPX |

(%) Use Adobe CC Playback

Embed in SDI VANC (HD/SD) ¥
Embed in SDI Line 21 (SD)
Embed in analog Line 21 (SD) @

Use Matrox 4VANC CC/AFD

Capture

Playback

¢ Select Use Adobe CC Playback.
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d Specify where you want the closed caption data to be embedded in the
video signal during playback. Since MXO?2 features simultaneous
outputs, you can select more than one of the following options.

+ Embed in SDI VANC (HD/SD) Use this option if you want to play
back HD or SD video from MXO2’s SDI output, and embed the closed
captioning data in your video’s VANC.

+ Embed in SDI Line 21 (SD) Use this option if you want to play back
SD video from MX02’s SDI output, and embed the closed captioning
data on Line 21 of the VBI (vertical blanking interval) portion of your
video signal.

+ Embed in analog Line 21 (SD) Use this option if you want to play
back SD video from any of MXO2’s analog outputs (component,
S-Video, and composite), and embed the closed captioning data on
Line 21 of the VBI (vertical blanking interval) portion of your video
signal.

Note To preview HD video with closed captioning on an SD monitor, you
must set the output that is connected to your monitor to SD (see “Specifying
your video output settings” on page 58), and select either Embed in SDI Line
21 (SD) or Embed in analog Line 21 (SD).

e In Premiere Pro, specify your playback settings as detailed in “Defining
your playback settings” on page 82.

f Play back your sequence or export your sequence to tape.

Overlay closed captions (CC)

This section details how to overlay the closed captions that are on your
sequence on all the MXO2 video outputs for playback using Premiere Pro
CC.

Note The closed captioning overlay is supported for playback only. The
overlay will not be exported to tape.

a In Premiere Pro, specify your playback settings as detailed in “Defining
your playback settings” on page 82.

b From the Program monitor pop-up menu, choose Closed Captioning
Display > Enable.

¢ From the Program monitor pop-up menu, choose Overlay Settings >
Settings, and in the Overlay Settings dialog, select Enable overlays
for Transmit.

d Play back your sequence.

Overlay closed captions (CS6)

This section detailed how to overlay the closed captions that are on your
sequence on all the MXO2 video outputs for playback using Adobe Premiere
Pro CS6.
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a In Premiere Pro, specify your playback settings as detailed in “Defining
your playback settings” on page 82. When specifying your playback
settings, make sure to select the Enable CC overlay on output (Adobe
CS6) option in the Matrox Player Setup dialog.

Matrox Player Setup

Video Output

© 8-bit
@ 10-bit

i Enable CC overlay on output (Adobe CS6)

b From the Program monitor pop-up menu, choose Closed Captioning
Display > Enable.

¢ Play back your sequence.

Setting up Matrox device control

Matrox device control lets you control any device that supports the RS-422
SMPTE time code protocol when capturing or exporting material to tape in
Adobe Premiere Pro. To use device control, you must connect your source device
or recorder as follows:

¢ MXO02, MXO02 Rack, and MXO2 LE Connect the RS-422 connector on

your MXO2 hardware to the serial device control port on your source device
or recorder using an RS-422 serial cable (see “MX02 RS-422 serial
connection” on page 17, “MX02 Rack RS-422 serial connection” on

page 28, or “MXO02 LE RS-422 serial connection” on page 37).

Note When using an analog RS-422 device on MX02, MXO2 Rack, or
MXO?2 LE, you must genlock to an external broadcast-quality analog sync
source. If you’re using an SDI RS-422 device and you don’t have an external
broadcast-quality analog sync source, you can genlock to your SDI video
source for capture. For export to tape, you can set your genlock source to the
MXO?2 internal reference and configure the setting on your deck to genlock
to the SDI video input. For details on how to set your genlock source, see
“Specifying your genlock settings” on page 54.

MXO2 Mini MZXO2 Mini does not feature an RS-422 serial connector.
You can, however, use a suitable serial adapter to connect the serial device
port on your source device or recorder to your computer. For a list of
supported device control adapters, see the Matrox MXO2 Support section of
our website at www.matrox.com/video/support.
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—> To configure your Matrox device control settings:
1 In Premiere Pro, choose Premiere Pro > Preferences > Device Control.

Note When exporting to tape, Matrox uses a preroll of five seconds. This
value is hardcoded and cannot be changed. The Preroll and Timecode Offset
options available in Premiere Pro are ignored when using Matrox device
control for export to tape (see “Exporting your sequence to tape” on page 101).

2 From the Devices list, select Matrox Device Control.
3 Click Options to display the Matrox Device Control Options panel.

Matrox Device Control Options

s ell Matrox RS-422 Port

Time Source: QR[e =

MIGER:EEEH 30 fps Non-Drop Frame +

Playback Offset: HETL
"ok

4 From the Port list, select Matrox RS-422 Port. If the list contains more
than one Matrox RS-422 Port option, which occurs when your system has
more than one serial device control connection, select the option
corresponding to the desired connection.

Note For MXO2 Mini users, if you’re using a third-party serial adapter to
connect the serial device port on your source device or recorder to your
computer, the adapter must be connected to your computer before starting your
system for it to appear in the Port list.

5 From the Time Source list, select the time source to be used for controlling
your device:

— LTC Longitudinal Time Code recorded on a track adjacent to the video.
This type of time code can be read at all tape speeds, except still.

— VITC Vertical Interval Time Code that is recorded onto the vertical
blanking interval of the video. This type of time code can be read
whenever an image is displayed, but not usually during high-speed
operation.

— LTC+VITC Select this if you want your device to decide which type of
time code to use in different operational modes (recommended only if
you’re sure that the two types of time code match on your tape).
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— Control Track Select this if you want to use only your tape’s control
track as the time source. Because using the control track is not as reliable
as LTC or VITC for device control, you should select this option only if
you’re having problems using the time code on your tape.

6 From the Time Base list, select the time base that matches your tape, such as
30 fps Drop Frame if you’re using NTSC video with drop frame time code,
or 25 fps if you’re using PAL video.

7 If required, in the Playback Offset box, specify the number of frames to
offset the playback of your sequence for export to tape. For example, if
playback starts too late and the first three frames are black on the tape, enter
an offset of -3. Alternately, if playback starts too early and the first three
frames of your sequence are missing, enter an offset of 3.

8 Click OK to save your Matrox device control settings.
9 Click OK to save your settings in the Preferences dialog.

For details on specifying your capture settings in Premiere Pro, see “Defining
your capture settings” on page 84. For details on capturing with device control,
see your Adobe Premiere Pro documentation. For information about exporting
your sequence to tape, see “Exporting your sequence to tape” on page 101.

Exporting your sequence to tape

To export your Adobe Premiere Pro sequence to tape without using device
control, simply play back your sequence and record the output from any of the
available outputs on your MXO2 system. If your recorder supports RS-422
device control, you can export your sequence to tape using Matrox device control
as explained in “Exporting to tape using Matrox device control (CC)” on

page 101 or “Exporting to tape using Matrox device control (CS6)” on page 102.

Exporting to tape using Matrox device control (CC)

Note The following procedure applies to Adobe Premiere Pro CC only. If
you’re using Adobe Premiere Pro CS6, see “Exporting to tape using Matrox
device control (CS6)” on page 102.

You can record your sequence onto tape using Matrox device control in Adobe
Premiere Pro CC as follows:

1 Open your project, and set your playback settings as described in ‘“Defining
your playback settings” on page 82.

2 Make sure that you’ve properly connected your RS-422 recorder and
configured Matrox device control as explained in “Setting up Matrox device
control” on page 99.

3 Activate the sequence that you want to export to tape, and position the work
area bar over the section of the sequence that you want to export.
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If you haven’t already done so, render all sections that are identified with a
red or yellow render bar.

Note Adobe Premiere Pro will automatically render sections that have ared
render bar when you start an export to tape, but to avoid having dropped frames
you must render both the red and yellow sections before performing an export
to tape.

Load a striped recordable tape into your recorder, and set your recorder to
Remote or VTR mode.

Choose File > Export > Tape (Serial Device) to open the Edit To Tape
panel.

Note When exporting to tape, Matrox uses a preroll of five seconds. This
value is hardcoded and cannot be changed.

To preview the export to tape in the Edit to Tape panel:

a Connect your recorder’s output to the input on MXO2, and set the MXO2
input settings as specified in “Specifying your A/V input settings” on
page 55.

b In the Edit To Tape panel, click Recorder Settings, select Matrox
Recorder from the Capture Format list, and then click OK to close the
Capture Settings pane.

Use the settings and controls in Premiere Pro’s Edit To Tape panel to export

your sequence to tape. For information on how to use the Edit To Tape

panel, refer to your Adobe Premiere Pro documentation.

Note When exporting to tape, MXO2 supports the first four audio channels
only.

Exporting to tape using Matrox device control (CS6)

Note The following procedure applies to Adobe Premiere Pro CS6 only. If
you’re using Adobe Premiere Pro CC, see “Exporting to tape using Matrox
device control (CC)” on page 101.

With Matrox device control, you can you can perform either an insert or
assemble edit to record your sequence onto tape in Adobe Premiere Pro CS6 as
follows:

1 Open your project, and set your playback settings as described in ‘“Defining

your playback settings” on page 82.

2 Activate the sequence that you want to export to tape, and position the work

area bar over the section of the sequence that you want to export.

3 If you haven’t already done so, render all sections that are identified with a

red or yellow render bar.

Chapter 9, Using Matrox MX0O2 with Supported Programs



Note Adobe Premiere Pro will automatically render sections that have a red
render bar when you start an export to tape, but to avoid having dropped frames
you must render both the red and yellow sections before performing a Matrox
export to tape.

4 Make sure that you’ve properly connected your RS-422 recorder and
configured Matrox device control as explained in “Setting up Matrox device
control” on page 99.

Note When exporting to tape, Matrox uses a preroll of five seconds. This
value is hardcoded and cannot be changed. The Preroll and Timecode Offset
options available in Premiere Pro are ignored when using Matrox device
control for exporting to tape.

5 Load a striped recordable tape into your recorder, and set your recorder to
Remote or VIR mode.

6 Make sure that the sequence is activated, and then choose File > Export >
Tape to open the Matrox Export to Tape panel.
Matrox Export to Tape

Device Status

Stopped...
Export to Tape Mode

Edit mode: QWITgs v
Video track £
Audiotracks &1 2 3 g4 & Al

Abort export on dropped frames Y

Transport Control

L << N < N = N I N> N > N >

Shuttle
_._
n

@ Out 01:31:38:18
© Duration 00:01:00:01
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7

10

1

Under Export to Tape Mode, select the Edit mode for your export to tape.
Check your device’s documentation to determine its recording capabilities
for assemble and insert editing:

— Assemble Records all tracks (video and audio) sequentially onto the
tape. The control track and previously recorded material on the tape will
be replaced with the material recorded from your sequence.

— Insert Records selected tracks (video and/or audio), without affecting
the control track. This lets you perform a video or audio dub. For
example, you can choose to record only video, only selected audio tracks,
or video and selected audio tracks from your sequence.

If Insert was selected as the Edit mode, select whether to export the Video
track, and select the Audio tracks to export.

Select Abort export on dropped frames if you’d like the export to tape to
automatically stop when dropped frames are encountered. You’ll get a
warning if the export to tape is aborted due to a dropped frame.

Under Transport Control, use the controls to play back your tape. The
current time code of your tape appears in the box above the transport
controls. When entering a time code manually, you must use the
HH:MM:SS:FF format. You can also use the J, K, and L shortcut keys to
control the shuttle. Press J to shuttle left, L to shuttle right, and K to stop.
Pressing J or L multiple times increases the shuttling speed. Click the cue
button ([« ]) to position the tape at the currently displayed time code.

Note The transport controls are greyed out when there is no tape in the
recorder or when an invalid connection is detected.

Specify where you want the recording to start and stop on your tape as
follows:

— Click the In button ([ { ]) to set the In point to the current time code, or
enter the required time code in the In box. Click the cue button ([ (< ]) to
position the tape at the currently displayed In time code.

— Click the Out button ([ } ]) to set the Out point to the current time code,
or enter the required time code in the Out box. Click the cue button
([ >} ) to position the tape at the currently displayed Out time code. The
Out time code is not inclusive. That is, your recording will stop a frame
before the set Out point time code. For example, if your In point is
00:00:00:01 and your Out point is 00:00:00:03, the duration of your
recording is 00:00:00:02 and you will record over frames 01 and 02 on
your tape.
Alternately, you can select Duration and enter the duration you want for
the recording. The Out point will then be calculated for you. By default,
the duration is set to the duration of the work area. Click the reset button
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([ o)) at any time to set the duration back to the duration of the work
area.
Note When Out is selected, the duration is calculated based on your
selected In and Out points. When Duration is selected, the Out point is
calculated based on your specified In point and duration.

12 Click Export to start the export to tape.
Note The Exportbutton isnotavailable when the tape/recorder is in Record

Inhibit mode, when there is no tape in the recorder, or when an invalid
connection is detected.

Using the Matrox MPEG-2 I-frame codec

The Matrox MPEG-2 I-frame codec is a full-raster HD codec that gets installed
automatically when you install your MXO2 software. It is included primarily for
users who do not have a full-raster HD codec installed on their system.

To capture SD/HD video using the Matrox MPEG-2 I-frame codec, the MXO2
software must be installed on your system, and the MXO2 hardware must be
connected.

If the captured video will be played back on another system, the Matrox MPEG-2
I-frame codec must be installed on that system as well. You can download the
Matrox MPEG-2 I-frame codec for playback on other Mac systems from the
Download section of our Support website at www.matrox.com/video/support.

—> To configure the Matrox MPEG-2 I-frame codec:

The default settings for the Matrox MPEG-2 I-frame codec provide good results
for most applications. We recommend that you change these settings only when
needed for special purposes.
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Note If you're using the Matrox MPEG-2 I-frame codec for playback, some of
the options described in this section may not apply.

Compression Settings

Compression type: Matrox MPEG-2 |-frame T]

Motion
Frames per second 59,94 ﬂ

frame rame reo )

# Limit data rate to 10000 | KBytes/sec ~ Optimized f

Encoding Mode
Mult

Compressor

Scan pattern: () Regular
@ Alternate

Rounding type: () MPEG-2
@ Matrox custom

DC precision: | 9-bit ﬂ
@ Force frame-based DCT

1 Under Motion, select the frame rate for your captured video in Frames per
second, and enter a target data rate in the Limit data rate to box.

Note The data rate must be between 10 Mb/s (975 KB/s) and 300 Mb/s
(36621 KB/s) for SD material, and 50 Mb/s (6100 KB/s) and 300 Mb/s for
HD material.

2 To apply advanced compression settings, set the options under Compressor.
The default settings for the advanced options provide good results for most
applications. We recommend that you change these settings only when
needed for special purposes.

— Select your desired Scan pattern:
« Regular Sets the regular zig zag scanning pattern of the AC
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure
7-2) specification document.
+ Alternate Sets the alternate zig zag scanning pattern of the AC
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure
7-3) specification document. Use this setting when capturing video at a
high data rate.
— Select your desired Rounding type:

+ MPEG-2 Rounds the AC coefficient up to the nearest whole number
when calculating the quantization coefficient.
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« Matrox custom Truncates the AC coefficients to the lowest whole
number when calculating the quantization coefficient. In some cases,
this setting may yield less artifacts in graphics.

— From the DC precision list, select the bit-depth precision of the DC intra
block. The higher the DC precision value that’s used to render your video,
the more likely that the DC content will be increased at the expense of the
AC content in the encoded stream. This may result in lowering the overall
quality of the compressed stream at a specified data rate.

— Select the Force frame-based DCT setting to render macroblocks as
frames rather than as fields. In some cases, graphics will yield less
artifacts if this option is selected.

3 Click OK to save your settings.
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Working with Adobe Encore

The MXO2 playback device for Encore lets you monitor video and audio from
your Encore project using theMXO2 outputs. For a list of the supported video
output formats for the MXO2 main and SD channels, and the supported video
formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported
Output Formats.”

Perform the following steps to output video and audio from the MXO2 outputs
during playback in Encore:

1 Start Adobe Encore and either open an existing project, or start a new
composition. If necessary, import your clip.
2 Choose Encore > Preferences > Audio/Video Out.

3 In the Preferences dialog, select Matrox Player from the Audio Device
list.

4 Under Video Device, select Matrox Player, and then click Setup beside
Matrox Player.

5 In the Matrox Player Setup dialog, set whether to output 8-bit or 10-bit
video, and then click OK.

Note The Enable CC overlay on output (Adobe CS6) option in the

Matrox Player Setup dialog is not used.

6 Set the appropriate video and audio output settings in the Matrox Utilities
preferences window (see Chapter 7, “Configuring Your MXO2 System”).

@ Important When using Matrox Player as the playback device in Encore,
make sure that a Matrox audio option is not selected as the Audio Output
Device from Encore > Preferences > Audio/Video Out.
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Working with Adobe Prelude

The MXO2 playback device for Prelude lets you monitor video and audio from
your Prelude project using the MXO?2 outputs. For a list of the supported video
output formats for the MXO2 main and SD channels, and the supported video
formats for the MXO2 outputs, see Appendix D, “Matrox MXO2 Supported
Output Formats.”

Perform the following steps to output video and audio from the MXO2 outputs
during playback in Encore:

1 Start Adobe Prelude and either open an existing project, or start a new
composition. If necessary, import your clip.
2 Choose Prelude > Preferences > Playback.

3 In the Preferences dialog, select Matrox Player from the Audio Device
list.

4 Under Video Device, select Matrox Player, and then click Setup beside
Matrox Player.

5 In the Matrox Player Setup dialog, set whether to output 8-bit or 10-bit
video, and then click OK.

Note The Enable CC overlay on output (Adobe CS6) option in the
Matrox Player Setup dialog is not used.

6 Set the appropriate video and audio output settings in the Matrox Utilities
preferences window (see Chapter 7, “Configuring Your MXO2 System”).
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Working with Adobe After Effects

You can output video and audio from the MXO2 outputs during playback in
Adobe After Effects. The procedure to do this depends on which version of After
Effects you’re using as explained in the following sections.

Using Adobe After Effects vi13.x

When working with After Effects v13.x, you can output video and audio from the
MXO?2 outputs during playback as follows:

1 Start Adobe After Effects and either open an existing project, or start a new
composition. If necessary, import your clip.

2 Choose After Effects > Preferences > Video Preview.

3 In the Preferences dialog box, select Matrox Player under Video Device,
and then click Setup beside Matrox Player.

4 In the Matrox Player Setup dialog box, set whether to output 8-bit or
10-bit video, and then click OK.

Note The Enable CC overlay on output (Adobe CS6) option in the
Matrox Player Setup dialog is not used.

5 Set the appropriate video output settings in the Matrox Utilities preferences
window as described in “Specifying your video output settings” on page 58.

6 Play back your clip. When playing back your clip in After Effects, the video
portion of your clip is sent to theMXO2 outputs automatically. However, if
you want to monitor audio from theMXO2 outputs as well, you must select
MXO2 as the audio hardware device and then play back your clip in RAM
Preview mode. To do so, choose After Effects > Preferences > Audio
Hardware, select Matrox MX02 Audio Output from the Default Device
list, and launch RAM Preview (Composition > Preview > RAM
Preview).

Using Adobe After Effects v12.x or earlier

The Matrox WYSIWYG plug-in for Adobe After Effects (v12.x and earlier) lets
you monitor video and audio from your After Effects project using the MXO02
outputs. Matrox also provides WYSIWYG options that you can set to customize
your output preview.

Perform the following steps to output video and audio from the MXO?2 outputs
during playback in After Effects:

1 Start Adobe After Effects and either open an existing project, or start a new
composition. If necessary, import your clip.

2 Set the MX02 WYSIWYG settings in the Matrox Utilities preferences
window (see “Specifying your Matrox WYSIWYG settings” on page 70).
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3 Play back your clip. When playing back your clip in After Effects, the video
portion of your clip is sent to MXO2the Mojito outputs automatically.
However, if you want to monitor audio from MXO2the Mojito outputs as
well, you must select MXO?2 as the audio hardware device and then play
back your clip in RAM Preview mode. To do so, choose After Effects >
Preferences > Audio Hardware, select Matrox MX02 Audio Output
from the Default Device list, and launch RAM Preview (Composition >
Preview > RAM Preview).

Working with Adobe Photoshop

The Matrox WYSIWYG plug-in for Photoshop lets you export your Photoshop
image to MXO2the Mojito outputs for monitoring. Matrox also provides
WYSIWYG options that you can set to customize your output preview.

Perform the following steps to export your Photoshop image to MXO2the Mojito
outputs:

1 Start Adobe Photoshop and either open an existing image file, or start a new
project.

2 Set MXO2the Mojito WYSIWYG settings in the Matrox Utilities
preferences window (see “Specifying your Matrox WYSIWYG settings” on
page 70).

3 Export your image to MXO2the Mojito outputs by choosing File > Export
> Matrox WYSIWYG Preview. If you make a change to your image, or to
the Matrox WYSIWYG options, you must export the image again to refresh
the output.

& Tip You can create a Photoshop Action shortcut for File > Export > Matrox
WYSIWYG Preview. For information on creating Actions, see your Adobe
Photoshop documentation.
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Working with Adobe SpeedGrade

You can output video played back in Adobe SpeedGrade on the Matrox MXO2
video outputs to preview your clips on your video monitor. You can also choose
to output audio played back in Adobe SpeedGrade on your Matrox MXO2
hardware.

For detailed information about using Adobe SpeedGrade, see your Adobe
SpeedGrade documentation.
——> To specify your playback settings for use with Matrox MX02:

1 In Adobe SpeedGrade, click Preferences () at the top left of the
window.

2 In the Preferences dialog, click Playback and set the Base frame rate for
the playback, such as 29.97.

Playback Settings

Base frame rate
Frame step
Auto-mirror

Max. dropped frames

3 Click Display and select Enable under Mercury Transmit.

Video Device

Mercury Transmit

+ Enable

Device Matrox Player Refresh

Resolution 1080p (1920 x 1080) Setup

4 From the Device list, select Matrox Player.

5 From the Resolution list, select the resolution for playback, such as 1080p
(1920 x 1080).

6 Click Setup and select the bit depth for your video output (8-bit or 10-bit).
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Note The Enable CC overlay on output (Adobe CS6) option is not used.

Video Output

Matrox Player Setup

© 8-bit
@ 10-bit

B Enable CC overlay on output (Adobe CS6)

7 Click OK to return to the Preferences dialog.

8 If you also want to output audio from your Matrox MXO2 hardware, click
Sound, select Core Audio from the Engine list, and then select the Matrox
MXO2 audio output option from the Device list.

Sound
Engine

Device

Mixing frequency
Output quality
Startup latency

Max. sync deviation

Core Audio

Matrox MX02 A441851 Audio Output

v Hz
v bits per sample

4 seconds

4 seconds

Important For your sound device setting to take effect, you must quit and
restart Adobe SpeedGrade.

9 Set the appropriate video and audio output settings in the Matrox Ultilities
preferences window (see Chapter 7, “Configuring Your MXO2 System”).

10 Play back your sequence in Adobe SpeedGrade.
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Working with Avid Media Composer and
Symphony
You can use Avid Media Composer and Avid Symphony with MXO2 to capture
and play back video and audio. For a list of the supported input and capture video
formats, see Appendix C, “Matrox MXO2 Supported Input and Capture

Formats.” For a list of the supported video output formats, see Appendix D,
“Matrox MXO2 Supported Output Formats.”

This section includes information on how to:

* Create a new Matrox MXO2 project. (page 114)
» Define your playback settings. (page 114)

* Define your capture settings. (page 115)

* Add a voice-over to your sequence. (page 117)

» Specify settings for capturing, playing back, and exporting Matrox 4VANC
AFD and closed caption data. (pages 115-120)

* Specify your audio output settings. (page 121)

* Define settings for exporting your sequence to tape. (page 122)

Creating a new Matrox MXO2 project

You can create a new Avid Media Composer/Symphony project for working with
Matrox MXO?2 as explained in your Avid documentation, with the following
exceptions:

* Avid supports only standard raster dimensions for projects created on
Matrox MXO2 hardware. This means that when you create an HD project
for MX 02, the raster dimension will be set to 1280x720 for a 720p project,
or 1920x 1080 for a 1080i/p project. You can, however, still import, export,
and play back thin raster material in your HD project.

* Matrox MXO2 supports YCbCr video only. If you set your project’s color
space to RGB, Avid Media Composer/Symphony will convert your material
to YCbCr for output on Matrox MXO2. To capture video using your Matrox
MXO2 hardware, your project’s color space must be set to YCbCr.

Defining your playback settings

This section details how to specify various settings for playing back video and
audio in Avid Media Composer and Symphony using the Matrox MXO2 outputs.
For a list of the supported video output formats, see Appendix D, “Matrox
MXO?2 Supported Output Formats.”
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1 Specify the MXO2 General settings, and if applicable to your Matrox
hardware, specify the Genlock settings (see Chapter 7, “Configuring Your
MXO2 System).

2 In Avid Media Composer/Symphony, open the project that you want to play
back.

3 When using an MX02, MXO2 LE, or MXO2 Rack SDI output for playback,
you can choose to play back Matrox 4VANC AFD (active format
description) or closed caption data that is stored as an audio track, and
restore the data to your video's VANC (vertical ancillary data space) on
output. For more information on Matrox 4VANC, see “Matrox 4VANC
capture and playback” on page 66.

Note Matrox 4VANC is not available on Matrox MXO2 Mini.

To play back the Matrox 4VANC AFD and/or closed caption data, in Avid
Media Composer/Symphony, click Settings in the Project window, and
then double-click Audio Project. In the Audio Project Settings dialog
box, in the Output pane, click the Mix Mode Selection button to select
Direct or Direct, surround tracks in SMPTE order, depending on your
version of Avid Media Composer/Symphony. Then assign the audio track
that contains the Matrox 4VANC AFD data to output as audio channel 15,
and/or assign the audio track that contains the Matrox 4VANC closed
caption data to output as audio channel 16. For information on how to
maintain Matrox 4VANC AFD and closed caption data when exporting your
project to a file, see “Specifying settings for exporting Matrox 4VANC AFD
and closed captioning to a file” on page 120.

Note To preserve the integrity of the AFD and closed caption data for
playback, do not manipulate the audio tracks that contain the AFD and closed
caption data in any way. For example, do not adjust the audio gain or balance,
or add audio effects to the tracks.

4 In Avid Media Composer/Symphony, click Settings in the Project window,
double-click Video Output to open the Matrox Utilities preferences
window, and then select More... to specify your Matrox video output
settings (as described in “Specifying your video output settings” on
page 58). If you’re playing back Matrox 4VANC AFD and/or closed caption
data, you must enable Matrox 4VANC playback in the Matrox Utilities
preferences window as described in “Matrox 4VANC capture and playback”
on page 66.

5 In Avid Media Composer/Symphony, play back your project.

Defining your capture settings
This section details how to specify various settings for capturing video and audio
in Avid Media Composer/Symphony using the Matrox MXO2 inputs.
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When using MXO2 with Avid Media Composer/Symphony, your source material
is captured to your project’s video format. You can also preview the captured
video using the Matrox MXO2 outputs. When previewing the captured video, the
output video format will match your project’s video format. For a list of the
supported input and capture video formats, see Appendix C, “Matrox MXO2
Supported Input and Capture Formats.”

Note The SD channel video output setting is not supported on MXO?2 during
capture. To preview the captured video, Main channel must be selected for the
MXO2 outputs in the Video Output pane of the Matrox Utilities preferences
window (see “Specifying your video output settings” on page 58.

If you want to capture material using RS-422 device control, you can connect the
RS-422 connector on Matrox MX02, MXO2 Rack, or MXO2 LE to the RS-422
serial device control port on your source device (see “MXO02 RS-422 serial
connection” on page 17, “MXO02 Rack RS-422 serial connection” on page 28, or
“MXO02 LE RS-422 serial connection” on page 37). On Matrox MXO2 Mini,
you must use a suitable adapter to connect the serial device control port on your
source device or recorder to your computer. For a list of supported device control
adapters, see the Matrox MXO2 Support section of our website at
www.matrox.com/video/support.

Remarks

* To capture video on Matrox MXO2, your project’s color space must be set to
YCbCr.

* Matrox MXO2 supports the Audio tool so that you can monitor and adjust
your audio input levels for capture.

» Capture on Matrox MXO?2 is not supported for a 24p NTSC, 24pPAL, or
720p/29.97 project.

—> To specify your capture settings:

1 Specify the MXO2 General settings, and if applicable to your Matrox
hardware, specify the Genlock settings (see Chapter 7, “Configuring Your
MXO?2 System).

2 Open Avid Media Composer/Symphony and create a new project (see
“Creating a new Matrox MXO?2 project” on page 114). Your source material
will be captured to your project’s video format.

3 In the Capture tool, make sure that Matrox is selected as the Video and
Audio input sources.

4 When using an MX02, MXO2 LE, or MXO2 Rack SDI input for capture,
you can choose to capture the AFD (active format description) or closed
caption data that is stored in your source video's VANC (vertical ancillary
data space) by using the Matrox 4VANC tool. For more information on
Matrox 4VANC, see “Matrox 4VANC capture and playback” on page 66.
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To capture AFD and/or closed caption data, in Avid's Capture tool, enable
all 16 audio channels, set audio channels 15 and 16 to Mono, and select 1:1
MXF from the Res list.

Note Matrox 4VANC is not available on Matrox MXO2 Mini.

5 Click the Hardware Setup (n ) button to open the Matrox Utilities
preferences window, and specify your Matrox capture settings as described
in “Specifying your A/V input settings” on page 55. If you’re capturing
Matrox 4VANC AFD and/or closed caption data, you must enable Matrox
4VANC capture in the Matrox Utilities preferences window as described in
“Matrox 4VANC capture and playback™ on page 66.

6 Capture as you would normally.

Adding a voice-over to your sequence

Matrox MXO2 supports the Audio Punch-In tool, which allows you to record
audio directly into the Timeline to add voice-over narration, such as to add
commentary to newsreels and documentaries.

Note The Audio Punch-In tool supports recording to mono tracks only.

Connection and setup
1 Connect the input device (microphone) to the audio input on a source device,
such as a preamplifier, and then connect the audio output from the source
device to the corresponding audio input on your MXO2 hardware.

Note The Matrox hardware audio inputs are line level. Therefore, make sure

your audio equipment output matches.

2 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.
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3 Click A/V Input.

a (3]
[ > || ShowAll | Q

Matrox Utilities

Load Preset | | Save Preset

{Cinfo | General = Genlock [NEVUAITTNMI Video Output Audio Output | CC/AFD | WYSIWYG

FCPX |

Input Source

Video: | Component (Y, Pb, Pr)

Capture unstable video signals

Audio: | Analog balanced XLR

Scaling

Scale input for capture
Source format:

Aspect ratio formatting: Letterbox

4 Under Input Source, select the Audio input on your Matrox hardware to
which your audio source device is connected, and then select Component

from the Video list.
5 Close the Matrox Utilities preferences window.

Recording your voice-over

You use the Audio Punch-In tool to record your voice-over. The following steps
provide guidelines for recording a voice-over. For details on using the Audio

Punch-In tool, see your Avid documentation.
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1 With a sequence loaded in the Avid Media Composer/Symphony timeline,

choose Tools > Audio Punch-In.

2 Select Matrox from the Input Source list.

Tip If Matrox MXO02 (serial number) Audio Input appears in the Input
Source list instead of Matrox, the Matrox hardware is deactivated in Avid.
Click the Toggle Hardware button in Avid to activate the Matrox hardware,

and then select Matrox.

Select the Matrox audio input channels that you want to record, and then
select the corresponding tracks on which you want to record. If you select an
existing track, you can replace all or part of the audio on the track with your
voice-over.

Click the Audio Tool button ([Jlll]). and use the controls and meters in the
Audio tool to test the audio input levels while speaking into the microphone.
If needed, adjust the audio level on your source device so that the input
levels are sufficiently high but not clipping.

Note To see the meters in the Audio tool, make sure that the In/Out toggle

buttons are set to | (for Input):
Input selected

Iil Ii Ii I- Ii Ii Iﬁ Iﬁ Ii Iﬁ Iﬁ Iii Iﬁ I Iﬁ Iii

For details on using the Audio tool, see your Avid documentation.
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5 Move the position indicator on the timeline to where you want the voice-over
to begin. You can also set In and Out points to specify the section of the
timeline to which you want to add your voice-over, and specify preroll and
postroll values if desired.

6 When you’re ready to start the voice-over, click the Record button ().

7 Click the Stop button (@) to stop the recording. Your voice-over will be
added as an audio clip on the Timeline.

Note During recording, your voice-over will not be output to your Matrox

MXO2 hardware, and audio punch-in monitoring is not supported.

Specifying settings for exporting Matrox 4VANC
AFD and closed captioning to a file

When working in an Avid Media Composer or Symphony project that has
Matrox 4VANC AFD and/or closed caption data stored as an audio track, the
following steps detail how to specify your settings in Avid Media
Composer/Symphony to maintain the Matrox 4VANC AFD and closed caption
data when exporting your project to a file. For information on how to capture and
play back Matrox 4VANC data in Avid Media Composer/Symphony, see
“Defining your capture settings” on page 115 and “Defining your playback
settings” on page 114.

1 In Avid Media Composer/Symphony, make sure that the audio track that
contains the Matrox 4VANC AFD data is set to output as audio channel 15,
and/or the audio track that contains the Matrox 4VANC closed caption data
is set to output as audio channel 16.

2 Choose File > Export.

3 In the Export As dialog, select Send to QT Movie from the Export
setting list, and then click Options.

4 In the Export Settings dialog, select the Use Marks and Use Enabled
Tracks options, select Video and Audio, and then select Direct Out in the
Audio Format pane.

Specifying settings for importing a Matrox
4VANC file

When working in Avid Media Composer or Symphony, you can import a video
file that contains Matrox 4VANC AFD and/or closed caption data to your project.
You can also import a Matrox 4VANC closed caption audio file that was created
using a supported captioning software, such as CPC MacCaption. This section
details how to import your Matrox 4VANC file in Avid Media
Composer/Symphony.
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For information on how to capture and play back Matrox 4VANC data in Avid
Media Composer/Symphony, see “Defining your capture settings” on page 115
and “Defining your playback settings” on page 114. For information on how to
specify your settings in Avid Media Composer/Symphony to maintain the
Matrox 4VANC AFD and closed caption data when exporting your project, see
“Specifying settings for exporting Matrox 4VANC AFD and closed captioning to
a file” on page 120.”

1 In Avid Media Composer/Symphony, choose File > Import.

2 In the Select files to Import dialog, select 1:1 MXF from the Resolution
list, except when importing a Matrox 4VANC closed caption audio file that
was created using a supported captioning software, such as CPC
MacCaption. In this case, select a DV MXF option from the list.

3 Click Options.
4 In the Audio pane, make sure that all options are cleared, and then click OK.

5 In the Select files to Import dialog, select the file to import and then click
Open.

Specifying your audio output settings

The simultaneous audio outputs on your Matrox MXO2 hardware allow you to
send your audio to a variety of devices at the same time. Avid Media
Composer/Symphony and Matrox provide various settings to configure your
audio output on MXO2.

1 In Avid Media Composer/Symphony, click Settings in the Project window,
and then double-click Audio Project.

2 In the Audio Project Settings dialog, click the Output tab, and then
specify your desired audio output settings as explained in your Avid
documentation. If playing back a project with Matrox 4VANC AFD and/or
closed caption data, see “Defining your playback settings” on page 114 for
information on how to specify your audio settings in Avid for use with
Matrox 4VANC. If exporting a project with Matrox 4VANC AFD or closed
captioning to a file, see “Specifying settings for exporting Matrox 4VANC
AFD and closed captioning to a file” on page 120.

Remarks

— For surround sound HDMI audio output, Matrox MXO2 supports the 5.1
and 7.1 SMPTE settings only (and the Direct SMPTE setting, if
available).

— Matrox MXO2 supports the Audio tool so that you can monitor the global
output level of your sequence. If needed, you can use the Output Gain
(master attenuator) slider to adjust the overall output volume for all tracks.
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— To preserve the integrity of Matrox 4VANC AFD or closed caption data
for playback (see “Defining your playback settings” on page 114), do not
manipulate the audio tracks that contain the AFD and closed caption data
in any way. For example, do not adjust the audio gain or balance, or add
audio effects to the tracks.

3 MXO2 lets you map any audio track in Avid Media Composer/Symphony to
any MXO?2 audio output. For information on how to enable and configure
audio mapping in MXO2, see “Specifying your audio output settings” on
page 62.

Note For surround sound HDMI audio output, the Enable audio mapping
option in the Audio Output pane of the Matrox Utilities preferences window
must be disabled.

Exporting your sequence to tape

You can record your sequence onto tape using device control or manually as
explained in your Avid documentation. Before exporting to tape, set your desired
playback settings as explained in “Defining your playback settings” on page 114.
For a list of the supported video output formats, see Appendix D, “Matrox
MXO?2 Supported Output Formats.”

To export to tape without device control, simply play back your sequence and
record the output from any of the available outputs on your MXO2 system.

If your recorder supports RS-422 device control, you can connect the RS-422
connector on Matrox MX02, MXO2 Rack, or MXO?2 LE to the RS-422 serial
control port on your recorder (see “MX0O2 RS-422 serial connection” on page 17,
“MXO02 Rack RS-422 serial connection” on page 28, or “MX02 LE RS-422
serial connection” on page 37). On Matrox MXO2 Mini, you must use a suitable
adapter to connect the serial device control port on your source device or recorder
to your computer. For a list of supported device control adapters, see the Matrox
MXO?2 Support section of our website at www.matrox.com/video/support.

Note When using an analog RS-422 device on MX02, MXO2 Rack, or
MXO2 LE, you must genlock to an external broadcast-quality analog sync
source. If you’re using an SDI RS-422 device and you don’t have an external
broadcast-quality analog sync source, you can set your genlock source to the
MXO?2 internal reference and configure the setting on your deck to genlock to the
SDI video input. For details on how to set your genlock source, see “Specifying
your genlock settings” on page 54.

To record the output from your MXO?2 system using device control with the
Digital Cut tool, make sure that the Output Mode is set to Real-Time. Also,
when configuring your deck in the Channel window, make sure that Direct is
selected from the Channel Type list, and Matrox RS-422 is selected from the
Port list.
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@ Important If you want to downconvert a 720p/23.976, 1080p/23.976, or
1080p24 sequence to SD to record a digital cut, you must change your project’s
format (project type) to SD. For example, to downconvert a 720p/23.976 or
1080p/23.976 sequence to NTSC to record a digital cut, you must change the
project type to 23.976p NTSC. You can then select the output format that you
want in the Digital Cut tool.

Working with Apple Final Cut Pro X

You can use Apple Final Cut Pro X to play back and output video and audio
using Matrox MXO?2.

Playback using Matrox MXO2

This section details how to play back and output video and audio in Apple Final
Cut Pro X using Matrox MXO2. For a list of the supported video output formats,
see Appendix D, “Matrox MXO?2 Supported Output Formats.”

1 Ensure that Apple Final Cut Pro X is not running.
2 From the Apple menu, click System Preferences, and then click the
Matrox Utilities icon.

‘@00 Matrox Utilities
[« > ][ Showall | Q

Load Preset Save Preset

{(info_| Ceneral | Cenlock | A/Vinput | Video Output | Audio Output | Matrox 4VANC | WySWYG G200

Output format: | 720p 29.97 8-bit

3 In the Matrox Utilities preferences window, in the FCP X pane, select the
Output format that matches the format of the project or clip that you want
to play back in Final Cut Pro X.
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Note If the Output format list is unavailable and “(In use)” appears,
MXO2the Mojito hardware is currently being used by an application on your
system. To change the output format, you must first disable A/V Output in
Final Cut Pro X (Window > A/V Output), or close any application that is
using Matrox MXO2.

4 In System Preferences > Sound, set Matrox MXO2 as the Output audio
device for your Mac OS system. Close the Sound preferences window.

8enon Sound
[ 4| > ][ Showall | Q|

Select a device for sound output:

Name Type
Line Qut Audio line-out port
Digital Out Optical digital-out port
Display Audio UsB

Matrox MXO2 LE BK89604 Audio Output PCl card

Settings for the selected device:

The selected device has no output controls

Output volume: * 1 *’)) Mute

@Shuw volume in menu bar
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5 Open Final Cut Pro X, choose Final Cut Pro > Preferences, and ensure
that the Matrox video format that you selected in step 3 appears as the A/V
Output option in the Playback pane.

6 In the Playback pane, set Playback Quality to High Quality. However, if
you experience dropped frames in your video output, select Better
Performance.
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7 From the Window menu, enable A/V Output.

[Window I

Minimize #EM
Minimize All

Zoom

Co to Event Browser 1
Go to Viewer 33
Go to Timeline 382
Go to Inspector a4
Go to Color Board %6
Co to Audio Enhancements #®e
Show Project Library ®0
Hide Event Library f+381
Show Timeline Index 382
Show Inspector ¥4
Show Video Scopes ®7
Show Angle Viewer G 87
Show Audio Meters 388
Media Browser >
Record Audio

Background Tasks ®9
Next Tab ~
Previous Tab A4t

Show Events on Second Display
Show Viewer on Second Display

v A/V Qutput

Revert to Original Layout
Bring All to Front
+ Final Cut Pro

Enter Full Screen ~3%F

8 Play back your video in Final Cut Pro X.
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Using the Matrox MAX H.264 Codec

This chapter explains how to
use the Matrox MAX H.264
codec that is available on
Matrox MXO2 products with
MAX technology for exporting
material for Blu-ray Disc, the
web and mobile devices.
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Overview

If you have an MXO2 product with Matrox MAX technology, you can quickly
and easily create H.264 files for Blu-ray Disc (Apple Compressor only), the web
and mobile devices, such as Apple TV, iPod, and iPhone, using the Matrox MAX
H.264 codec.

Remarks
* The MXO?2 inputs and outputs will not be available when creating H.264
files using the Matrox MAX H.264 codec. This limitation, however, does not
apply if your system includes a Matrox CompressHD card. In this case, the
Matrox MAX H.264 codec on your Matrox CompressHD card will always
be used, and your MXO2 inputs and outputs will be available when creating
H.264 files.

» Non-Matrox compression options that are available in supported
applications are not optimized for using MXO2 to accelerate H.264
encoding. As a result, the use of non-Matrox options in a supported
application may result in increased encoding times.

This chapter provides information on how to encode using the Matrox MAX
H.264 codec from the following applications:

» Apple Compressor (page 128)

» Apple Final Cut Pro X (page 137)
* Adobe Premiere Pro (page 138)

* Adobe Media Encoder (page 138)
» Telestream Episode (page 142)

* Avid Media Composer (page 145)
* Avid Symphony (page 145)

* Apple QuickTime Pro (page 149)

Using Apple Compressor

The Matrox MAX H.264 component for Apple Compressor includes predefined
Matrox MAX H.264 settings that you can assign to immediately apply
appropriate compression settings for delivering H.264 files for Blu-ray, the web,
and mobile devices. For most deliverables, you can use one of the predefined
Matrox MAX H.264 settings in Compressor (see “Assigning a Matrox MAX
H.264 setting” on page 129). However, if you require a custom setting, see
“Creating a custom Matrox MAX H.264 setting” on page 130. For detailed
information on settings and other Compressor-related subjects, see your Apple
Compressor documentation.
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The Matrox MAX H.264 Blu-ray settings encode video only. Audio is not
encoded by the Matrox MAX H.264 codec when creating H.264 elementary
streams for Blu-ray. To include audio when exporting to Blu-ray format, you
must assign a separate audio setting to your source media file. However, audio is
encoded by the Matrox MAX H.264 codec when creating QuickTime files for the
web and mobile devices. The Matrox MAX H.264 elementary stream files that
you create for Blu-ray Disc using Compressor can be imported directly to Adobe
Encore and Roxio Toast without having to transcode the files.

Matrox MAX technology also supports the closed caption data from SCC files
for web deliverables (.mov) when encoding at 1:1, or when downscaling. When
an SCC (CEA-608) closed caption file is associated with your source media file
in Compressor, Matrox MAX technology embeds the closed caption data in the
encoded video file (.mov).

Assigning a Matrox MAX H.264 setting

This section describes how to assign a Matrox MAX H.264 setting to your source
file in Apple Compressor. The Matrox MAX H.264 settings include the
predefined settings installed with your MXO2 software, and any custom settings
that you create (see “Creating a custom Matrox MAX H.264 setting” on

page 130).

Note When selecting a predefined Matrox MAX H.264 setting, any
modifications made to your source video’s frame size in your application must be
taken into consideration. For example, if your source video was cropped in your
application, your source video’s frame size is the cropped frame size and not the
original frame size.

The predefined Matrox MAX H.264 settings that are installed with your MXO2
software are located in Compressor’s Settings window, under Custom >
Matrox MAX H.264 Settings. The predefined Matrox MAX H.264 settings are
separated into three folders: Blu-ray, Fast Encode, and High-Quality:

* Blu-ray Use these settings for all Blu-ray deliverables. The encoded file’s
extension will be .264.

Note For compatibility with most Blu-ray players and Adobe Encore, the
predefined Matrox MAX H.264 settings for Blu-ray use a simple GOP
structure.

* Fast Encode Use these settings for fast encoding of QuickTime files.
These settings leverage your system’s resources with the MXO2 hardware,
resulting in even faster encoding times. The encoded file’s extension will be
.mov.

Note If your source video must be scaled for encoding and its aspect ratio
does not match the compression aspect ratio, with Compressor v3.5 or later,

129
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you can select Preserve source aspect ratio from the Padding list in
Compressor’s Geometry pane to maintain your source video’s aspect ratio.

* High-Quality Use these settings for high-quality encoding of QuickTime
files. With these settings, the encoding is performed entirely by the MXO2
hardware, which frees your system’s resources for other tasks. The encoded
file’s extension will be .mov.

—> To assign a Matrox MAX H.264 setting:

1 In Apple Compressor, add the source media file that you want to export as an
H.264 file to the Batch window in Compressor.

2 Drag the desired Matrox MAX H.264 setting from the Settings window to
your source media file (job) in the Batch window.

Note Matrox MAX technology supports closed caption data from SCC files
for web deliverables (.mov) when encoding at 1:1, or when downscaling. When
an SCC (CEA-608) closed caption file is associated with your source media
file in Compressor, Matrox MAX technology embeds the closed caption data
in the encoded video file (.mov).

3 If you’re exporting to Blu-ray format and you want to export audio as well,
you must add a separate audio setting to your Batch window. Matrox
provides predefined audio settings for each of the Matrox settings, however,
you can choose to use another audio setting.

4 Choose a destination for your job’s targets and submit your batch as you
would normally.

Creating a custom Matrox MAX H.264 setting
You can create a custom Matrox MAX H.264 setting in Apple Compressor for
delivering H.264 files for either Blu-ray (.264) or QuickTime (.mov). Once you
create a new Matrox MAX H.264 setting, you can assign it to your source file in
Apple Compressor using the steps described in “Assigning a Matrox MAX H.264
setting” on page 129.

@ Important To avoid losing your custom Matrox MAX H.264 settings in
Compressor when updating your MXO?2 software, you must uninstall the MXO02
software that is installed on your system, restart your computer, and then install
the new MXO?2 software version before opening Compressor. If you open
Compressor before installing the new MXO?2 software, that is, with no MXO02
software installed on your computer, your custom Matrox MAX H.264 settings
will be deleted by Compressor.
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1 In Apple Compressor, click the Create a new setting button in the
Settings window, and then click either Matrox MAX H.264 (.264) for
Blu-ray or Matrox MAX H.264 (.mov) for QuickTime.

Note You can also select and duplicate an existing Matrox MAX H.264
setting that you want to use as a starting point for creating the new setting.

2 In the Inspector window, type a Name and Description.

3 On the Encoder pane of the Inspector window, make sure that File Format
is set to Matrox MAX H.264 (.264) for Blu-ray or Matrox MAX H.264
(.mov) for QuickTime, and Extension is set to 264 for Blu-ray or mov for
QuickTime, and then click Options.

(.264 options)

can
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4 Under Encoding Resolution, select the resolution settings for your encoded
video:

Note Matrox MAX technology supports closed caption data from SCC files
for web deliverables (.mov) when encoding at 1:1, or when downscaling. When
an SCC (CEA-608) closed caption file is associated with your source media
file in Compressor, Matrox MAX technology embeds the closed caption data
to the encoded video file (.mov).

— H.264 Level Select the H.264 level that you want for your encoded

video.
Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)

2.0 352288 29.97 2

3.0 720%576 29.97 10

3.1 1280%720 29.97 14

4.0 1920x 1080 29.97 20

4.1 1920x 1080 29.97 50

4.2 1920%x 1080 59.94 50

Remarks

— Use H.264 level 4.0 if you want to create Matrox MAX H.264 files
intended for mass replication of Blu-ray Discs. You can use either level
4.0 or 4.1 if you want to author and burn individual copies that are
compatible with Blu-ray Disc players.

— Use H.264 level 3.1 to create HD video for use with Apple iPad.

— Frame size Specify the frame size that you want for your encoded
video. You can select a frame size from the list, or select Custom and
enter a frame size (horizontal x vertical). If entering a custom frame size,
the minimum frame size is 64 x64, and the maximum frame size depends
on the selected H.264 level. The horizontal and vertical values must be
even numbers.

Note Theavailable frame sizes in the listdepend on the selected H.264 level.
If the compression frame size differs from your source video’s frame size,
MXO?2’s onboard scaler will either upscale or downscale your source video.

— Pixel aspect ratio If you entered a custom compression frame size,
specify a pixel aspect ratio for your encoded video. You can select a pixel
aspect ratio from the list, or enter a custom value:

+ Custom Enter a custom pixel aspect ratio using a decimal value.
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« Square Use this for video that will be displayed on a computer, or
when exporting to 1280x720 or 1920x 1080.

+ NTSC (4:3) Sets the pixel aspect ratio to 4:3 using 720x480 pixels.

+ NTSC (16:9) Sets the pixel aspect ratio to 16:9 using 720x480
pixels.

« PAL (4:3) Sets the pixel aspect ratio to 4:3 using 720x576 pixels.
« PAL (16:9) Sets the pixel aspect ratio to 16:9 using 720x576 pixels.

« DVCPRO HD 720p Sets the pixel aspect ratio to 16:9 using 960x720
pixels.

« DVCPRO HD 1080i 59.94 Sets the pixel aspect ratio to 16:9 using
1280x 1080 pixels.

« DVCPRO HD 1080i 50 / HDV  Sets the pixel aspect ratio to 16:9
using 1440x 1080 pixels.

— Color space If you entered a custom compression frame size, specify a
color space for your encoded video.

— Frame rate Select the frame rate that you want for your encoded video.

— Web streaming (Fast Start) (.mov files only) Select this option if you
want your encoded .mov QuickTime file to play as it is being downloaded
from a standard web server. This option encodes your video as a
QuickTime “Fast Start” file. When the file is being downloaded, it will
begin to play back from a QuickTime application once enough data has
been downloaded to the system for uninterrupted playback. This option
ensures high-quality playback regardless of internet connection speed.
However, viewers with slower connection speeds may wait longer before
the file begins to play.

5 Under GOP Structure, specify the GOP structure settings that you want the
Matrox MAX H.264 codec to use to encode your video:

— GOP type (.264 files only) Select the type of GOP structure for your
encoded video:
« Simple GOP Offers a fixed structure in how frames are referenced,
and may be more easily decoded than advanced GOPs.

« Advanced GOP (short/long) An advanced GOP has more
structural flexibility than a simple GOP, is capable of using more
reference frames, and therefore may provide better overall
compression. For a “short” advanced GOP, the distance between P
frames is always 4, and for a “long” advanced GOP, the distance
between P frames is always 8.

Important An H.264 elementary stream file for Blu-ray that was created
using an advanced GOP structure may not be compatible with some Blu-ray
players, and may cause stability issues in Adobe Encore when burning a
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Blu-ray Disc. For compatibility with most Blu-ray players and Adobe

Encore, we recommend using a simple GOP structure when encoding to

Blu-ray.

— GOP size Select the GOP size in frames (must be a multiple of the
distance between P frames). The GOP size can be either 2048, or an
integer value between 3 and 254.

Note When creating an H.264 elementary stream file for Blu-ray, the GOP
size must be less than one second of video. For example, if the frame rate that
you want for your encoded video is 29.97 fps, the GOP size must be 29 frames
or less.

— Distance between P frames Select the number of frames between P
frames that you want for your GOP structure. This setting can be changed
for a simple GOP structure only.

Under Hardware Preprocessing, specify the hardware-related processing
settings for your encoded video:

— Hardware scaling If your source video must be scaled for encoding,
select this option if you want the scaling to be done by the MXO02
hardware. This produces the best-quality results and frees your system’s
resources for other tasks. Clear this option to leverage your system’s
resources with the MXO2 hardware for even faster encoding times. If
enabled, specify the following scaling options:

+ De-interlace video Select this option if your source video is
interlaced and you want to de-interlace your video before encoding.
This option can be used to display your encoded video on a monitor
that displays lines progressively, such as an LCD or computer monitor.
For all other instances, make sure this option is not selected.

» Retain aspect ratio when scaling If your source video must be
scaled for encoding, and its aspect ratio does not match your selected
compression aspect ratio, select this option to maintain your source
video’s aspect ratio. If this option is selected, MXO2 will encode your
source video as pillarbox video when encoding to a larger aspect ratio,
or letterbox video when encoding to a smaller aspect ratio. If this
option is not selected, MXO2 will encode your source video as
anamorphic video.

@ Important When your source video must be scaled for encoding and

Hardware scaling is disabled, if you’re working with Compressor v3.5 or
later you can select Preserve source aspect ratio from the Padding list in
Compressor’s Geometry pane to maintain your source video’s aspect ratio.
— Noise Filter Sets the level of noise filtering that you want to apply to

your video before encoding. Increasing the noise filter level reduces the
amount of high frequencies in your source video by softening the
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high-detail portions of your video. Since high frequencies require more
bits to encode, increasing the noise filter level leaves more bits available
for the encoding of other frames, which can improve the overall quality of
your encoded video. However, if you lose too much detail in your encoded
video you may need to decrease the noise filter level.

— Scene detection (.mov files only) Enabling this option allows the
Matrox MAX H.264 codec to detect scene changes while encoding, and
encode these transitions as [-frames. This results in multi-pass quality in a
single pass. This option can be useful for creating higher quality video at a
given data rate. It’s especially useful when encoding video with many
scene changes and targeting a low data rate.

7 Under Video Compression, specify the compression settings for your
encoded video:

— Algorithm Select the entropy coding method to be used during
compression:

+ CABAC Uses the CABAC coding method, and defines the video
stream as H.264 Main profile.

+ CAVLC Uses the CAVLC coding method, and defines the video
stream as H.264 Baseline profile when Distance between P frames
is set to 1. Otherwise, the video stream is defined as H.264 Main
profile. This method is not supported when encoding to a frame size
that has a width greater than 720.

— Compression type Select from the following compression types:

- Variable data rate Video is compressed at varying data rates based
on the complexity of the video and your specified minimum and
maximum data rates. The Matrox MAX H.264 codec analyzes and
encodes each frame to deliver the highest possible quality at your target
data rate.

« Constant data rate Video is compressed at your specified target
data rate, which is useful when you need to limit or predict the size of
your video file. However, if your video is very complex (such as scenes
with many colors, sharp edges, or transitions), you’ll need to specify a
high target data rate to avoid having frames of blocky video in your file.

« Constant quality Delivers your desired quality on each frame with
no regard to data rate.

Remarks
— When using Constant quality, the entropy encoding algorithm must be
set to CABAC.

— Variable data rate and Constant quality compression types are not
recommended for delivering H.264 files for Blu-ray.

8 Specify the settings associated with your selected compression type:
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— Target data rate (Variable/Constant data rate only) Enter the target

data rate, in Mb/s or Kb/s, for your encoded video. The higher the target
data rate you specify, the better the video quality will be.

— Minimum/Maximum data rate (Variable data rate only) If locked

(| @) to the Target data rate, the minimum and maximum data rates are
set automatically and cannot be changed. Unlock the minimum and
maximum data rates to set custom rates for your encoded video.

Note If you’ll be using Adobe Encore or Apple Compressor 3.5 to burn the
encoded H.264 file for Blu-ray, the maximum H.264 level and data rate
accepted by these applications for Blu-ray authoring is H.264 level 4.1 at
35 Mb/s (Encore) and H.264 level 4.1 at 30 Mb/s (Compressor).

— Source video complexity (Variable data rate only) Specifies the

complexity level of your source video. A complex video can be defined as
containing scenes with many colors, sharp edges, or transitions. The
Matrox MAX H.264 codec uses this setting to determine how much
compression is required in order to deliver high-quality video at your
specified target data rate. The default setting (15) is suitable for most
moderately complex videos. For simpler or more complex videos, you
may need to adjust this setting to obtain the highest-quality encoding
possible while respecting your target data rate. If the size of your encoded
video is good but the quality can be improved, lower the complexity level
setting. Your video will then be encoded with less compression. If the
quality of your encoded video is good but the size is larger than expected,
raise the complexity level setting. Your video will then be encoded with
more compression. In any case, you may need to try different settings to
get your desired results.

Sample rate (Variable/Constant data rate only) Determines how
frequently the Matrox MAX H.264 codec verifies the current data rate
while encoding and compares it to your specified target data rate. If a
discrepancy exists between the current and target data rates, the current
data rate is adjusted as specified by the Data rate adjustment option.

Data rate adjustment (Variable/Constant data rate only) When the
current encoding data rate does not match your specified target data rate,
this setting determines how quickly the current data rate is adjusted to
reach the target data rate. A gradual adjustment produces smoother
transitions than a quick adjustment.

Encoding quality (Constant quality only) Specifies the quality level for

your encoded video. Every frame in your video will be encoded at the
specified quality level with no regard to data rate.

For .mov files, select Enable audio under Audio to encode audio along with
your video, and then click Settings to set your QuickTime movie audio
settings.
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Note To export a clip for use with Apple iPod or iPhone devices, you must
choose AAC (advanced audio coding) as your export audio file format. To do
this, in the Sound Settings window, select AAC from the Format list, and
then click Save.

10 Click Save.

Using Apple Final Cut Pro X
When working in Final Cut Pro X, you can send your clip to Apple Compressor
and then use the Matrox MAX H.264 Compressor settings to export H.264 files
for Blu-ray, the web, and other mobile devices. For detailed information on Final
Cut Pro X- or Compressor-related subjects, see your application’s
documentation.

Note The Share feature in Final Cut Pro X for encoding using the Matrox
MAX H.264 codec in Compressor is not supported.

The Matrox MAX H.264 Blu-ray settings encode video only. Audio is not
encoded by the Matrox MAX H.264 codec when creating H.264 elementary
streams for Blu-ray. To include audio when exporting to Blu-ray format, you
must assign a separate audio setting to your source media file. However, audio is
encoded by the Matrox MAX H.264 codec when creating QuickTime files for the
web and mobile devices.

Note When selecting a predefined Matrox MAX H.264 setting, any
modifications made to your source video’s frame size in your application must be
taken into consideration. For example, if your source video was cropped in your
application, your source video’s frame size is the cropped frame size and not the
original frame size.

The predefined Matrox MAX H.264 Compressor settings are separated into three
folders: Blu-ray, Fast Encode, and High-Quality:

* Blu-ray Use these settings for all Blu-ray deliverables. The encoded file’s
extension will be .264.

Note For compatibility with most Blu-ray players and Adobe Encore, the
predefined Matrox MAX H.264 settings for Blu-ray use a simple GOP
structure.

* Fast Encode Use these settings for fast encoding of QuickTime files.
These settings leverage your system’s resources with the MXO2 hardware,
resulting in even faster encoding times. The encoded file’s extension will be
.mov.

Note If your source video must be scaled for encoding and its aspect ratio
does not match the compression aspect ratio, with Compressor v3.5 or later,
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you can select Preserve source aspect ratio from the Padding list in
Compressor’s Geometry pane to maintain your source video’s aspect ratio.

* High-Quality Use these settings for high-quality encoding of QuickTime
files. With these settings, the encoding is performed entirely by the MXO2
hardware, which frees your system’s resources for other tasks. The encoded
file’s extension will be .mov.

—> To send a Final Cut Pro X clip to Apple Compressor for export using the
Matrox MAX H.264 settings:

1 In Final Cut Pro X, select the clip or sequence that you want to export.

2 If your system does not include a Matrox CompressHD card, from the
Window menu, disable A/V Output.

3 Choose File > Send to Compressor.

4 Drag the desired Matrox MAX H.264 setting from the Settings window to
your source media file (job) in the Batch window.

Note Matrox MAX technology supports closed caption data from SCC files
for web deliverables (.mov) when encoding at 1:1, or when downscaling. When
an SCC (CEA-608) closed caption file is associated with your source media
file in Compressor, Matrox MAX technology embeds the closed caption data
in the encoded video file (.mov).

5 If you’re exporting to Blu-ray format and you want to export audio as well,
you must add a separate audio setting to your Batch window. Matrox
provides predefined audio settings for each of the Matrox settings, however,
you can choose to use another audio setting.

6 Choose a destination for your job’s targets and submit your batch as you
would normally.

Using Adobe Premiere Pro or Media Encoder

This section details how to specify the Matrox MAX H.264 compression settings
in Adobe Premiere Pro and Media Encoder for delivering QuickTime files for the
web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based
devices. The encoded file’s extension will be .mov.

The Matrox MAX H.264 component for Premiere Pro and Media Encoder
includes predefined Matrox MAX H.264 presets that you can use to immediately
apply appropriate compression settings for delivering H.264 files. For most
deliverables, you can use one of the predefined Matrox MAX H.264 presets (see
“Assigning a Matrox MAX H.264 preset” on page 139). However, if you require
a custom setting, see “Creating a custom Matrox MAX H.264 preset” on

page 139.
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Assigning a Matrox MAX H.264 preset

This section describes how to assign a Matrox MAX H.264 preset to your source
file in Premiere Pro and Media Encoder for delivering QuickTime files for the
web, and for use with Apple TV, iPad, iPod, iPhone, and other QuickTime-based
devices. The Matrox MAX H.264 presets include the predefined presets installed
with your MXO?2 software, and any custom presets that you create (see “Creating
a custom Matrox MAX H.264 preset” on page 139).

Note When selecting a predefined Matrox MAX H.264 preset, any
modifications made to your source video’s frame size in your application must be
taken into consideration. For example, if your source video was cropped in your
application, your source video’s frame size is the cropped frame size and not the
original frame size.

1 Start Adobe Premiere Pro and open a project, or start Adobe Media Encoder
and add the source clip or sequence to the queue.

Note Whenencoding using the Matrox MAX H.264 codec in Adobe Media
Encoder, the Matrox MAX H.264 codec does not support batch encoding the
same item (job) in the queue to more than one Matrox MAX H.264 setting.
To export your file/sequence to more than one Matrox MAX H.264 setting,

you must add a separate item to the queue for each Matrox MAX H.264 setting.

2 If you’re working with Premiere Pro, choose File > Export > Media. If
you’re working with Media Encoder, in the Queue panel, right-click the clip
or sequence that you want to export, and then click Export Settings.

3 In the Export Settings dialog, under Export Settings, select QuickTime
from the Format list, and then select the desired Matrox MAX preset from
the Preset list.

4 Export the file as you would normally.

Creating a custom Matrox MAX H.264 preset
You can create a custom Matrox MAX H.264 preset in Adobe Premiere Pro and
Media Encoder for delivering QuickTime files for the web, and for use with
Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. Once you
create a new Matrox MAX H.264 preset, you can assign it to your source file in
Premiere Pro and Media Encoder using the steps described in “Assigning a
Matrox MAX H.264 preset” on page 139.

1 Start Adobe Premiere Pro and open a project, or start Adobe Media Encoder
and add the source clip or sequence to the queue.
Note Whenencoding using the Matrox MAX H.264 codec in Adobe Media
Encoder, the Matrox MAX H.264 codec does not support batch encoding the
same item (job) in the queue to more than one Matrox MAX H.264 setting.

139

Using Adobe Premiere Pro or Media Encoder



140

To export your file/sequence to more than one Matrox MAX H.264 setting,
you must add a separate item to the queue for each Matrox MAX H.264 setting.
If you’re working with Premiere Pro, choose File > Export > Media. If
you’re working with Media Encoder, in the Queue panel, right-click the clip
or sequence that you want to export, and then click Export Settings.

In the Export Settings dialog, under Export Settings, select QuickTime
from the Format list.

Tip You can use an existing Matrox MAX preset as a starting point for
your new preset by selecting the desired preset from the Preset list before
specifying your export settings.

In the Video pane, under Video Codec, select Matrox MAX H.264 from
the Video Codec list, and then click Codec Settings.

In the Matrox MAX H.264 Codec Settings dialog, set the following
options:

) O C Matrox MAX H.264 Codec Settings

Algorithm: CABAC
®) CAVLC

De-interlace video:

H.264 level: | 3.0 =

A

Noise filter level: | None -

Cancel [ oK |

— Select the entropy coding Algorithm to be used during compression:

+ CABAC Uses the CABAC coding method, and defines the video
stream as H.264 Main profile.

+ CAVLC Uses the CAVLC coding method, and defines the video
stream as H.264 Main profile when Frame Reordering (under
Advanced Settings) is selected. Otherwise, the video stream is
defined as H.264 Baseline profile. This method is not supported when
encoding to a frame size that has a width greater than 720. In this case,
CABAC will always be used for encoding.

— De-interlace video Select this option if your source video is interlaced
and you want to de-interlace your video before encoding. This option can
be used to display your encoded video on a monitor that displays lines
progressively, such as an LCD or computer monitor. For all other
instances, make sure this option is not selected.
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— Select the H.264 level that you want to be used to encode your video.

Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)
2.0 352x288 29.97 2
3.0 720x576 29.97 10
3.1 1280x720 29.97 14
4.0 1920x 1080 29.97 20
4.1 1920%x 1080 29.97 50
4.2 1920x 1080 59.94 50

— Select the Noise filter level that will be applied to your video before
encoding. Increasing the noise filter level reduces the amount of high
frequencies in your source video by softening the high-detail portions of
your video. Since high frequencies require more bits to encode, increasing
the noise filter level leaves more bits available for the encoding of other
frames, which can improve the overall quality of your encoded video.
However, if you lose too much detail in your encoded video you may need
to decrease the noise filter level.

Click OK to save and close the Matrox MAX H.264 Codec Settings

dialog.

In the Export Settings dialog, in the Video pane, under Bitrate Settings,

enable the Limit data rate to option and enter a value if you’re using the

CAVLC entropy coding algorithm (see step 5). If using CABAC, you can

enable or disable this option.

For optimal results when encoding using the Matrox MAX H.264 codec, in
the Video pane, under Basic Video Settings, select Progressive from the
Field Order list.

Specify any other export settings as desired. For detailed information on
Media Encoder settings, see your Media Encoder documentation.

Note To export a clip for use with Apple iPad, iPod or iPhone devices, you
must select AAC as the Audio Codec.

In the Export Settings dialog, under Export Settings, click the Save
Preset button next to the Preset list.

Type a descriptive name for your preset, and then click OK.

Export the file as you would normally.
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Using Telestream Episode

This section details how to specify Matrox MAX H.264 compression settings in
Telestream Episode for delivering QuickTime files for the web, and for use with
Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. The encoded
file’s extension will be .mov.

1 Start Telestream Episode, drag the source file that you want to encode, and
an encoder preset, to the Workflow Panel.

2 Click the encoder preset in the Workflow Panel, and then in the Inspector
Panel, type a descriptive name in the Task Name text box.

3 In the Inspector Panel, under Format, select MOV for the Container, and
QuickTime for the Video Codec. The Compression Settings window
appears. If not, highlight Video Codec, and then click Options.

Compression Settings

Compression type: Matrox MAX H.264
Motion
Frames per second: 29.97
lzT Key frame every 24 frames Frame reordering
Limit data rate to kbits/sec Optimized for Download

Encoding Mode

Multi-pass Single-pass

Compressor

Quality

;
Least Low Medium Best

Algorithm: (s) CABAC
CAVLC

De-interlace video:
H.264 level: | 4.1

Noise filter level: | Low

? Cancel | | OK |

4 In the Compression Settings dialog, select Matrox MAX H.264 from the
Compression type menu.

5 Under Motion, select your desired settings as explained in your Telestream
Episode documentation.
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Remarks

— If using the CAVLC entropy coding algorithm (see step 7), you must
enable Limit data rate to and type a value. If using CABAC, you can
enable or disable this option.

— The Limit data rate to option applies to the video portion of your
encoded file only. When factoring in the encoded audio, the overall data
rate for your encoded file may exceed the specified data rate limit. To
minimize the impact of the audio on the overall data rate, select AAC or
AAC QuickTime as the Audio Codec in the Inspector Panel.

Under Compressor, set the Quality level for your encoded video. Your
desired quality is delivered on each frame at the lowest data rate possible,
depending on the complexity of the video.

Select the entropy coding Algorithm to be used during compression:

— CABAC Uses the CABAC coding method, and defines the video stream
as H.264 Main profile.

— CAVLC Uses the CAVLC coding method, and defines the video stream
as H.264 Main profile when Frame Reordering is selected. Otherwise,
the video stream is defined as H.264 Baseline profile.

Note CAVLC is not supported when encoding to a frame size that has a

width greater than 720. In this case, CABAC will always be used for encoding.

If your source video is interlaced and you want to de-interlace your video
before encoding, select De-interlace video. This option can be used to
display your encoded video on a monitor that displays lines progressively,
such as an LCD or computer monitor. For all other instances, make sure this
option is not selected.

Important If your interlaced video is being scaled, either because you
applied an effect in your project or specified a different frame size for export
(see step 12), don’t use this option. Instead, use the Deinterlace option
under Video Filters in the Inspector Panel to de-interlace your video.

9 Select the H.264 level that you want to be used to encode your video.

Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)
2.0 352x288 29.97 2
3.0 720x576 29.97 10
3.1 1280x720 29.97 14
4.0 1920x 1080 29.97 20
4.1 1920x 1080 29.97 50
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Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)
4.2 1920x 1080 59.94 50

Note Use H.264 level 3.1 to create HD video for use with Apple iPad.

Select the Noise filter level that will be applied to your video before
encoding. Increasing the noise filter level reduces the amount of high
frequencies in your source video by softening the high-detail portions of
your video. Since high frequencies require more bits to encode, increasing
the noise filter level leaves more bits available for the encoding of other
frames, which can improve the overall quality of your encoded video.
However, if you lose too much detail in your encoded video you may need to
decrease the noise filter level.

Click OK.

If you want to scale your source video for export, specify the new frame size
in the Resize option under Video Filters in the Inspector Panel.

Note The minimum frame size is 64 x64, and the maximum frame size
depends on the H.264 level selected in step 9. The horizontal and vertical
values must be even numbers.

Set your desired audio settings. To export a clip for use with Apple iPad,
iPod or iPhone devices, you must select AAC or AAC QuickTime as the
Audio Codec in the Inspector Panel.

Drag a deployment location to the Workflow Panel, and encode the file as
you would normally.
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Using Avid Media Composer or Symphony

This section details how to specify the Matrox MAX H.264 compression settings
in Avid Media Composer and Avid Symphony for delivering QuickTime files for
the web and mobile devices. The encoded file’s extension will be .mov.

1 Open Avid Media Composer/Symphony, and open the project that you want
to export.
2 Choose File > Export.

3 In the Export As dialog, select Untitled from the Export setting list, and
then click Options.

4 In the Export Settings dialog, select QuickTime Movie from the Export
As list.

5 Select Custom, and then click Format Options.
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6 In the Movie Settings dialog, under Video, click Settings.

Movie Settings

™ video
[ Settings... ‘ Compression: Matrox MAX H.264
Quality: Medium
el Key frame rate: 24
| Filter.. | giirate: 6400 kbits/sec
- Frame reordering: yes
\ Size... | Compress using the CAVLC algorythm

IDC level 3.0
Noise filter is disabled

Allow Transcoding

™ sound
| Settings... | Format: AAC
———————————" Sample rate: 44.100 kHz

Channels: Stereo (L R)
Bit rate: 128 kbps

[2] Prepare for Internet Streaming

| Fast Start 3| | Settings

| Cancel | @

7 From the Compression Type menu, select Matrox MAX H.264.

Standard Video Compression Setting:
Compression Type: | Matrox MAX H.264 e
Motion Data Rate
Frame Rate: | Current '33 fps Data Rate: @ Automatic
(O Restrict to kbits/sec
Key Frames: () Automatic )
@ Every 24 frames Optimized for: Download s

0N
oAl

[_] Frame Reordering

Compressor Preview
Quality
) v
Least Low Medium High Best

Algorithm: @) CABAC
(O cavLc
De-interlace video:

H.264 level: | 4.1 |§

Noise filter level: | Low ¥ }
( Cancel)

8 Under Motion and Data Rate, select your desired settings as explained in
your Avid documentation.
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Remarks

— If using the CABAC entropy coding algorithm (see step 10), you can use
either the Automatic or Restrict to data rate option. If using CAVLC,
you must use the Restrict to data rate option.

— The Restrict to data rate option applies to the video portion of your
encoded file only. When factoring in the encoded audio, the overall data
rate for your encoded file may exceed the specified data rate limit. To
minimize the impact of the audio on the overall data rate, select AAC as
the audio format for your encoded file (see step 15).

Under Compressor, if Automatic was sclected as the Data Rate, set the
Quality level for your encoded video. Your video is compressed at the
specified quality setting with no regard to data rate. Your desired quality is
delivered on each frame at the lowest data rate possible, depending on the
complexity of the video.

Select the entropy coding Algorithm to be used during compression:

— CABAC Uses the CABAC coding method, and defines the video stream
as H.264 Main profile.

— CAVLC Uses the CAVLC coding method, and defines the video stream
as H.264 Main profile when Frame Reordering is selected. Otherwise,
the video stream is defined as H.264 Baseline profile.

Note CAVLC is not supported when encoding to a frame size that has a
width greater than 720. In this case, CABAC will always be used for encoding.

If your source video is interlaced and you want to de-interlace your video
before encoding, select De-interlace video. This option can be used to
display your encoded video on a monitor that displays lines progressively,
such as an LCD or computer monitor. For all other instances, make sure this
option is not selected.

Important If your interlaced video is being scaled, either because you
applied an effect in your project or specified a different compression frame
size, don’t use this option. Instead, use the Deinterlace Source Video
option in the Export Size Setup window to de-interlace your video. You’ll
be able to do this when specifying the frame size for your encoded video in
step 16.

12 Select the H.264 level that you want to be used to encode your video.

Using Avid Media Composer or Symphony

Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)
2.0 352%288 29.97 2
3.0 720x576 29.97 10
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Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)
3.1 1280x720 29.97 14
4.0 1920x 1080 29.97 20
4.1 1920x 1080 29.97 50
4.2 1920x 1080 59.94 50

Note Use H.264 level 3.1 to create HD video for use with Apple iPad.

13 Select the Noise filter level that will be applied to your video before
encoding. Increasing the noise filter level reduces the amount of high
frequencies in your source video by softening the high-detail portions of
your video. Since high frequencies require more bits to encode, increasing
the noise filter level leaves more bits available for the encoding of other
frames, which can improve the overall quality of your encoded video.
However, if you lose too much detail in your encoded video you may need to

decrease the noise filter level.

14 Click OK.

15 In the Movie Settings dialog, under Sound, click Settings to specify your

audio settings, and then click OK.

Remarks

— When limiting the data rate of your encoded file to a specified bit rate (see
step 8), please note that the encoded audio may cause the overall data rate
to exceed the data rate limit. To minimize the impact of the encoded audio
on the overall data rate, select AAC as the audio format for your encoded
file. To do this, in the Sound Settings window, select AAC from the

Format list.

— To export a clip for use with Apple iPod or iPhone devices, you must
choose AAC (advanced audio coding) as your export audio file format. To
do this, in the Sound Settings window, select AAC from the Format

list.

16 In the Movie Settings dialog, click Size and select the frame size that you

want for your encoded video from the Dimensions menu.

Note The minimum frame size is 64 x 64, and the maximum frame size
depends on the H.264 level selected in step 12. The horizontal and vertical

values must be even numbers.

17 Once all settings are specified, click OK in the Movie Settings window.
18 Click Save in the Export Settings dialog, and then click Save in the

Export As window to encode your video.

Chapter 10, Using the Matrox MAX H.264 Codec




149

Using Apple QuickTime Pro, and other

QuickTime-based applications

This section details how to specify Matrox MAX H.264 compression settings in
QuickTime Pro v7.6.x for delivering QuickTime files for the web, and for use
with Apple TV, iPad, iPod, iPhone, and other QuickTime-based devices. The
encoded file’s extension will be .mov. The settings described in this section are
the same when exporting to QuickTime from other QuickTime-based video
applications. For details on how to export to QuickTime from another
QuickTime-based application, see your application’s documentation.

1 Start QuickTime Pro, and open the video file that you want to export.
2 Choose File > Export.

3 In the Save exported file as window, click Options.

4 In the Movie Settings dialog, under Video, click Settings.

Standard Video Compression Settings

Compression Type: | Matrox MAX H.264 ?

Motion Data Rate

Frame Rate: | Current 18] fps Data Rate: @) Automatic
) Restrict to kbits/sec
Key Frames: () Automatic
@ Every 24 frames Optimized for: Dow
OAll

Frame Reordering

Compressor Preview
Quality

" 4
Least Low Medium High Best

Algorithm: @) CABAC
) CAVLC

De-interlace video:

H.264 level: (4.1 [3)
Noise filter level: | Low B

&) Cancel )  OK )

5 From the Compression Type menu, select Matrox MAX H.264.
6 Under Motion and Data Rate, select your desired settings as explained in
your application’s documentation.
Remarks
— If using the CABAC entropy coding algorithm (see step 8), you can use
either the Automatic or Restrict to data rate option. If using CAVLC,
you must use the Restrict to data rate option.
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— The Restrict to data rate option applies to the video portion of your
encoded file only. When factoring in the encoded audio, the overall data
rate for your encoded file may exceed the specified data rate limit. To
minimize the impact of the audio on the overall data rate, select AAC as
the audio format for your encoded file (see step 13).

Under Compressor, set the Quality level for your encoded video. Your
desired quality is delivered on each frame at the lowest data rate possible,
depending on the complexity of the video.

Select the entropy coding Algorithm to be used during compression:

— CABAC Uses the CABAC coding method, and defines the video stream
as H.264 Main profile.

— CAVLC Uses the CAVLC coding method, and defines the video stream
as H.264 Main profile when Frame Reordering is selected. Otherwise,
the video stream is defined as H.264 Baseline profile.

Note CAVLC is not supported when encoding to a frame size that has a
width greater than 720. In this case, CABAC will always be used for encoding.

If your source video is interlaced and you want to de-interlace your video
before encoding, select De-interlace video. This option can be used to
display your encoded video on a monitor that displays lines progressively,
such as an LCD or computer monitor. For all other instances, make sure this
option is not selected.

Important If your interlaced video is being scaled, either because you
applied an effect in your project or specified a different compression frame
size, don’t use this option. Instead, use the Deinterlace Source Video
option in the Export Size Setup window to de-interlace your video. You’ll
be able to do this when specifying the frame size for your encoded video in
step 14.

10 Select the H.264 level that you want to be used to encode your video.

Maximum Maximum Maximum
H.264 level Frame size Frame rate Data rate
(fps) (Mb/s)
2.0 352x288 29.97 2
3.0 720x576 29.97 10
3.1 1280x720 29.97 14
4.0 1920x 1080 29.97 20
4.1 1920%x 1080 29.97 50
4.2 1920x 1080 59.94 50
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Note Use H.264 level 3.1 to create HD video for use with Apple iPad.

Select the Noise filter level that will be applied to your video before
encoding. Increasing the noise filter level reduces the amount of high
frequencies in your source video by softening the high-detail portions of
your video. Since high frequencies require more bits to encode, increasing
the noise filter level leaves more bits available for the encoding of other
frames, which can improve the overall quality of your encoded video.
However, if you lose too much detail in your encoded video you may need to
decrease the noise filter level.

Click OK.

In the Movie Settings dialog, under Sound, click Settings to specify your
audio settings, and then click OK.

Remarks

— When limiting the data rate of your encoded file to a specified bit rate (see
step 6), please note that the encoded audio may cause the overall data rate
to exceed the data rate limit. To minimize the impact of the encoded audio
on the overall data rate, select AAC as the audio format for your encoded
file. To do this, in the Sound Settings window, select AAC from the
Format list.

— To export a clip for use with Apple iPad, iPod or iPhone devices, you must
choose AAC (advanced audio coding) as your export audio file format. To
do this, in the Sound Settings window, select AAC from the Format
list.

In the Movie Settings dialog, click Size and select the frame size that you
want for your encoded video from the Dimensions menu.

Note The minimum frame size is 64 x64, and the maximum frame size
depends on the H.264 level selected in step 10. The horizontal and vertical
values must be even numbers.

Once all settings are specified, click OK, and then Save in the Save
exported file as window to encode your video.

Using Apple QuickTime Pro, and other QuickTime-based applications
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Chapter 10, Using the Matrox MAX H.264 Codec



Understanding Pulldown

This appendix describes MXO2
pulldown.
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Overview

Depending on your project’s video output format, you may choose to apply a
pulldown to convert 23.98 fps video to 29.97 fps or 59.94 fps video for output on
MXO2 (see Appendix D, “Matrox MXO2 Supported Output Formats”). If you
choose to enable Pulldown in the Video Output pane of the Matrox preferences
window (see Chapter 7, “Configuring Your MXO2 System”), Matrox uses the
standard pulldown method to convert 23.98 fps to 29.97 fps or 59.94 fps video.

Standard pulldown

Standard pulldown is often used as part of the telecine process to transfer 24 fps
film footage to 29.97 fps interlaced video. This pulldown method is also used to
convert any 23.98 fps progressive video to 29.97 fps interlaced video, such as for
converting 486p @ 23.98 fps video to NTSC.

In order to convert 24 fps film or 23.98 progressive video to 29.97 fps interlaced
video, additional video frames, and more specifically video fields, must be
created and added to the video sequence. For example, to convert a sequence of
four film or progressive frames, five frames of video are needed for a total of 10
video fields. Therefore, one additional video frame or two video fields must be
created. To accomplish this, the first and third frames of a four-frame film or
progressive video sequence are each converted to two video fields. The second
and fourth frames of the sequence are converted to three video fields to make up
a total of five interlaced video frames.

The following diagram demonstrates the process:

Film frames @ 24 fps or progressive frames @ 23.98 fps

A B C D

Video fields @ 29.97 fps

al a2 b1 b2 b3 cl c2 d1 d2 d3

I | I | I |
| | |
Frame A Frame B Frame C Frame D Frame E
Standard pulldown is accomplished by representing the first frame of film or

progressive video (frame A) as two fields of video (fields al and a2), the second
frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame

Appendix A, Understanding Pulldown
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(frame C) as two fields (fields c1 and c2), and the fourth frame (frame D) as three
fields (fields d1, d2, and d3). This sequence repeats six times each second.

Standard pulldown
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Your notes

Appendix A, Understanding Pulldown



Matrox MX0O2 Connectors

This appendix describes the
inputs and outputs for MXO2,
MXO2 Rack, MXO2 LE, and
MXO2 Mini.
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Inputs

The following sections detail the MX02, MXO02 Rack, MXO2 LE, and MXO02

Mini inputs.

MXO2 inputs

Appendix B, Matrox MX0O2 Connectors
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MXO2 LE inputs

Component
Analog audio video
(unbalanced) (HD/SD) External
L(CH 1) reference

P Y ReR

Matrox MXO2 LE

natrox MXO2 LE
HDMI

INPUT

' HDMI Y{C Composite
Analog suti (HD/SD) (SVideo) video
(unbalanced)
Component SDI
— video (HD/SD)
CH 1A \ CH2 (HDP/SD)
nalog r
audio
(balanced)

Appendix B, Matrox MX0O2 Connectors



MXO2 Mini inputs

Composite
video (CVBS)
Y

S-Video
(see “Connecting
S-Video devices to

MXO2 Mini” on
page 47)
Pb Pr
v) )
Power
(see “Powering
MXO02 Mini” on
page 42)
HDMI Analog audio
(HD only) Component video (unbalanced)
(HD/SD) L R Host

(CH 1) (CH 2) (see “Connecting

MXO2 Mini to your
computer” on
B T

@ e S

Matrox MX02 Mini

1
N
P
u
T
o
HDMI IN U
T
P
]
T
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Inputs
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Input connector descriptions

This section describes the Matrox MX02, MXO02 Rack, and MXO2 LE inputs.
For MXO2 Mini inputs, see “Input connector descriptions (MXO2 Mini)” on
page 164.

You can select the video and audio inputs to be used as your capture source in the
MXO?2 preferences window (see “Specifying your A/V input settings” on

page 55). For a list of the supported input and capture formats, see Appendix C,
“Matrox MXO2 Supported Input and Capture Formats.”

Note Depending on your MXO2 hardware, some of the following connectors
may not be available or may be available in a limited capacity only. Some
connectors on your MXO2 hardware may not appear exactly as shown below.

External reference (REF) Allows you to genlock all devices
connected to your MXO2 system to an external genlock source
— (bi-level analog black burst for SD, or analog tri-level sync for
MXO2and  gp) MXO02 Rack features an additional REF OUT connector
MXO2LE)  ith loop through that allows you to daisy chain the genlock
reference input to another device’s reference input.

@ Important If you connected an external genlock

— = source to MXO2 Rack’s REF IN connector, and you’re
(MXO2 Rack) not using the REF OUT connector, you must terminate
the reference signal by connecting a BNC 75-ohm
terminator to REF OUT.

To compensate for cable delays, timing-offset controls that
align your video output relative to your external genlock source
are available (see “Specifying your genlock settings” on

page 54).

HDMI Provides an input for HD HDMI video (either YUV
or RGB), and up to eight channels of uncompressed embedded
audio, from a digital HDMI device. HDCP sources and SD
video are not supported on this input. Connect a standard
HDMI video/audio cable from a camera, VTR, or other video
input source.

HDMI

Appendix B, Matrox MX0O2 Connectors
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SDI Provides an input for use with a digital SDI device. This
input supports HD-SDI and SD-SDI video, and up to 16
channels of embedded audio. You can also use this input to
capture closed captioning and AFD data (see “Matrox 4VANC
capture and playback” on page 66). Connect an SDI
video/audio cable from a camera, VTR, or other video input
source.

Component video (Y, Pb, Pr) Provide inputs for use with an
analog component device, and support HD and SD video.
Connect component Y, Pb, Pr video cables from a camera,
VTR, or other video input source.

-ZmZ0v=00:

vic Y/C (S-Video) Provides an input for use with an analog
. S-Video device (SD only). Connect an S-Video cable from a
camera, VTR, or other video input source.

Composite video (CVBS) Allows you to input SD video
from an analog NTSC or PAL device. Connect a composite
cvBs video cable from a camera, VTR, or other video input source.

AES/EBU digital audio Allows you to input stereo digital

AES/EBU
<> audio. Connect a coaxial BNC audio cable from a camera,
VTR, audio mixer, or other audio input source.
Note Not available on MXO2 LE.

L) Analog audio (unbalanced) Allows you to input unbalanced
@ stereo analog audio. Connect RCA cables from a camera, VTR,
audio mixer, or other audio input source.

R(2)

Analog audio (balanced) Allows you to input balanced
stereo analog audio. Connect XLR cables from a camera, VTR,
audio mixer, or other audio input source.

Inputs
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Input connector descriptions (MXO2 Mini)
This section describes the Matrox MXO2 Mini inputs. For other MXO2 products,
see “Input connector descriptions” on page 162.

You can select the video and audio inputs to be used as your capture source in the
MXO2 Mini preferences window (see “Specifying your video output settings” on
page 58). For a list of the supported input and capture formats, see Appendix C,
“Matrox MXO2 Supported Input and Capture Formats.”

Note Analog A/V cables connected to Matrox MXO2 Mini must be limited to

less than three meters to comply with EEC and EMC directives.

HDMI IN

OFORO)!

Y Pb

RO

Pb Pr

0 O

HDMI Provides an input for HD HDMI video (either YUV
or RGB), and up to eight channels of uncompressed embedded
audio, from a digital HDMI device. HDCP sources and SD
video are not supported on this input. Connect a standard
HDMI video/audio cable from a camera, VTR, or other video
input source.

Component video (Y, Pb, Pr) Provide inputs for use with an
analog component device, and support HD and SD video.
Connect component Y, Pb, Pr video cables from a camera,
VTR, or other video input source.

Note When you connect an analog component device
to MXO2 Mini, you won’t be able to connect an
S-Video or composite device at the same time.

S-Video Input connectors Pb and Pr allow you to connect the
MXO?2 S-Video adapter cable for use with an analog S-Video
device (SD only). Connect an S-Video cable, via the MXO2
S-Video adapter cable, from a camera, VIR, or other video
input source. For an illustration on how to connect S-Video
devices to MXO2 Mini, see “Connecting S-Video devices to
MXO2 Mini” on page 47.

Composite video (Y) Allows you to input SD video from an
analog NTSC or PAL device. Connect a composite video cable
from a camera, VTR, or other video input source.

Analog audio (unbalanced) Allows you to input unbalanced
stereo analog audio. Connect RCA cables from a camera, VTR,
audio mixer, or other audio input source.

Appendix B, Matrox MX0O2 Connectors
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The following sections detail the MXO02, MXO2 Rack, MXO2 LE, and MX0O2

Mini outputs.

Outputs

MXO2 outputs
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MXO2 Rack outputs
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MXO2 LE outputs

Component
video Analog audio
(HD/SD) (unbalanced)

SDIB

(HD/SD) Y Pb LieH

Matrox MXO2 LE

Composite Y/C HDMI
i i R(CH 2

video ($Video) (4p/sD) AnaISJg au)dio

(unbalanced)

SDIA Component
(HD/SD) video -
(HD/SD) CH 1Ana|ogCH 2
Pr
audio
(balanced)

Outputs
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MXO2 Mini outputs

Matrox MX02 Mini

1
"
P
u
T
o
HDMI IN U HDMI OUT
: Q =
T
% Host
(see “Connecting
% MXO2 Mini to
Pb your computer”
Component video (CH1) (CH2) on page 44)
(HD/SD) Analog audio HDMI
(unbalanced) (HD/SD)
Power
(see “Powering
MXO2 Mini” on
page 42)
) (C)
S-Video
(see “Connecting
S-Video devices to
MXO02 Mini” on
page 47)
Composite
video (CVBS)
Y
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Output connector descriptions

This section describes the Matrox MX02, MXO2 Rack, and MXO2 LE outputs.
For MXO2 Mini outputs, see “Output connector descriptions (MXO2 Mini)” on
page 171.

HD to SD downscaling, SD to HD upscaling, and cross conversion are supported
on all video outputs simultaneously. To select your video output settings, see
“Specifying your video output settings” on page 58. You can also map any audio
track in your video application to any MXO2 audio output (see “Specifying your
audio output settings” on page 62). For a list of the video formats that you can
output from the MXO2 outputs, see “Video formats supported on MXO2
outputs” on page 184.

Note Depending on your MXO2 hardware, some of the following connectors
may not be available or may be available in a limited capacity only. Some
connectors on your MXO2 hardware may not appear exactly as shown below.

HDMI Provides an output for HD/SD HDMI video, and up to
eight channels of embedded audio, to a digital HDMI device.
HDCP is not supported on this output. This output supports 1:1
pixel mapping for accurate monitoring on your HDMI display
of NTSC, PAL, 1280720, and 1920x 1080 video. Connect a
standard HDMI video/audio cable to an HDMI monitor, VTR,
or other digital HDMI device. You can also connect directly to a
home theatre system for surround sound monitoring.

Note The HDMI output supports YUV and RGB
devices. To set the HDMI output type, see “Specifying
your video output settings” on page 58.

HDMI

HDMI monitor calibration is available through this output. Use
the Matrox HDMI Calibration Utility to calibrate your HDMI
monitor (see Chapter 8, “Calibrating Your HDMI Monitor for
Video”).

169

Outputs
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SDI A and SDI B  Provide two simultaneous outputs of the
same HD-SDI or SD-SDI video, with up to 16 channels of
embedded audio. You can also output closed captioning and
AFD data using the SDI outputs (see “Matrox 4VANC capture
and playback” on page 66). For each output, connect an SDI
video/audio cable to a video monitor, VIR, or other SDI
device. You can also perform surround sound monitoring
through the SDI output by connecting to a third-party device,
such as an SDI audio de-embedder.

—] Component video (Y, Pb, Pr) Allows you to output HD or
SD video to an analog component device. Connect component
Y, Pb, Pr video cables to a video monitor, VTR, or other
component device.

—ZmZ0Tv=00!

Note The component output supports YUV and RGB
devices. To set the component output type, see
“Specifying your video output settings” on page 58.

Yic Y/C (S-Video) Provides an output for SD video to an analog
. S-Video device. Connect an S-Video cable to a video monitor,
VTR, or other S-Video device.

Composite video (CVBS) Allows you to output SD video to
an analog NTSC or PAL device. Connect a composite video
cable to a video monitor, VTR, or other NTSC or PAL device.

AES/EBU AES/EBU digital audio Allows you to output stereo digital
<> audio. Connect a coaxial BNC audio cable to a VTR, audio
mixer, speakers, or other audio device.

Note Not available on MXO2 LE.

Analog audio (balanced) Allows you to output
balanced stereo analog audio. Connect XLR
cables to a VTR, audio mixer, speakers, or other

audio device.

Appendix B, Matrox MX0O2 Connectors



171

L ¢@ is@) Analog audio (unbalanced) Provide outputs for unbalanced
@ @ @ analog audio. Matrox MXO?2 offers outputs for channels one to
six, or three stereo pairs suitable for 5.1 surround sound

monitoring. Connect RCA cables to a VTR, audio mixer,

R@ LFE4) Rs@) speakers, or other audio device.

Output connector descriptions (MXO2 Mini)
This section describes the Matrox MXO2 Mini outputs. For other MXO2
products, see “Output connector descriptions” on page 169.

HD to SD downscaling, SD to HD upscaling, and cross conversion are supported
on all video outputs simultaneously. To select your video output settings, see
“Specifying your video output settings” on page 58. You can also map any audio
track in your video application to any MXO2 Mini audio output (see “Specifying
your audio output settings” on page 62). For a list of the video formats that you
can output from the MXO2 Mini outputs, see “Video formats supported on
MXO?2 outputs” on page 184.

Note Analog A/V cables connected to Matrox MXO2 Mini must be limited to
less than three meters to comply with EEC and EMC directives.

HDMI Provides an output for HD/SD HDMI video, and up to
eight channels of embedded audio, to a digital HDMI device.
HDCP is not supported on this output. This output supports 1:1
pixel mapping for accurate monitoring on your HDMI display
of NTSC, PAL, 1280x% 720, and 1920x 1080 video. Connect a
standard HDMI video/audio cable to an HDMI monitor, VTR,
or other digital HDMI device. You can also connect directly to a
home theatre system for surround sound monitoring.

Note The HDMI output supports YUV and RGB
devices.

HDMI OUT

HDMI monitor calibration is available through this output. Use
the Matrox HDMI Calibration Utility to calibrate your HDMI
monitor (see Chapter 8, “Calibrating Your HDMI Monitor for
Video”).

Outputs
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ORORO)

Y Pb Pr

RO

Pb Pr

Component video (Y, Pb, Pr) Allows you to output HD or
SD video to an analog component device. Connect component
Y, Pb, Pr video cables to a video monitor, VTR, or other
component device.

Note The component output supports YUV devices
only. When you connect an analog component device to
MXO2 Mini, you won’t be able to connect an S-Video
or composite device at the same time.

S-Video Output connectors Pb and Pr allow you to connect
the MXO2 S-Video adapter cable for outputting SD video to an
analog S-Video device. Connect an S-Video cable, via the
MXO2 S-Video adapter cable, to a video monitor, VTR, or
other S-Video device. For instructions on how to connect
S-Video devices to MXO2 Mini, see “Connecting S-Video
devices to MXO2 Mini” on page 47.

Composite video (Y) Allows you to output SD video to an
analog NTSC or PAL device. Connect a composite video cable
to a video monitor, VTR, or other NTSC or PAL device.

Analog audio (unbalanced) Provide outputs for unbalanced
analog audio channels one and two, or one stereo pair. Connect
RCA cables to a VTR, audio mixer, speakers, or other audio
device.

Appendix B, Matrox MX0O2 Connectors



Matrox MX0O2 Supported Input and
Capture Formats

This appendix provides
information on the video input
and capture formats that are
supported on all MXO2
products.
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Supported input formats

The following tables list the video formats that are supported on the various
MXO?2 inputs.

For descriptions of the inputs, see “Inputs” on page 158, and for a list of the
supported capture formats, see “Supported capture formats” on page 176.

Matrox MX02, MX02 Rack, and MX0O2 LE

Matrox MX02 input

Source video HDMI Component| S-Video |Composite
format (Y, Pb, Pr) (Y/C) (CVBS)

%)
=)

NTSC —

PAL —

NTSC 16:9 —

NERA
NASANAN

PAL 16:9

720p at 50 fps

720p at 59.94 fps

1080i at 25 fps

ASRSASANE

1080i at 29.97 fps

1080PsF at 23.98 fps

1080PsF at 25 fps

ANANENENENA YA SNENE NENEN
\
\

1080PsF at 29.97 fps

1080p at 23.98 fps

1080p at 24 fps

1080p at 25 fps

1080p at 29.97 fps

SISININSININSISNIN NSNS SIS

ANENE N NENENEN

1080p at 30 fps

Appendix C, Matrox MXO2 Supported Input and Capture Formats



Matrox MX02 Mini

Matrox MX0O2 Mini input

Source video
format

HDMI

Component
(Y, Pb, Pr)

S-Video
(Pb, Pr)

Composite
(Y)

NTSC

PAL

NTSC 16:9

PAL 16:9

AR

NSNS

720p at 50 fps

720p at 59.94 fps

1080i at 25 fps

1080i at 29.97 fps

NSNS

1080PsF at 23.98 fps

1080PsF at 25 fps

1080PsF at 29.97 fps

SNISISINN NN NN SIS

1080p at 23.98 fps

1080p at 24 fps

1080p at 25 fps

1080p at 29.97 fps

1080p at 30 fps

ANENANENENA YR

175

Supported input formats



176

Supported capture formats

The following table lists the capture formats that are supported on MXO2 based
on the format of your source video. If the format to which you want to capture
does not match the format of your source video, you must enable scaling on the
input. For a list of the video formats that are supported on the Matrox MXO2
inputs, see “Supported input formats” on page 174.

Avid Media Composer/Symphony

Supported capture format (project video format)

Source
video
format

23.976p
NTSC

30i
NTSC

25p
PAL

25i PAL

720p/
23.976

720p/
25

720p/
50

720p/
59.94

1080p/
23.976

1080p/
24

1080p/
25

1080p/
29.97

1080i/
50
(25 fps)

1080i/
59.94
(29.97 fps)

NTSC

v

/l

/l

/l

/l

PAL

/1

NTSC
16:9

/l

‘/]

‘/]

‘/l

PAL 16:9

720p at
50 fps

‘/l

/1

720p at
59.94 fps

‘/1

/1

‘/]

1080i at
25 fps

/l

/]

1080i at
29.97 fps

/1

/1

/l

1080PsF at
23.98 fps

/l

1080PsF at
25 fps

1080PsF at
29.97 fps

1080p at
23.98 fps

1080p at
24 fps

1080p at
25 fps

/l

/1

/l

/l

v

v

1080p at
29.97 fps

/1

/1

/l

v

! You must enable Scale input for capture in the Matrox Utilities preferences window (see “Specifying your A/V input
settings” on page 23).
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Adobe Premiere Pro
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Supported capture format

Source
video
format

NTSC

NTSC
16:9

PAL

PAL
16:9

720p
23.98

720p
25

720p
29.97

720p
50

720p
59.94

1080p
23.98

1080p
24

1080p
25

1080p
29.97

1080p
30

1080i
25

1080i
29.97

NTSC

PAL

NTSC 16:9

PAL 16:9

720p at
50 fps

720p at
59.94 fps

10801 at
25 fps

1080i at
29.97 fps

1080PsF at
23.98 fps

1080PsF at
25 fps

1080PsF at
29.97 fps

1080p at
23.98 fps

1080p at
24 fps

1080p at
25 fps

1080p at
29.97 fps

‘/l

/1

/]

/l

v

v

1080p at 30
fps

4

! You must enable Scale input for capture in the A/V Input pane of the Matrox Utilities preferences window (see Chapter 7,
“Configuring Your MXO2 System”).

Supported capture formats
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Matrox MX0O2 Supported
Output Formats

This appendix provides
information on the video output
formats that are available on
the MXO2 main and SD
channels, and the video
formats that are supported on
the MXO2 outputs.
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Supported main and SD video output formats

This section lists the video output formats that are available on the MXO2 main
and SD channels based on your project’s video format. You can specify the main

and SD channel settings on the Video Output pane of the Matrox Utilities

preferences window (see Chapter 7, “Configuring Your MXO2 System”).

Apple Final Cut Pro X,
Adobe Premiere Pro, Prelude, and Encore

Project’s Main channel output sSD
fo‘:;i:ﬁ.z Follow | 4 q6,/576p 720p 1080i/PsF 1080p ::ta':::f!,
application p
. 720x4386p at 1280%720p at 1920x1080i at 1920x1080p at
NTSC (720x486i) NTSC 59.94 fps 59.94 fps 29.97 fps 29.97 fps NTSC
NTSC 16:9 ) 720x486p at 1280%720p at 1920%1080i at 1920x1080p at
(720x4861) NTSC 16:9 59.94 fps 59.94 fps 29.97 fps 29.97 fps NTSC
PAL (720 576i) PAL 720x576p at 1280x720p at 50 | 1920x1080i at 25 | 1920x1080p at PAL
50 fps fps fps 25 fps
PAL 16:9 . 720x576p at 1280x720p at 50 | 1920x1080i at 25 | 1920x1080p at
(720x576i) PAL16:9 50 fps fps fps 25tp PAL
DV—NTSC NTSC 720x486p at 1280%720p at 1920%1080i at 1920x1080p at NTSC
(720x4861) 59.94 fps 59.94 fps 29.97 fps 29.97 fps
DV-NTSC 16:9 . 720%x486p at 1280%720p at 1920x1080i at 1920% 1080p at
(720x4861) NTSC 16:9 59.94 fps 59.94 fps 29.97 fps 29.97 fps NTSC
DV-PAL PAL 720x576p at 1280%720p at 50 | 1920x1080i at 25 | 1920x 1080p at PAL
(720%x576i1) 50 fps fps fps 25 fps
DV-PAL 16:9 ) 720x576p at 1280%720p at 50 | 1920x1080i at 25 | 1920x 1080p at
(720x576i) PAL 16:9 50 fps fps fps 25 fps PAL
720x486p at 720x486p at 1280x720p at | 1920x1080PsFat | 1920x1080p at
486p at 23.98 fps 59.94 fps 59.94 fps 59.94 fps 23.98 fps’ 23.98 fps NTSC
486p at 23.98 fps 720x486p at 720x486p at 1280x720p at | 1920x1080PsFat | 1920x1080p at NTSC
16:9 59.94 fps 16:9 59.94 tps 59.94 fps 23.98 fps’ 23.98 fps
4860 at 29.97 fos 720x486p at 720x486p at 1280x720p at | 1920x1080PsFat | 1920x1080p at | 720x486PsF
P 2P 59.94 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps at 29.97 fps
486p at 29.97 fps 720x486p at 720%x486p at 1280%x720p at | 1920x1080PsF at | 1920x1080p at | 720x486PsF
16:9 59.94 fps 16:9 59.94 fps 59.94 fps 29.97 fps 29.97 fps at 29.97 fps
S76p at 25 fos 720x576p at 720x576p at 1280x720p at 50 | 1920x 1080PsF at [ 1920x1080p at | 720x576PsF
P P 50 fps 50 fps fips 25 fps 25 fps at 25 fps
. 720x576p at 720%x576p at 1280%720p at 50 | 1920x 1080PsFat | 1920x1080p at | 720x576PsF
STopat25ips 16:9) 5 1 16:0 50 fps fps 25 fps 25 fps at 25 fps
960x720p at 1280%720p at 720x486p at 1280x720p at | 1920x1080PsFat | 1920x1080p at NTSC
23.98 fps 59.94 fps 59.94 fps 59.94 fps 23.98 fps5 23.98 fps
960x720p at 1280x720p at 50 | 720x576p at 1280x720p at 50 | 1920x1080PsFat | 1920x1080p at | 720x576PsF
25 fps fps 50 fps fps 25 fps 25 fps at 25 fps
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Main channel output

Project’s SD
video Follow . channel
1,2 . 486p/576 720 1080i/PsF 1080 34
format application p/576p p / p output
960x720p at 1280x720p at 720x486p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at | 720x486PsF
29.97 tps 59.94 fps 59.94 fps 59.94 fps 29.97 fps 29.97 tps at 29.97 fps
960x720p at 1280%720p at 50 720x576p at 1280x720p at 50 | 1920x1080i at 25 [ 1920x1080p at PAL
50 fps fps 50 fps fps fps 25 fps
960x720p at 1280x720p at 720x486p at 1280x720p at 1920x 10801 at 1920x1080p at NTSC
59.94 fps 59.94 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps
1280%720p at 1280%720p at 720%x486p at 1280x720p at | 1920x1080PsF at | 1920x1080p at NTSC
23.98 fps 59.94 fps 59.94 fps 59.94 fps 23.98 fps5 23.98 fps
1280x720p at 1280%720p at 50 720x576p at 1280x720p at 50 | 1920x1080PsF at | 1920x1080p at | 720x576PsF
25 fps fps 50 fps fps 25 fps 25 fps at 25 fps
1280x720p at 1280x720p at 720x486p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at | 720x486PsF
29.97 tps 59.94 fps 59.94 tps 59.94 fps 29.97 fps 29.97 tps at 29.97 fps
1280x720p at 1280x720p at 50 720x576p at 1280x720p at 50 | 1920x1080i at 25 | 1920x1080p at PAL
50 fps fps 50 fps fps fps 25 fps
1280x720p at 1280x720p at 720x486p at 1280x720p at 1920%1080i at 1920x1080p at NTSC
59.94 tps 59.94 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps
1280x1080i at 1920%1080i at 720%486p at 1280x720p at 1920x1080i at 1920x1080p at NTSC
29.97 tps 29.97 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps
1440%1080i at 25 | 1920x1080i at 720x576p at 1280x720p at 50 | 1920x1080i at 1920%1080p at PAL
fps 25 fps 50 fps fps 25 fps 25 fps
1440x1080i at 1920%1080i at 720%486p at 1280x720p at 1920%1080i at 1920%1080p at NTSC
29.97 fps 29.97 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps
1920x1080i at 25 | 1920x1080i at 720x576p at 1280x720p at 50 | 1920%1080i at 1920x1080p at PAL
fps 25 fps 50 fps fps 25 fps 25 fps
1920x1080i at 1920x1080i at 720x486p at 1280x720p at 1920%1080i at 1920x1080p at NTSC
29.97 tps 29.97 fps 59.94 fps 59.94 fps 29.97 fps 29.97 tps
1280x 1080p at 1920x1080p at 720x486p at 1280x720p at | 1920x 1080PsF at | 1920x1080p at NTSC
23.98 fps 23.98 fps 59.94 fps 59.94 fps 23.98 fps’ 23.98 fps
1440x1080p at 1920x 1080p at 720x486p at 1280%x720p at | 1920x1080PsF at | 1920x1080p at NTSC
23.98 tps 23.98 fps 59.94 fps 59.94 fps 23.98 fps5 23.98 fps
1440x1080p at 24 | 1920x1080p at . . . 1920%1080p at .
fps 24 fps 24 fps
1440x1080p at 25 | 1920x1080p at 720x576p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at | 720x576PsF
fps 25 fps 50 fps 50 fps 25 fps 25 fps at 25 fps
1440%1080p at 1920x1080p at 720x486p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at | 720x486PsF
29.97 fps 29.97 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps at 29.97 fps
1440x1080p at 30 | 1920x1080p at . o . 1920x1080p at o
fps 30 fps 30 fps
1920x 1080p at 1920x1080p at 720x486p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at NTSC
23.98 fps 23.98 fps 59.94 fps 59.94 fps 23.98 fps’ 23.98 fps

Supported main and SD video output formats
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Project’s Main channel output SD
wdeo1 , Follow . ) chanmaaL
format ’ application 486p/576p 720p 1080|/PSF 1080p output /
1920x 1080p at 24 | 1920 1080p at B — B 1920 1080p at B
fps 24 fps 24 fps
1920x1080p at 25 | 1920x1080p at | 720x576p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at | 720x576PsF
fps 25 fps 50 fps 50 fps 25 fps 25 fps at 25 fps
1920x1080p at | 1920x1080pat | 720x486p at 1280x720p at | 1920x 1080PsFat | 1920x1080p at | 720x486PsF
29.97 fps 29.97 fps 59.94 fps 59.94 fps 29.97 fps 29.97 fps at 29.97 fps
1920x1080p at 30 | 1920x 1080p at B B B 1920 1080p at B
fps 30 fps 30 fps
RED 1K 2:1 at
23.98 fps 1080p at 23.98 fps| 486p at 59.94 fps | 720p at 59.94 fps 1922: };;S??F a 1922()3"91;);;05 a NTSC
(1024x512) 2o 1pS 2o 1pS
RED 1K 16:9 at
23.98 fps 1080p at 23.98 fps| 486p at 59.94 fps | 720p at 59.94 fps 1922; 19(;8;)1:2F a 19220;9180?0:’ a NTSC
(1024x576) 1P 1P
RED 2K 2:1 at
23.98 fps 1080p at 23.98 fps| 486p at 59.94 fps | 720p at 59.94 fps 192(2); 19(;Sf()IZ§F a 1922()3"91;)?05 a NTSC
(2048x1024) 7o 1P 7o 1P
RED 2K 16:9 at
23.98 fps 1080p at 23.98 fps| 486p at 59.94 fps | 720p at 59.94 fps 1923; 19%8;)1:2}‘: a 19220;9180?0:’ a NTSC
(2048x1152) 1P 1P
RED IK 2:1 at
s 1080pat 25 fps | S76pats0fps | 720patsofps | 1920X10OPSFat | 1920x1080pat [ 720xS76PsE
(1024x512) 25 fps 25 fps at 25 fps
RED IK 16:9 at
5 i 1080p at 25 fps | S76pats0fps | 720patsofps | 120X LOSOPSFat | 1920x1080pat [ 720xST6PsE
(1024x576) 25 fps 25 fps at 25 fps
RED 2K 2:1 at
s 1080pat 25 fps | S76pats0fps | 720patsofps | 1920X10OPSFat | 1920x1080pat [ 720xS76PsE
(2048x1024) 25 fps 25 fps at 25 fps
RED 2K 16:9 at
5 1080p at 25 fps | S76pats0fps | 720patsofps | 120X LOSOPSFat | 1920x1080pat [ 720xST6PsE
(2048x1152) 25 fps 25 fps at 25 fps

Lt working with a non-standard video broadcast format, the video is scaled to the closest video broadcast format.

2 Some of the listed video formats may not be available in all the supported applications.
3 The SD channel is not supported and is output as black video when cross-converting your project’s video output between 720p

and 1080p/i/PsF.

4 If your project’s aspect ratio is 16:9, set Aspect ratio formatting to Anamorphic in the Video Output pane of the
Matrox Utilities preferences window to output as 16:9 (see Chapter 7, “Configuring Your MXO2 System”).
5 Enable Pulldown in the Video Output pane of the Matrox Utilities preferences window to output 1080i at 29.97 fps (see
Chapter 7, “Configuring Your MXO2 System”).
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. Main channel output SD
Project’s channel
video format | Follow | 00 76,2 | 799 1080i
. i/PsF 1080 12
application p/576p p / P output
23.976p NTSC NTSC 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC
23'97165.;\”8(1 NTSC 16:9 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC
24p NTSC NTSC 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC
24p NTSC 16:9 NTSC 16:9 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC
30i NTSC NTSC 486p at 59.94 fps | 720p at 59.94 fps | 10801 at 29.97 fps | 1080p at 29.97 fps NTSC
30i NTSC 16:9 NTSC 16:9 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC
24p PAL PAL 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
24p PAL 16:9 PAL 16:9 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
25p PAL PAL 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
25p PAL 16:9 PAL 16:9 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
251 PAL PAL 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
251 PAL 16:9 PAL 16:9 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
1080PsF at
720p/23.976 720p at 59.94 fps | 486p at 59.94 fps | 720p at 59.94 fps 23.98 fps’ 1080p at 23.98 fps NTSC
720p/25 720p at 50 fps 576p at 50 fps 720p at 50 fps | 1080PsF at 25 fps| 1080p at 25 fps 576P1§;at 25
N 1080PsF at 486PsF at
720p/29.97 720p at 59.94 fps | 486p at 59.94 fps | 720p at 59.94 fps 29.97 fps 1080p at 29.97 fps 29.97 fps
720p/50 720p at 50 fps 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
720p/59.94 720p at 59.94 fps | 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC
1080p/23.976 | 1080p at 23.98 fps| 486p at 59.94 fps | 720p at 59.94 fps 120388511:)? 1080p at 23.98 fps NTSC
1080p/24 1080p at 24 fps — — — 1080p at 24 fps —
576PsF at
1080p/25 1080p at 25 fps 576p at 50 fps 720p at 50 fps | 1080PsF at 25 fps| 1080p at 25 fps 25 fps
N . 1080PsF at 486PsF at
1080p/29.97 1080p at 29.97 fps| 486p at 59.94 fps | 720p at 59.94 fps 29.97 fps 1080p at 29.97 fps 29.97 fps
1080i/50 1080i at 25 fps 576p at 50 fps 720p at 50 fps 1080i at 25 fps 1080p at 25 fps PAL
1080i/59.94 1080i at 29.97 fps | 486p at 59.94 fps | 720p at 59.94 fps | 1080i at 29.97 fps | 1080p at 29.97 fps NTSC

! The SD channel is not supported and is output as black video when cross-converting your project’s video output between 720p

and 1080p/i/PsF.

21t your project’s aspect ratio is 16:9, set Aspect ratio formatting to Anamorphic in the Video Output pane of the
Matrox Utilities preferences window to output as 16:9 (see Chapter 7, “Configuring Your MXO2 System”).

3 Enable Pulldown in the Video Output pane of the Matrox Utilities preferences window to output 1080i at 29.97 fps (see
Chapter 7, “Configuring Your MXO2 System”).

Supported main and SD video output formats
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Video formats supported on MXO2 outputs

The following table lists the video formats that you can output from the various

Matrox MXO2 outputs. The listed video output formats are those that are

supported on the main and SD channels (see “Supported main and SD video
output formats” on page 180). To assign the main or SD channel to an MXO2
output, see “Specifying your video output settings” on page 58. For descriptions
of the MXO2 outputs, see “Outputs” on page 165.

Matrox MX0O2 output

Video output HDMI spI' Component S-Video Composite
format (Y, Pb, Pr) (Y/C) (CVBS)
NTSC NTSC NTSC NTSC NTSC NTSC
NTSC 16:9 NTSC 16:9 NTSC 16:9 NTSC 16:9 NTSC 16:9 NTSC 16:9
PAL PAL PAL PAL PAL PAL
PAL 16:9 PAL 16:9 PAL 16:9 PAL 16:9 PAL 16:9 PAL 16:9
486PSF at 20.97 fps 486PSF at 29.97 fps 486Psl;past 29.97 486Psl;past 29.97 486Psl;past 29.97 486Psl;pa;t 29.97
486PsF at 29.97 fps 486PsF at 29.97 fps 486PsF at 486PsF at 29.97 486PsF at 29.97 486PsF at 29.97
16:9 16:9 29.97 fps 16:9 fps 16:9 fps 16:9 fps 16:9

576PsF at 25 fps 576PsF at 25 fps 576PsF at 25 fps | 576PsF at 25 fps | 576PsF at 25 fps | 576PsF at 25 fps

ST6PSF at 25 fps 16:9 | ST6PSF at 25 fps 16:9 576Psl;6a:t9 25 fps 576Ps}136a:t9 25 fps 576PS};;t9 25 fps 576Ps1136a:; 25 fps
486p at 59.94 fps 480p at 59.94 fps NTSC — — —
486p at 59.94 fps 16:9 | 480p at 59.94 fps 16:9 NTSC 16:9 — — —
576p at 50 fps 576p at 50 fps PAL — — —
576p at 50 fps 16:9 576p at 50 fps 16:9 PAL 16:9 — — —
720p at 50 fps 720p at 50 fps 720p at 50 fps 720p at 50 fps — —
720p at 59.94 fps 720p at 59.94 fps 720p at 59.94 fps | 720p at 59.94 fps — —
10801 at 25 fps 10801 at 25 fps 10801 at 25 fps 10801 at 25 fps — —
1080i at 29.97 fps 10801 at 29.97 fps 10801 at 29.97 fps | 1080i at 29.97 fps — —
1080PSF at 23.98 fps — 1338_%1;5; ;‘t ffgzsfijt — —
1080PsF at 25 fps 1080PsF at 25 fps 1080PsF at 25 fps | 1080PsF at 25 fps — —
1080PSF at 29.97 fps | 1080PSF at 29.97 fps 1§§gl;s§)§t 1§§gl;s§)§t — —
1080p at 23.98 fps 1080p at 23.98 fps 1080p at 23.98 fps — — —
1080p at 24 fps 1080p at 24 fps 1080p at 24 fps — — —
1080p at 25 fps 1080p at 25 fps 1080p at 25 fps — — —
1080p at 29.97 fps 1080p at 29.97 fps 1080p at 29.97 fps — — —
1080p at 30 fps 1080p at 30 fps 1080p at 30 fps — — —

! The SDI output is not available on Matrox MXO2 Mini.
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Connecting and Using
Matrox MXO2 Dock

This chapter shows how to
power MXO2 Dock, how to
connect it to your MX0O2
system, and lists the available
connections for use with your
peripheral devices.
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Powering Matrox MXO2 Dock

To power Matrox MXO2 Dock, connect the power supply cable to MXO2 Dock
and an AC outlet as shown in this section. To remove power from MXO2 Dock,
unplug the power supply cable from the AC outlet.

MXO2 Dock power supply and adapter plugs
Matrox MXO2 Dock provides a power supply cable with international adapter
plugs for use in different regions:

* To remove an adapter plug from the power adapter, hold down the button on
the adapter plug, and then slide the adapter plug up until it releases from the
power adapter.

* To insert an adapter plug into the power adapter, ensure that the adapter plug
is properly aligned with the corresponding slot on the power adapter, and
then slide the adapter plug down into the power adapter until it locks into
place.

11
@T Adapter
plug
Power
adapter
Removing an adapter plug Inserting an adapter plug
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Matrox MX02 Dock (back view)
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Connecting MXO2 Dock to your MX0O2 system

Use the Matrox MXO2 Dock docking station to connect MXO2 to your
computer’s Thunderbolt port. When doing this, it may take up to ten seconds for
your MXO2 to be detected by your system and its applications.

@ Important Make sure that the Matrox PCle cable is connected to MXO2 Dock
and MXO2 before connecting MXO2 Dock to your computer via the
Thunderbolt cable. If you want to disconnect or connect MXO2 when your
system is running, you must do it by disconnecting/connecting the Thunderbolt
cable. Do not disconnect the Matrox PCle cable from MXO2 Dock, or MXO02,
when your Mac system is running.

Connecting to Matrox MX02

MX02
(side view)

& Caution To ensure functionality and avoid
damaging the PCle cable or host connector, you
must connect the PCle cable as shown in
“Ensuring proper PCle cable connection” on
page 14.

L Thunderbolt cable
(Not included. A
Thunderbolt cable is
required to connect
Matrox MXO2 Dock to
your computer.)

To your computer’s
Thunderbolt port.
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ANALOG AUDIO

Ere MXO 2 Rack { "" " . ‘

ANALOG AUDIO
Rs42

= eo0@

OUTPUT

ve
Nan

100-200 v -c000 e

MXO02 Rack . . . .
il Caution To ensure functionality and avoid

° damaging the PCle cable or host connector,
you must connect the PCle cable as shown in
“Ensuring proper PCle cable connection” on
page 25.

PCle cable

Thunderbolt cable
(Not included. A
Thunderbolt cable is

MXO2 Dock to your
computer.)

To your computer’s
Thunderbolt port.

required to connect Matrox
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Connecting to Matrox MXO2 LE

A

A Caution To ensure functionality and avoid
damaging the PCle cable or host connector, you
must connect the PCle cable as shown in
“Ensuring proper PCle cable connection” on
page 34.

MXO02 LE
(side view)

PCle cable

Thunderbolt cable

(Not included. A
Thunderbolt cable is
required to connect Matrox
MXO02 Dock to your
computer.)

To your computer’s
Thunderbolt port.
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Connecting to Matrox MX0O2 Mini

Pb Pr L R
ot X0 M
®

Y
o

MXO02 Mini

ar,
POWER
Y

1
N
P
u
T
HDMI IN 3 ~ HDMI OUT
= |0 @ @ (@ - o
T
& Caution Toensure functionality and avoid jmee
damaging the PCle cable or host connector,
you must connect the PCle cable as shown in

“Ensuring proper PCle cable connection” on PCle cable
page 44.

—

Thunderbolt cable

(Not included. A
Thunderbolt cable is
required to connect Matrox
MXO2 Dock to your
computer.)

To your computer’s
Thunderbolt port.
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Available MX0O2 Dock connections

When your computer is connected to MXO2 Dock (see “Connecting MXO?2
Dock to your MXO2 system” on page 188), all peripheral devices connected to
MXO2 Dock are automatically detected by your Mac system. Matrox MXO2
Dock features the following connections for your peripheral devices:

Matrox MX0O2 Dock
(front view)

ss
= ;@ Q Matrox MXO2 Dock
USB 3.0 Thunderbolt port Status LED

(see “Connecting (see “Understanding
MXO02 Dock to the MX02 Dock
your MX02 status LED” on
system” on page 193)
page 188)

Matrox MXO2 Dock
(back view)

@ a2
of P e
= i
Homi HosT — < ——

HDMI Host Gigabit USB 2.0 Power
output  (see “Connecting MXO2 Ethernet (see “Powering
Dock to your MX02 Matrox MX02
system” on page 188) Dock” on
Matrox MXO2 Dock features one HDMI connector for connecting an HDMI
monitor.

By default, the monitor connected to MXO2 Dock is detected by your system as
a secondary monitor. However, you can change your system’s display settings
(System Preferences > Display) so that the HDMI monitor connected to
MXO2 Dock’s HDMI output is the primary monitor. When you disconnect
MXO02 Dock from your computer, your computer’s display settings return to
default settings. When re-connecting MXO2 Dock to your computer, the display
settings that were specified when MXO2 Dock was last connected are restored.

Note The Matrox MXO2 Dock HDMI output supports the playback of HDCP
(content-protected) sources.
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Gigabit Ethernet
Matrox MXO2 Dock has one Gigabit Ethernet port for connecting to a Gigabit
Ethernet network.

The network connected to MXO2 Dock is automatically selected by your
computer. If for any reason you need to select the network connected to MXO2
Dock, the MXO2 Dock port appears as Thunderbolt Ethernet Slot in System
Preferences > Network. If your network connection goes through a proxy
server, select Thunderbolt Ethernet Slot in Network preferences, and then set
the appropriate proxy settings in the Advanced options. If a network cable is
connected to MXO2 Dock’s Gigabit Ethernet port and another network cable is
connected to an Ethernet port on your computer, the network connected directly
to your computer is used.

Note The MXO2 Dock Gigabit Ethernet port supports wake-on-LAN (WOL).

usSB

Matrox MXO2 Dock includes two USB 2.0 ports for connecting USB devices
such as a keyboard, mouse, printer and scanner. MXO2 Dock also features one
front-mounted USB 3.0 port for connecting a SuperSpeed device, such as a flash
drive or storage.

Note The MXO2 Dock USB ports support wake-on-USB.

Understanding the MXO2 Dock status LED

Matrox MXO2 Dock features a status LED on the front of the unit to indicate the
following conditions:

* Green Matrox MXO2 Dock is connected to a computer via the
Thunderbolt cable, and is functioning properly.

* Red The computer to which MXO2 Dock is connected via the
Thunderbolt cable is shut down, or MXO2 Dock is not connected to a
computer via the Thunderbolt cable.

* Amber The computer to which MXO2 Dock is connected via the
Thunderbolt cable is in sleep mode.

Understanding the MXO2 Dock status LED
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Your notes
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This appendix provides
specifications for all Matrox
MXO2 products.
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Matrox MXO2 specifications

General
* Video formats NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 480p

* Regulatory compliance
— FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
— RoHS Directive 2002/95/EC
¢ Dimensions
— Length 330 mm (13")
— Width 241 mm (9.5")
— Height 51 mm (2")
¢ External AC/DC adapter
100-240 VAC 50-60 Hz
Input: IEC320-C14 inlet
Output: +12V DC, 3A max
— Dimensions: L 104 mm x W 46 mm x H 36 mm (4.1" x 1.8" x 1.4")
» Total power consumption 15 watts

Connections
* Genlock reference input

— HD analog tri-level sync or SD analog bi-level black burst
— BNC connector (75 Q), terminated
e RS-422 D-sub connector (9 pins)
Video
¢ HDMI
— HD input and output
+ HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
+ Eight channels of embedded audio
» Standard Type A HDMI connector (19 pins)
— SD output
+ HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
+ Eight channels of embedded audio
» Standard Type A HDMI connector (19 pins)
* SDI
— HDTY input
« HD-SDI with 16 channels of embedded SDI audio

Appendix F, Matrox MX0O2 Specifications



24-bit, 48 kHz
Compliant with SMPTE 292M, SMPTE 299M
BNC connector (75 Q), terminated

Equalized input for maximum cable length support

— HDTYV output

HD-SDI with 16 channels of embedded SDI audio
24-bit, 48 kHz

Compliant with SMPTE 292M, SMPTE 299M
BNC connector (75 Q)

— SDTYV input

SD-SDI with 16 channels of embedded audio
24-bit, 48 kHz

BNC connector (75 Q), terminated

Equalized input for maximum cable length support
Compliant with SMPTE 259M-C, SMPTE 272M

— SDTYV output

SD-SDI with 16 channels of embedded audio
24-bit, 48 kHz

BNC connector (75 Q)

Compliant with SMPTE 259M-C, SMPTE 272M

¢ S-Video and composite video input
— SDTYV input

PAL, NTSC, NTSC-EIAJ

BNC connector for composite (75 €2), terminated
4-pin mini-DIN S-Video connector (75 Q), terminated
12-bit ADC

2x oversampling

Anti-aliasing filtering

Automatic gain control

— SDTYV output

PAL, NTSC, NTSC-EIAJ

BNC connector for composite (75 )
4-pin mini-DIN S-Video connector (75 Q)
12-bit DAC

8x oversampling
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* Analog component video input
— HDTY input

EIA-770.3 compliant
BNC connectors (75 Q)
12-bit ADC

Anti-aliasing filtering

— HDTYV output

EIA-770.3 compliant
BNC connectors (75 Q)
12-bit DAC

2x oversampling

— SDTYV input

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

BNC connectors (75 Q)

12-bit ADC

4x oversampling

Anti-aliasing filter

— SDTYV output

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

BNC connectors (75 Q)

12-bit DAC

8x oversampling

* Analog video performance

— HDTYV analog component video (passthrough)

Frequency response Y: +/- 1.0 dB max to 28 MHz
Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
Component channel delay: < 8 ns

Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

— SDTYV S-Video and composite video (passthrough)

Amplitude error: < 4%

Frequency response: +/- 0.5 dB max to 5 MHz
2T pulse response: 1.0% max

Diff. Gain: < 2%, Diff. Phase: < 1 degree
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« S/N: > 58 dB, unified weighted
— SDTYV analog component video (passthrough)
« Frequency response Y: +/- 0.5 dB max to 5 MHz
« Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
« Component channel delay: < 8 ns
+ Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

Audio

Unbalanced analog audio inputs

1x stereo pair

RCA connectors

Input impedance: Hi-Z
— Line level with 18 db headroom (max level)

Unbalanced analog audio outputs

3x stereo pair

— RCA connectors

— Output impedance: 100 Q

— Line level with 18 db headroom (max level)

Balanced analog inputs

1x stereo pair

2x XLR female connectors
Nominal levels: +4 dBu (+4 dBm)
— Input impedance: Hi-Z

— Line level with 18 db headroom (max level)
Balanced analog outputs

— 2x stereo pair

4x XLR male connectors

Nominal levels: +4 dBu (+4 dBm)

— Output impedance: 50 Q

— Line level with 18 db headroom (max level)
Unbalanced digital (AES/EBU) input

— 1x stereo pair

— BNC connector (75 Q), terminated

— Maximum input level: 5 Vp_p

Unbalanced digital (AES/EBU) output

— 1x stereo pair

Matrox MXO02 specifications



200

— BNC connector
— Output impedance: 75 Q
— Nominal output level: 1V,

Balanced and unbalanced analog audio performance

Sampling frequency: 48 kHz (using 64x oversampling)
Quantization: 24 bits

S/N: > 85 db

THDN at 1 kHz, nominal level: < 0.05%

Environmental specifications

Minimum/maximum ambient operating temperatures: 0 to 40° C
Minimum/maximum storage temperature: —40 to 75° C

Maximum altitude for operation: 3,000 meters

Maximum altitude for transport: 12,000 meters

Operating humidity: 20 to 80% relative humidity (non-condensing)
Storage humidity: 5 to 95% relative humidity (non-condensing)

Matrox MXO2 Rack specifications

General

Video formats NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 480p
Regulatory compliance

— FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
— RoHS Directive 2002/95/EC

Dimensions (without rackmount brackets)

— Length 437 mm (17.2")

— Width 208 mm (8.2")

— Height 86 mm (3.4") (two rack units)

Dimensions (with rackmount brackets)

— Length 483 mm (19")

— Width 208 mm (8.2")

— Height 89 mm (3.5") (two rack units)

AC power

— 100-240 VAC 50-60 Hz

— Input: IEC320-C14 inlet

— Output: +12V DC, 3A max
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* Total power consumption 15 watts

Connections
* Genlock reference input

— HD analog tri-level sync or SD analog bi-level black burst
— BNC connector (75 Q)
¢ Genlock reference output
— HD analog tri-level sync or SD analog bi-level black burst
— Loop through
— BNC connector (75 Q)
* RS-422 D-sub connector (9 pins)
Video
« HDMI
— HD input and output
« HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
« Eight channels of embedded audio
+ Standard Type A HDMI connector (19 pins)
— SD output
« HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
« Eight channels of embedded audio
+ Standard Type A HDMI connector (19 pins)
* SDI
— HDTY input
« HD-SDI with 16 channels of embedded SDI audio
+ 24-bit, 48 kHz
« Compliant with SMPTE 292M, SMPTE 299M
« BNC connector (75 Q), terminated
» Equalized input for maximum cable length support
— HDTY output
« HD-SDI with 16 channels of embedded SDI audio
+ 24-bit, 48 kHz
« Compliant with SMPTE 292M, SMPTE 299M
« BNC connector (75 Q)
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— SDTV input

SD-SDI with 16 channels of embedded audio
24-bit, 48 kHz

BNC connector (75 ), terminated

Equalized input for maximum cable length support
Compliant with SMPTE 259M-C, SMPTE 272M

— SDTYV output

SD-SDI with 16 channels of embedded audio
24-bit, 48 kHz

BNC connector (75 Q)

Compliant with SMPTE 259M-C, SMPTE 272M

* S-Video and composite video input
— SDTYV input

PAL, NTSC, NTSC-EIAJ

BNC connector for composite (75 Q), terminated
4-pin mini-DIN S-Video connector (75 €2), terminated
12-bit ADC

2x oversampling

Anti-aliasing filtering

Automatic gain control

— SDTYV output

PAL, NTSC, NTSC-EIAJ

BNC connector for composite (75 Q)
4-pin mini-DIN S-Video connector (75 )
12-bit DAC

8x oversampling

* Analog component video input
— HDTY input

EIA-770.3 compliant
BNC connectors (75 Q)
12-bit ADC

Anti-aliasing filtering

— HDTYV output

EIA-770.3 compliant
BNC connectors (75 Q)

Appendix F, Matrox MX0O2 Specifications



203
12-bit DAC

2x oversampling

— SDTV input

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

BNC connectors (75 Q)

12-bit ADC

4x oversampling

Anti-aliasing filter

— SDTYV output

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

BNC connectors (75 Q)

12-bit DAC

8x oversampling

¢ Analog video performance

— HDTY analog component video (passthrough)

Frequency response Y: +/- 1.0 dB max to 28 MHz
Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
Component channel delay: < 8 ns

Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

— SDTYV S-Video and composite video (passthrough)

Amplitude error: < 4%

Frequency response: +/- 0.5 dB max to 5 MHz
2T pulse response: 1.0% max

Diff. Gain: < 2%, Diff. Phase: < 1 degree

S/N: > 58 dB, unified weighted

— SDTYV analog component video (passthrough)

Frequency response Y: +/- 0.5 dB max to 5 MHz
Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
Component channel delay: < 8 ns

Component S/N (Y, Pb, Pr): > 54 dB, unified weighted
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Audio
* Balanced analog inputs
— 2x stereo pair
— 4x XLR female connectors
— Nominal levels: +4 dBu (+4 dBm)
Input impedance: Hi-Z

— Headroom (max level): 18 db
¢ Balanced analog outputs
— 4x stereo pair
— 8x XLR male connectors
— Nominal levels: +4 dBu (+4 dBm)
— Output impedance: 50 Q
— Headroom (max level): 18 db
¢ Unbalanced digital (AES/EBU) input
— 2x stereo pair
— 2x BNC connector (75 Q), terminated
— Maximum input level: 5V,
¢ Unbalanced digital (AES/EBU) output
— 2x stereo pair
— 2x BNC connector
— Output impedance: 75 Q
— Nominal output level: 1V,
¢ Balanced analog audio performance
— Sampling frequency: 48 kHz (using 64x oversampling)
— Quantization: 24 bits
— S/N:>85db
— THDN at 1 kHz, nominal level: < 0.05%

Environmental specifications
* Minimum/maximum ambient operating temperatures: 0 to 40° C

* Minimum/maximum storage temperature: —40 to 75° C

* Maximum altitude for operation: 3,000 meters

* Maximum altitude for transport: 12,000 meters

* Operating humidity: 20 to 80% relative humidity (non-condensing)
* Storage humidity: 5 to 95% relative humidity (non-condensing)
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Matrox MXO2 LE specifications

General
* Video formats NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 486p

¢ Regulatory compliance
— FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI
— RoHS Directive 2002/95/EC
¢ Dimensions
— Length 237 mm (9.3")
— Width 241 mm (9.5")
— Height 51 mm (2")
¢ External AC/DC adapter
100-240 VAC 50-60 Hz
Input: IEC320-C14 inlet
Output: +12V DC, 3A max
— Dimensions: L 104 mm x W 46 mm x H 36 mm (4.1" x 1.8" x 1.4")

» Total power consumption 15 watts

Connections
* Genlock reference input

— HD analog tri-level sync or SD analog bi-level black burst
— BNC connector (75 Q), terminated
e RS-422 D-sub connector (9 pins)
Video
¢ HDMI
— HD input and output
+ HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
+ Eight channels of embedded audio
» Standard Type A HDMI connector (19 pins)
— SD output
+ HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
+ Eight channels of embedded audio
» Standard Type A HDMI connector (19 pins)
* SDI
— HDTY input
« HD-SDI with 16 channels of embedded SDI audio
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24-bit, 48 kHz
Compliant with SMPTE 292M, SMPTE 299M
BNC connector (75 Q), terminated

Equalized input for maximum cable length support

— HDTYV output

HD-SDI with 16 channels of embedded SDI audio
24-bit, 48 kHz

Compliant with SMPTE 292M, SMPTE 299M
BNC connector (75 Q)

— SDTYV input

SD-SDI with 16 channels of embedded audio
24-bit, 48 kHz

BNC connector (75 Q), terminated

Equalized input for maximum cable length support
Compliant with SMPTE 259M-C, SMPTE 272M

— SDTYV output

SD-SDI with 16 channels of embedded audio
24-bit, 48 kHz

BNC connector (75 Q)

Compliant with SMPTE 259M-C, SMPTE 272M

¢ S-Video and composite video input
— SDTYV input

PAL, NTSC, NTSC-EIAJ

BNC connector for composite (75 €2), terminated
4-pin mini-DIN S-Video connector (75 Q), terminated
12-bit ADC

2x oversampling

Anti-aliasing filtering

Automatic gain control

— SDTYV output

PAL, NTSC, NTSC-EIAJ

BNC connector for composite (75 )
4-pin mini-DIN S-Video connector (75 Q)
12-bit DAC

8x oversampling
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* Analog component video input
— HDTY input

EIA-770.3 compliant
BNC connectors (75 Q)
12-bit ADC

Anti-aliasing filtering

— HDTYV output

EIA-770.3 compliant
BNC connectors (75 Q)
12-bit DAC

2x oversampling

— SDTYV input

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

BNC connectors (75 Q)

12-bit ADC

4x oversampling

Anti-aliasing filter

— SDTYV output

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

BNC connectors (75 Q)

12-bit DAC

8x oversampling

* Analog video performance

— HDTYV analog component video (passthrough)

Frequency response Y: +/- 1.0 dB max to 28 MHz
Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
Component channel delay: < 8 ns

Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

— SDTYV S-Video and composite video (passthrough)

Amplitude error: < 4%

Frequency response: +/- 0.5 dB max to 5 MHz
2T pulse response: 1.0% max

Diff. Gain: < 2%, Diff. Phase: < 1 degree
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« S/N: > 58 dB, unified weighted
— SDTYV analog component video (passthrough)
« Frequency response Y: +/- 0.5 dB max to 5 MHz
« Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
« Component channel delay: < 8 ns
+ Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

Audio
* Unbalanced analog audio inputs

1x stereo pair

RCA connectors

Input impedance: Hi-Z
— Line level with 18 db headroom (max level)

* Unbalanced analog audio outputs

1x stereo pair

— RCA connectors

— Output impedance: 100 Q

— Line level with 18 db headroom (max level)

¢ Balanced analog inputs

1x stereo pair

2x XLR female connectors
Nominal levels: +4 dBu (+4 dBm)
— Input impedance: Hi-Z

— Headroom (max level): 18 db
* Balanced analog outputs

— 1x stereo pair
2x XLR male connectors
Nominal levels: +4 dBu (+4 dBm)
— Output impedance: 50 Q

— Headroom (max level): 18 db

¢ Balanced and unbalanced analog audio performance
— Sampling frequency: 48 kHz (using 64x oversampling)
— Quantization: 24 bits
— S/N:>85db
— THDN at 1 kHz, nominal level: < 0.05%
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Environmental specifications

Minimum/maximum ambient operating temperatures: 0 to 40° C
Minimum/maximum storage temperature: —40 to 75° C

Maximum altitude for operation: 3,000 meters

Maximum altitude for transport: 12,000 meters

Operating humidity: 20 to 80% relative humidity (non-condensing)

Storage humidity: 5 to 95% relative humidity (non-condensing)

Matrox MXO2 Mini specifications

General

Video formats NTSC, PAL, NTSC-EIAJ, 1080p/i/PsF, 720p, 576p, 486p
Regulatory compliance

— FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI

— RoHS Directive 2002/95/EC

Dimensions

— Length 166 mm (6.5")

— Width 110 mm (4.3")

— Height 40 mm (1.6")

Operating voltages and power consumption

— Included AC/DC adapter: 100-240 V AC 50-60 Hz (5 V DC, 3 A max)
— MXO2 Mini unit: 5-25 V DC, 2.5 mm barrel-type connector

+ 9 watts power consumption

Connections
Video

HDMI video
— HD input and output
« HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
« Eight channels of embedded audio
+ Standard Type A HDMI connector (19 pins)
— SD output
« HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (8-bit)
« Eight channels of embedded audio
+ Standard Type A HDMI connector (19 pins)
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* Composite video (not available if using analog component input/output)
— SDTYV input

PAL, NTSC, NTSC-EIAJ
RCA connector

10-bit ADC

4x oversampling
Anti-aliasing filtering

Automatic gain control

— SDTYV output

PAL, NTSC, NTSC-EIAJ
RCA connector
12-bit DAC

16x oversampling

* S-Video (not available when using analog component input/output)
— SDTYV input

PAL, NTSC, NTSC-EIAJ
RCA connectors

10-bit ADC

4x oversampling
Anti-aliasing filtering

Automatic gain control

— SDTYV output

PAL, NTSC, NTSC-EIAJ
RCA connectors
12-bit DAC

16x oversampling

* Analog component video (not available when using composite, or S-Video
input/output)

— HDTYV input

EIA-770.3 compliant
RCA connectors
10-bit ADC

Anti-aliasing filtering

— HDTYV output

EIA-770.3 compliant
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12-bit DAC

4x oversampling

— SDTYV input

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

RCA connectors

10-bit ADC

2x oversampling

Anti-aliasing filter

— SDTYV output

Betacam, Betacam SP (NTSC and NTSC-EIAJ)
SMPTE/EBU N10 (PAL)

RCA connectors

12-bit DAC

16x oversampling

* Analog video performance

— HDTYV analog component video

Frequency response Y: +/- 1.0 dB max to 28 MHz
Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz
Component channel delay: < 8 ns

Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

— SDTYV S-Video and composite video

Amplitude error: < 4%

Frequency response: +/- 0.75 dB max to 5 MHz
Diff. Gain: < 2%, Diff. Phase: < 1 degree

S/N: > 54 dB, unified weighted

— SDTYV analog component video

Frequency response Y: +/- 0.75 dB max to 5 MHz
Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz
Component channel delay: < 8 ns

Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

211

Matrox MXO02 Mini specifications



212

Audio

Unbalanced analog audio inputs
— Ix stereo pair

— RCA connectors

Input impedance: > 10 kQ
— Line level with 18 db headroom (max level: +8 dBv)

Unbalanced analog audio outputs

1x stereo pair

— RCA connectors

— Output impedance: < 200 Q

— Line level with 18 db headroom (max level: +8 dBv)

Unbalanced analog audio performance

Sampling frequency: 48 kHz (using 128x oversampling)
Quantization: 24 bits

S/N: > 90 db

THDN at 1 kHz, nominal level: < 0.02%

Frequency response: +/- 0.5 dB, 20 Hz to 20 kHz
Channel separation: > 100 db

Environmental specifications

Minimum/maximum ambient operating temperatures: 0 to 40° C
Minimum/maximum storage temperature: —40 to 75° C

Maximum altitude for operation: 3,000 meters

Maximum altitude for transport: 12,000 meters

Operating humidity: 20 to 80% relative humidity (non-condensing)
Storage humidity: 5 to 95% relative humidity (non-condensing)
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Matrox MXO2 Thunderbolt adapter
specifications
* Dimensions
— Length 87 mm (3.4")
— Width 48 mm (1.9")
— Height 19 mm (.75")
* Power consumption 3.6 watts

¢ Minimum/maximum ambient operating temperatures 0 to 40° C

Matrox MXO2 Dock specifications
* Regulatory compliance
— FCC Class B, CE Mark Class B
— RoHS Directive 2002/95/EC
* Dimensions
— Length 91 mm (3.6")
— Width 201 mm (7.9")
— Height 32 mm (1.25")
e Weight 484 g (1.07 1bs)
¢ External AC/DC adapter
— Input: 100-240 VAC 50-60 Hz
— Output: +12V DC, 2A max
— Dimensions: L 78 mm x W 46 mm x H 36 mm (3.1" x 1.8" x 1.4")
¢ Unit voltage and amperage 12V/2A

* Total power consumption 24 W

Connections
« HDMI output:

« One Standard Type A HDMI connector (19 pins)
+ Eight channels of embedded audio
« Maximum resolution: 1920 x 1080 at 60 fps
« HDCP compliant for protected content playback
¢ Data ports:
— One Thuderbolt port

— One USB 3.0 port with wake-on-USB, and a maximum theoretical data
transfer speed of 2.5 Gb/s.

— Two USB 2.0 ports with wake-on-USB
Matrox MXO2 Thunderbolt adapter specifications



214

— One Gigabit Ethernet port with wake-on-LAN (WOL)

Environmental specifications

Minimum/maximum operating temperature: 10° C to 35° C
Minimum/maximum storage temperature: —20° C to 47° C
Maximum altitude for operation: 3,000 m

Maximum altitude for transport: 10,000 m

Operating humidity: 20% to 80% relative humidity (non-condensing)

Matrox PCle host adapter specifications

Matrox PCle host ExpressCard/34 adapter
(for laptops)

— Standard ExpressCard/34
— Dimensions: L 96 mm x W 33 mm x H 13 mm (3.8" x 1.3" x 0.5")

Matrox PCle host adapter (for desktops)

— Standard low-profile PCle (x1) card
— PCB dimensions
« L 66 mm x H 69 mm (2.6" x2.7")

« overall thickness including components: 19 mm (0.75")
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How to get Matrox customer support

If you have a problem that you’re unable to solve by referring to the
documentation for your Matrox product, please contact your Matrox
representative. He or she should be able to help you quickly correct any
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our
website at www.matrox.com/video/support.

@ Important Only registered users are entitled to customer support, software
updates, special promotional offers, and access to our user forum.

Keep up to date with our website

In addition to registering your Matrox product, our website offers you
up-to-the-minute information about Matrox products and software updates. Be
sure to place our site in your favorites or bookmarks:
www.matrox.com/video/support.

Contacting us

Matrox is proud to offer worldwide customer support. Please use the contact
information for your Matrox product and area as provided on our website at
www.matrox.com/video/support.
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settings for Adobe Media Encoder 138

settings for Adobe Premiere Pro 138

settings for Apple Compressor 128

settings for Apple QuickTime Pro 149

settings for Telestream Episode 142

settings in Avid Media Composer 145

Matrox MPEG-2 I-frame codec

configuring settings 105
downloading for playback 105
overview 105

Matrox MXO2 Dock

available connections 192
connecting to MX02 188
connecting to MXO2 LE 190
connecting to MXO2 Rack 189
DVI connection 192

Gigabit Ethernet connection 193
HDMI connection 192
specifications 213

status LEDs 193

USB connection 193

Matrox MXO2 Thunderbolt adapter

connecting to MX02 15
connecting to MXO2 LE 35
connecting to MXO2 Mini 45
connecting to MXO2 Rack 26

L specifications 213
Matrox Player
setting as audio device 83, 108, 109
M setting as video device 83, 108, 109, 112
Matrox WYSIWYG
specifying settings 70
working with Adobe After Effects 110
working with Adobe Photoshop 111
Media Composer
See Avid Media Composer

Luminance levels, setting for video input/output 53

Mac system
connecting to your MX02 14
connecting to your MXO2 LE 34
connecting to your MXO2 Mini 44
connecting to your MXO2 Rack 25
Main and SD channels, video output formats on 180
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Monitor calibration

See HDMI monitor calibration
MOV files

See QuickTime files (.mov)
MPEG-2 I-frame

See Matrox MPEG-2 I-frame codec

o

Outputs on MXO2 Mini
analog RCA audio 172
available 168
component (Y, Pb, Pr) 172
composite (Y) 172
HDMI 171
specifying audio 62
specifying video 58
supported video formats 184
supported video formats on main and SD channels

180

S-Video (Pb, Pr) 172

Outputs on MX02, MXO2 Rack, and MXO2 LE
AES/EBU audio 170
analog RCA audio 171
analog XLR audio 170
available on MXO2 165
available on MXO2 LE 167
available on MXO2 Rack 166
component (Y, Pb, Pr) 170
composite (CVBS) 170
HDMI 169
SDI 170
specifying audio 62
specifying video 58
supported video formats 184
supported video formats on main and SD channels

180
S-Video (Y/C) 170

P

PCle host adapter
connecting to MX02 16
connecting to MXO2 LE 36
connecting to MXO2 Mini 44, 46
connecting to MXO2 Rack 27
installing 7
specifications 214

PCle host ExpressCard/34 adapter

Index

connecting to MX02 16
connecting to MXO2 LE 36
connecting to MXO2 Mini 44, 46
connecting to MXO2 Rack 27
installing 7
removing 8
specifications 214

Pedestal, setting for NTSC analog video 54

Photoshop
See Adobe Photoshop

Power
connecting to MX02 12
connecting to MXO2 Dock 186
connecting to MXO2 LE 32
connecting to MXO2 Mini 42
connecting to MXO2 Rack 24
functionality in MXO2 12
functionality in MXO2 LE 32
functionality in MXO2 Rack 24
See also Battery

Power adapter plugs
connecting for MXO2 Dock 186
connecting for MX02 Mini 42

Preferences window
Loading custom presets 52
saving custom presets 52
specifying A/V input settings 55
specifying audio output settings 62
specifying general settings 53
specifying genlock settings for MX02, MX02
Rack, and MXO2 LE 54
specifying Matrox WYSIWYG settings 70
specifying the Apple Final Cut Pro X setting 123
specifying video output settings 58
viewing MXO2 information 72

Prelude
See Adobe Prelude

Premiere Pro
See Adobe Premiere Pro

Presets, preferences window
loading 52
saving 52

Programs, using with supported 79

Q

QuickTime files (.mov)



assigning a Matrox MAX H.264 preset in Adobe
Media Encoder 139

assigning a Matrox MAX H.264 preset in Adobe
Premiere Pro 139

assigning a Matrox MAX H.264 setting in Apple
Compressor 129

creating a custom Matrox MAX H.264 preset in
Adobe Media Encoder 139

creating a custom Matrox MAX H.264 preset in
Adobe Premiere Pro 139

creating a custom Matrox MAX H.264 setting in
Apple Compressor 130

creating in Avid Media Composer using Matrox
MAX H.264 145

specifying Matrox MAX H.264 settings in Adobe
Media Encoder 138

specifying Matrox MAX H.264 settings in Adobe
Premiere Pro 138

specifying Matrox MAX H.264 settings in Apple
QuickTime Pro 149

specifying Matrox MAX H.264 settings in Te-
lestream Episode 142

R

Registering your Matrox product 216
RS-422
connection to MX02 17
connection to MXO2 LE 37
connection to MXO2 Rack 28
See also Device control

S

Scaling
on MXO?2 inputs 56
Settings
A/V input 55
audio output 62
for capturing AFD in Premiere Pro 92
for capturing closed captioning in Premiere Pro 94
for exporting AFD in Premiere Pro 93
for exporting closed captioning to a file in Premiere
Pro 96
for playing back AFD in Premiere Pro 92
for playing back closed captioning in Premiere Pro
95, 97
general 53
genlock for MX02, MXO2 Rack, and MXO2 LE 54
video output for MXO2 58
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Setup level
See Pedestal
Software, MXO02
installing 8
removing 10
Specifications
host ExpressCard/34 adapter 214
Matrox MXO02 196
Matrox MXO2 Dock 213
Matrox MXO2 LE 205
Matrox MXO2 Mini 209
Matrox MX02 Rack 200
Matrox MXO2 Thunderbolt adapter 213
PClIe host adapter 214
SpeedGrade
See Adobe SpeedGrade
Style conventions 3
Symphony
See Avid Symphony
System requirements 2

T

Technical support 216

Telestream Episode, Matrox MAX H.264 settings in
142

Thunderbolt adapter
See Matrox MXO2 Thunderbolt adapter

\"

Video formats
expressed in MXO2 documentation 4
supported in capture 176
supported on inputs 174
See also Video output device settings
See also Video output formats, MXO02
Video output device settings
in Adobe After Effects 110
in Adobe Encore 108
in Adobe Photoshop 111
in Adobe Prelude 109
Video output formats
supported on main and SD channels 180
supported on outputs 184
See also Video output device settings
See also Video formats
Video output settings 58
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Voice-over

adding to sequence

in Adobe Premiere Pro 86

in Avid editing applications 117
connection and setup

in Adobe Premiere Pro 86

in Avid editing applications 117
recording

in Adobe Premiere Pro 90

in Avid editing applications 118

w

Warranty 1
WWW site, Matrox 216
WYSIWYG, specifying settings 70
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Compliance Statements

USA

FCC Compliance Statement

Remark for the Matrox hardware products supported by this guide

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The
use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada

(English) Industry Canada Compliance Statement

CAN ICES-3 (A)/NMB-3 (A)

Remark for the Matrox hardware products supported by this guide

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Frangais) Conformité avec les exigences de I'Industrie Canada

CAN ICES-3 (A)/NMB-3 (A)

Remarque sur les produits matériels Matrox couverts par ce guide

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Reglement sur
le brouillage radioélectrique édicté par Industrie Canada.

Europe

(English) European user’s information — Declaration of Conformity

Remark for the Matrox hardware products supported by this guide

These devices comply with EC Directive 2006/95/EC for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and
EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet
EC requirements, shielded cables must be used to connect the equipment and other peripherals. Analog A/V cables connected to Matrox MXO2 Mini must be limited to
less than three meters to comply with EEC and EMC directives. These products have been tested in a typical Class A compliant host system. It is assumed that these
products will also achieve compliance in any Class A compliant system.

(Francais) Informations aux utilisateurs Européens — Déclaration de conformité

Remarque sur les produits matériels Matrox couverts par ce guide

Ces unités sont conformes a la directive communautaire 2006/95/EC pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux
normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces prod dans un environnement résidentiel peut causer des interférences radio, dans ce cas
I’ utilisateur peut étre amené a prendre les mesures appropriées. Pour respecter les impératifs communautaires, les cables de connexion entre I’équipement et ses
périphériques doivent étre blindés. Afin de se conformer aux exigences des directives de la CEE et de 'EMC, les cables analogiques audio/vidéo reliés a Matrox MXO2
Mini ne doivent pas dépasser trois metres. Ces produits ont été testés dans un systeme hote typique compatible classe A. On suppose qu’ils présenteront la méme
compatibilité dans tout systéme compatible classe A.

(Deutsch) Information fiir europaische Anwender — Konformitatserklarung

Anmerkung fiir die Matrox Hardware-Produktunterstiitzung durch dieses Handbuch

Diese Geriite entsprechen EG Direktive 2006/95/EC fiir ein digitales Geriit Klasse A. Sie wurden getestet und entsprechen demnach EN55022/CISPR22 und
EN55024/CISPR24. In einer Wohnumgebung kénnen diese Produkte Funkinterferenzen erzeugen, und der Benutzer kann genétigt sein, entsprechende Manahmen zu
ergreifen. Um EG-Anforderungen zu entsprechen, miissen zum AnschlieBen des ausriistung und anderer Peripheriegeriite abgeschirmte Kabel verwendet werden.
Analoge A/V Kabel, die an Matrox MXO2 Mini angeschlossen werden, miissen eine Linge von weniger als drei Metern aufweisen um den EWG-und EMV-Richtlinien
zu entsprechen. Diese Produkt wurden in einem typischen, der Klasse A entsprechenden, Host-System getestet. Es wird davon ausgegangen, daf diese Produkte auch in
jedem Klasse A entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei — Dichiarazione di conformita

Nota per i prodotti hardware Matrox supportati da questa guida

Questi dispositivi sono conformi alla direttiva CEE 2006/95/EC relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme
EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel qual caso all’utente potrebbe venire richiesto
di prendere le misure adeguate. Per soddisfare i requisiti CEE, I’apparecchiatura e le altre periferiche vanno collegati con cavi schermati. I cavi analogici A/V collegati a
Matrox MXO2 Mini devono essere limitati a meno di tre metri per essere conformi alle direttive di contabilita elettromagnetica e del EEC. Questi prodotti sono stati
provati in un tipico sistema host conforme alla Classe A. Inoltre, si da per scontato che questi prodotti acquisiranno la conformita in qualsiasi sistema conforme alla
Classe A.

(Espaiiol) Informaci6n para usuarios europeos — Declaracién de conformidad

Observacién referente a los productos de hardware de Matrox apoyados por este manual

Estos dispositivos cumplen con la directiva de la CE 2006/95/EC para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha
comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las
comunicaciones por radio; en tal caso el usuario deberd adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberdn utilizarse cables apantallados
para conectar el equipo y demds periféricos. Los cables andlogos de A/V conectados con Matrox MXO2 Mini se deben limitar a menos de tres metros para conformidad
con las directivas del EEC y del EMC. Estos productos han sido sometidos a prueba en un tipico sistema anfitrién que responde a los requisitos de la Clase A. Se supone
que estos productos cumplirdn también con las normas en cualquier sistema que responda a los requisitos de la Clase A.
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